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Preface

This ASG-SmartTest PLI User’s Guide provides user information about ASG-SmartTest
PL/I (herein called SmartTest-PLI). SmartTest-PLI1 provides testing and debugging
processes for applicationsin the PL/I environment. SmartTest-PLI isfully integrated with
ASG-SmartTest (herein called SmartTest). All basic and extended facilities are available
including: program view, execution control, Breakpoints, monitoring and changing data,
pseudocode, abend processing, Backtrack, and the COBOL intelligent search function.

Allen Systems Group, Inc. (ASG) provides professional support to resolve any questions
or concerns regarding the installation or use of any ASG product. Telephone technical
support is available around the world, 24 hours a day, 7 days aweek.

ASG welcomes your comments, as a preferred or prospective customer, on this
publication or on any ASG product.

About this Publication

This publication consists of these chapters:
=  Chapter 1, "Introduction,” provides an introduction to SmartTest-PLI.

e  Chapter 2, "Additional Languages,” provides information about SmartTest-PLI
with Assembler and COBOL.

- Chapter 3, "SmartTest-PL| Test Session," introduces the SmartTest test session.

- Chapter 4, "Test Session: Additional Environments,” provides information for
setting up SmartTest in additional environments.

=  Chapter 5, "Testing Techniques," presents common SmartTest testing and
debugging techniques.

- Chapter 6, "Analysis Features,” describes the SmartTest-PLI Intelligent Search
Function

=  Chapter 7, "Help Facility," describes the comprehensive and context-sensitive Help
facility, including an online Help Tutorial.

Vi
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Related Publications

viii

The documentation library for ASG-SmartTest PLI consists of these publications (where
nn represents the product version number):

Note:

ASG-Center Installation Guide (CNX0300-nn) contains installation and
maintenance information for ASG-Center, the common set of libraries shared by the
ASG-ESW suite of products.

ASG-ESW Enhancement Summary (ESW1000-nn) highlights the new functionality
for thisrelease.

ASG-SmartTest CICSUser’s Guide (STC0200-nn) contains specific commands and
test session setup information for the CICS environments.

ASG-SmartTest for COBOL and Assembler User’s Guide (STA0200-nn) contains
introductory and usage information for COBOL and Assembler. It also containstest
session setup information for the TSO, ISPF, IMS/DB, DB/2, BTS, and Batch
environments.

ASG-SmartTest IMS User’s Guide (STM0200-nn) contains specific commands and
test session setup information for the IMS/DC environments.

ASG-SmartTest Installation Guide (STX0300-nn) contains information for
installing and maintaining ASG-SmartTest.

ASG-SmartTest PLI User’s Guide (STL0200-nn) contains introductory and usage
information about how to use ASG-SmartTest with the PL/I language. It also
contains test session setup information for the TSO, ISPF, IMS/DB, DB/2, BTS,
and Batch environments.

ASG-SmartTest Quick Sart for COBOL/ASM (STA0900-nn) summarizes how to
use ASG-SmartTest with the COBOL or Assembler language.

ASG-SmartTest Quick Sart for PL/I (STL0900-nn) summarizes how to use
ASG-SmartTest with the PL/I language.

ASG-SmartTest Reference Guide (STX0400-nn) contains detailed reference
information about CUA pull-downs and pop-ups, ASG-SmartTest command
syntax, and pseudo code.

ASG-SmartTest Reference Summary (STX0600-nn) summarizes the syntax and
usage of ASG-SmartTest commands.

ASG-SmartTest TCA User’s Guide (STT0200-nn) contains procedures for using the
ASG-SmartTest-TCA (Test Coverage Analysis) option.

To obtain a specific version of a publication, contact ASG Customer Support.
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ASG-Existing Systems Workbench (ASG-ESW)

ASG-ESW (herein called ESW) is an integrated suite of components designed to assist
organizations in enhancing, redeveloping, or re-engineering their existing systems. ESW
products use the Application Knowledge Repository (AKR) to store source program
analysis information generated by the Analytical Engine. Figure 1 represents the
components of ESW.

Figurele+ ASG Existing Systems Workbench

Existing Systems Workbench I

ASG-Alliance for Application Understanding

ASG-AutoChange for Mass Change Projects
ASG-Bridge for Conversion Projects
ASG-Encore for Evolving COBOL Programs
ASG-Center ASG-Estimate for Resource Estimation
ASG-Insight for Program Understanding
ASG-Recap for Portfolio Analysis

. . ASG-SmartDoc for Program Documentation
Analytical Engine |«

Y

ASG-SmartEdit for COBOL Intelligent Editing

ASG-SmartQuest for Analyzing Abends

Application
Knowledge

Repository (AKR) - TS0
- CICs

- IMS

- ASM

- APS

- PLI

- TCA for Test Coverage Analysis
- DB2 Stored Procedure

ASG-SmartTest for Testing/Debugging
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This table contains the name and description of each ESW component:

ASG-Alliance

Alliance

The application understanding component that is
used by I T professionalsto conduct an analysis of
every application in their environment. Alliance
supports the analysis and assessment of the
impact of change requests upon an entire
application. Alliance alows the programmer/
analyst to accurately perform application analysis
tasks in afraction of the time it would take to
perform these tasks without an automated
analysistool. Theimpact analysis from Alliance
provides application management with additional
information for use in determining the resources
required for application changes.

ASG-AutoChange AutoChange

The COBOL code change tool that makes
conversion teams more productive by enabling
quick and safe changes to be made to large
quantities of code. AutoChange is an interactive
tool that guides the user through the process of
making source code changes.

ASG-Bridge

Bridge

Thebridging product that enablesfield expansion
for program source code, without being required
to simultaneously expand the fieldsin files or
databases. Because programs are converted in
smaller groups, or on a one-by-one basis, and do
not require file conversion, testing during the
conversion process is simpler and more thorough.

ASG-Center

Center

The common platform for al ESW products.
Center providesthecommon Analytical Engineto
analyze the source program and store this
information in the AKR. This common platform
provides a homogeneous environment for all
ESW products to work synergisticaly.
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ASG-Encore Encore The program re-engineering component for
COBOL programs. Encore includes analysis
facilities and allows you to extract code based on
the most frequently used re-engineering criteria.
Thecode generation facilitiesallow you to usethe
results of the extract to generate a standalone
program, a callable module, a complement
module, and a CICS server. Prior to code
generation, you can view and modify the
extracted Logic Segment using the COBOL
editor.

ASG-Estimate Estimate The resource estimation tool that enablesthe user
to define the scope, determine the impact, and
estimate the cost of code conversion for COBOL,
Assembler, and PL/I programs. Estimate locates
selected data items across an application and
determines how they are used (moves, arithmetic
operations, and compares). Time and cost factors
are applied to these counts, generating cost and
personnel resource estimates.

ASG-Insight Insight The program understanding component for
COBOL programs. Insight allows programmers
to expose program structure, identify dataflow,
find program anomalies, and trace logic paths. It
also has automated proceduresto assist in
debugging program abends, changing a
computation, and resolving incorrect program
output values.

ASG-Recap Recap The portfolio analysis component that evaluates
COBOL applications. Recap reports provide
function point analysis and metrics information,
program quality assessments, intra-application
and inter-application comparisons and
summaries, and historical reporting of function
point and metrics information. The portfolio
analysisinformation can also be viewed
interactively or exported to a database,
Spreadsheet, or graphics package.

ASG-SmartDoc SmartDoc The program documentation component for
COBOL programs. SmartDoc reports contain
control and data flow information, an annotated
sourcelisting, structure charts, program summary
reports, exception reportsfor program anomalies,
and software metrics.

xi



ASG-SmartTest PLI User’s Guide

ASG-SmartEdit SmartEdit The COBOL editing component that can be
activated automatically when the | SPF/PDF
Editor isinvoked. SmartEdit provides
comprehensive searching, inline copybook
display, and syntax checking. SmartEdit allows
you to include an additional preprocessor (for
example, the APS generator) during syntax
checking. SmartEdit supportsall versions of IBM
COBOL, CICS, SQL, and CA-IDMS.

ASG-SmartQuest  SmartQuest Thediagnostic tool for analyzing batch and CICS
transaction abends. SmartQuest has been
designed to make the maximum use of simple
point-and-shoot techniques to enable fast and
easy navigation through any data dump.

ASG-SmartTest SmartTest The testing/debugging component for COBOL,
PL/I, Assembler, and APS programsin the TSO,
MV S Batch, CICS (including file services), and
IMS environments. SmartTest features include
program analysis commands, execution control,
intelligent breakpoints, test coverage, pseudo
code with COBOL source update, batch connect,
disassembl ed object code support, and full screen
memory display.

Invoking ESW Products

The method you use to invoke an ESW product depends on your system setup. If you
need assistance to activate a product, see your systems administrator. If your site startsa
product directly, use the I SPF selection or CLIST asindicated by your systems
administrator. If your site uses the ESW screen to start a product, initiate the ESW screen
using the I SPF selection or CLIST asindicated by your systems administrator and then
typing in the product command on the command line.

The product names can a so vary depending on whether you access a product directly or
through ESW. See "ESW Product Integration” on page xiii for more information about
using ESW.

Xii



Preface

To initialize ESW products from the main ESW screen, select the appropriate option on
the action bar pull-downs or type the product shortcut on the command line.

Alliance (Application Understanding) AL Understand » Application
AutoChange (Conversion Set) CcC Change » Conversion Set
Bridge BR Change » ASG-Bridge
Encore (Program Re-engineering) EN Re-engineer » Program
Estimate ES Measure » ASG-Estimate
Insight (Program Understanding) IN Understand » Program
Recap (Portfolio Analysis) RC Measure P Portfolio
SmartDoc (Program Documentation) DC Document » Program
SmartEdit SE Change » Program

Or

Change » Program with Options

SmartQuest SQV Understand » Abend/Dump

SmartTest (Testing/Debugging) ST Test » Module/Transaction

ESW Product Integration

Because ESW is an integrated suite of products, you are able to access individual ESW
products directly, or through the main ESW screen. As aresult, different fields, values,
action bar options, and pull-down options display on a screen or pop-up depending on
how you accessed the screen or pop-up.

Certain ESW products also contain functionality that interfaces with other ESW products.
Using SmartTest as an example, if Allianceisinstalled, SmartTest provides a dynamic
link to Alliance that can be used to display program analysisinformation. If Insight is
installed and specified during the analyze, the Insight program analysis functions are
automatically available for viewing logic/data rel ationships and execution path. For
example, the Scratchpad option is available on the Options pull-down if you have Insight
installed.

Xiii
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Accessto these integrated products requires only that they be installed and executed in
the same libraries.

Example 1

Figure 2 shows the Encore Primary screen that displays when you access Encore directly.

The Encore Primary screen contains these eight action bar menu items: File, View,
Extract, Generate, Search, List, Options, and Help.

Figure2+« EncorePrimary Screen

File Uiew Edtract Generate 3Zearch List Odptions Help

AEE-Encore
CoHHand ===
Aotttk Hetebbek bbbl Stk
Atk Hbtebk bbbkl ettt
Atttk Atttk Hhtebkbt kekR Atk
Aetetoick Aetetoick Atttk etk Atk
Atttk
Aotttk

Copyright ALLen $ystens Group, IncC., an unpublished work.
A proprietary product of ASG, Inc. Use pestricted to authorized licensees.
Visit the ASGE Support Web Site at www.asg.cod

Xiv
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Figure 3 shows the Encore Primary screen that displays when you access Encore through
ESW by selecting Re-engineer » Program from the ESW action bar menu. Notice that the
Primary screen name changes to ASG-ESW - Program Re-engineering when you enter
Encore through ESW. Also, the Logic menu item displaysif Insight isinstalled.

Figure 3+« ESW Encore Primary Screen

File Uiew Edtract Generate fearch Logic List Options Help

AZG-EZN — Prograd Re-engineering

CorAdand ===
Atttk Eoos 2 I S s 2 Atk
Aotttk Aebbt bbbk Aotk
Atttk Atttk Atttk stk Atk
Atttk Atttk debittck deboiolk Aok
Aotk
ettt

Copwright Allen Systens Group, INC.. an unpubliszhed vork.
A proprietary product of ASG, InC. Use restricted to authorized licensess.
Wigit the AZG Support Web Zite at wuw,asg.coH

Figure 4 shows the File - Analyze Submit pop-up that displays when you access
SmartTest directly. Figure 5 on page xvi showsthe File - Analyze Submit pop-up that
displays when you access SmartTest through ESW.

Figured« File- Analyze Submit Screen

File - Analyze SUbHiT
ConAand ===

E - Edit JCL % = EubMiT JCL

CoHpile and link JCL [PDE or sequentiall:
Data set nane

Analyze features [T-M]:
ASG-3HartTests ¥ Extended Analysis:s M

AKR data set nawe
AKR proghad nade  NEWDEHO [if overriding PROGRAA-IO0)

Analyze options:

CoHpile? [Y«H] « o o o o o« o T [¥ if needad by features)
Link 1oad Hodule reusable® [Y-M] T

XV
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The actions shown on these screens can also vary. For example, the D - Doc Options
action isonly available on the File Prepare Program screen (or File - Analyze Submit
screen) if SmartDoc isinstalled on your system. In Figure 4 on page xv, the Doc Options

action is not displayed.

Figure5e« ASG-ESW - Prepare Program Screen (accessed through ESW)

CoHHand ===

AZE-EIN - Prepare Prograd

E - Edit TCL % - Eubmit TCL

CoHpile and link JCL [PDE oF sequentiall:
Data =&t nane

0 - Doc options

Analyze features [T-M]:
Understand: M Testl T
Re-&ngineetl N Abend<DuMpl N

AKR data set nane

Extended Analysiss M

Docurent: M

AKR prograd nane  MEWMDEHO

Analyze options:

[if overriding PROGRAR-IO)

CoHpile? [¥«<H] « « o« @ & o & o T
Link l1oad Hodule reusable® (v-M] T

[¥ if needad by features)
[Test and Abend-Ounp onlyl

Notice that the Analyze featuresfield in Figure 5 lists additional ESW products than
shown on Figure 4 on page xv. Thisfield isautomatically customized to contain the ESW
products you have installed on your system. These are the names of the analyze types:

ASG-Encore Re-engineer
ASG-Insight Understand
ASG-SmartDoc Document
ASG-SmartQuest Abend/Dump
ASG-SmartTest Test

Extended Analysis (ASG-SmartTest with  Extended Analysis

Insight installed)

XVi
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Publication Conventions
ASG uses these conventions in technical publications:

Convention Represents

ALL CAPITALS Directory, path, file, dataset, member, database,
program, command, and parameter names.

Initial Capitals on Each Word Window, field, field group, check box, button, panel (or
screen), option names, and names of keys. A plussign
(+) isinserted for key combinations (e.g., Alt+Tab).

lowercase italic Information that you provide according to your
monospace particular situation. For example, you would replace
T1lename with the actual name of thefile.

Monospace Characters you must type exactly as they are shown.
Code, JCL, file listings, or command/statement syntax.

Also used for denoting brief examplesin a paragraph.

Vertical Separator Bar (|) Optionsavailablewith thedefault valueunderlined (e.q.,
with underline Y|N).

Underline Denotes a cursor-selectable field or line.

ASG Customer Support

ASG provides support throughout the world to resolve questions or problems regarding
installation, operation, or use of our products. We provide all levels of support during
normal business hours and emergency support during non-business hours.

ASG Third-party Support. ASG provides software products that run in a number of
third-party vendor environments. Support for all non-ASG productsis the responsibility
of the respective vendor. In the event avendor discontinues support for a hardware and/or
software product, ASG cannot be held responsible for problems arising from the use of
that unsupported version.

XVvii
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Intelligent Support Portal (ISP)

Online product support is available at: http://www.asg.com/support/support.asp via the
ASG Intelligent Support Portal (1SP). Y our logon information for | SP online support is:

Customer ID = NNNNNNNNN
Password = XXXXXXXXXX

where;

NNNNNNNNNN is your customer 1D supplied by ASG Product Distribution.
XXXXXXXXXX isyour unique password supplied by ASG Product Distribution.

The ASG-Intelligent Support Portal User's Guide providesinstructions on how to usethe
ISP and islocated on the ASG Support web page.

Telephone Support

To expedite response time, please have this information ready:

- Product name, version number, and rel ease number

- List of any fixes currently applied

- Any alphanumeric error codes or messages written precisely as displayed
- A description of the specific steps that immediately preceded the problem

- Verify whether you received an ASG Service Pack or cumulative service tape for this
product. It may include information to help you resolve questions regarding installation of
this ASG product. The Service Pack instructions are in atext file on the distribution media
included with the Service Pack. Y ou can access the latest software corrections and Service
Packs viathe | SP.

- The severity code (ASG Customer Support uses an escalated severity system to prioritize
serviceto our clients. The severity codes and their meanings are listed below.)

Severity Codes and Expected Support Response Times

Severity Meaning Expected Support Response Time
1 Production down, critical situation Within 30 minutes
2 Major component of product disabled Within 2 hours
3 Problem with the product, but customer has ~ Within 4 hours
work-around solution
4 "How-to" questions and enhancement Within 4 hours
requests

XViii
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E-mail

United States and
Canada

Europe, Middle East, and Africa (EMEA)

800.354.3578

1.703.464.4901

support@asg.com

During normal business hours, we recommend that you call the Central Support number

first (except in South Africa).

Phone Fax E-mail
Central Support 00.800.3544.3578 44.1727.812018 support.emea@asg.com
English 44.1727.736305 44.1727.812018 support.uk@asg.com
French 33.141.028590 33.141.028589 support.fr@asg.com
German 49.89.45716.200 49.89.45716.400 support.de@asg.com
Italian 39.0290450025 support.it@asg.com
Dutch 31.30.241.6133 support.nl @asg.com
Spanish 34.913.523.800 34.917.156.961 support.es@asg.com
South Africa 800.201.423 support.sa@asg.com
Asia Pacific (APAC)

Phone Fax E-mail
Central Support 61.3.9645.8500 61.3.9645.8077 support.au@asg.com
Australia 800.637.947 61.3.9645.8077 support.au@asg.com
Hong Kong 800.96.2800 support.hk@asg.com
Japan 81.3.5326.3684 81.3.5326.3001 support.au@asg.com
Singapore 65.224.3080 65.224.8516 support.sg@asg.com
All Other Countries (Also for any non-working numbers)

Phone Fax E-mail
All other countries  1.239.435.2201 support@asg.com

If you receive a voice mail message, follow the instructions to report a production-down
or critical problem. Leave a detailed message including your name and phone number.
An ASG Customer Support representative will be paged and will return your call as soon
as possible. Please have available the information described previously when the ASG
Customer Support representative contacts you.

XiX
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ASG Documentation/Product Enhancements

XX

Submit all product and documentation suggestions to ASG’ s product management team
at http://www.asg.com/asp/email productsuggestions.asp.

If you do not have access to the web, FAX your suggestions to product management at
(239) 263-3692. Please include your name, company, work phone, e-mail ID, and the
name of the ASG product you are using. For documentation suggestions include the
publication number located on the publication’ s front cover.


http://www.asg.com/asp/emailproductsuggestions.asp

1 Introduction

This chapter provides an introduction to SmartTest and contains these sections:

Interactive Testing/Debugaing 1
Testing Support 3
SmartTest-PLI Interfaces 4
Command Targets 5
PL/l Optimization Considerations 9
Limitations 10

SmartTestisthetesting and debugging component of ESW for COBOL, PL/I, Assembler,
and APS programs in the TSO, MV S Batch, CICS (including file services), and IMS
environments. SmartTest features include program analysis commands, execution
control, intelligent breakpoints, test coverage, pseudo code with COBOL source update,
batch connect, disassembled object code support, and full screen memory display

Interactive Testing/Debugging

PL/I programs are prepared for a SmartTest testing and debugging session using the
Analyze feature. Output from the Program Analyze processis stored in the AKR. This
information then becomes an integrated component of the test session.

Once aPL/I programis prepared for SmartTest testing, interactive testing and debugging
can begin.

SmartTest-PLI enables PL/I programsto be viewed, analyzed, tested, and debugged at
the source level. It executes in the TSO/I SPF environment and provides full |SPF
compatibility, which facilitates learning and usage through a standard IBM interface.
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SmartTest-PLI interfaces features Common User Access (CUA) screens, pull-downs, and
pop-ups that are designed to provide easy accessto al of the product features. Powerful
SmartTest-PLI commands can be used instead of, or in conjunction with, the selections
offered from the action bar.

SmartTest-PLI provides these comprehensive testing and debugging features and

functions;

Comprehensive
Program Knowledge

The testing environment contains complete knowledge about
the program including its syntax, logic relationships, and
execution flow. This knowledge is stored in the AKR.

PL/I Intelligence

Dynamic Breakpoints can be set based on PL/I syntax
statements or conditions.

Script Automation

A predefined command sequence can be included in any test
session. These script files can be created automatically during
atest session, then used for regression testing of a program.

Scrollable Window
Displays

In-context windows for data display and logic provide easy
access to related information.

Hot Key Branching

Hot key branching between paragraphs, sections, and called
routines provides easy accessto related logic.

Assembler Integration

Full screen Assembler integration of programs, called
modules, or memory display of data elementsis provided.

ESW Integration

ESW integrates the ESW family of products that support the
automation of the software maintenance cycle.

Execution Review
(Backtrack)

Execution history may be viewed using the Backtrack Facility.
This feature allows you to step backward or forward through

the executed code and view data values as they existed when

specific statements were executed.

The dramatic advantage SmartTest-PL 1 has over conventional program debugging tools
isthat it is PL/I intelligent. It provides comprehensive analysis information about a

program.

SmartTest-PLI effectively presentsinformation in an interactive environment for online
querying and/or testing on adisplay screen. The results of new code or enhancements can
be quickly and accurately tested to determine their impact on the rest of the program
logic. Program errors are easily recognized and can be quickly corrected.



Testing Support

1 Introduction

SmartTest runsunder MV S (XA/ESA) TSO/ISPF (Release 3.x) and supports these

languages, execution environments, and databases:

Supported Languages

COBOL Il

OSPL/I Version 2.3

PL/ MVS& VM

COBOL/370

Enterprise COBOL Release 3.1
CASE-generated COBOL
High-level Assembler
CA-Optimizer || (COBOL Il)
INTERSOLV APS

Supported Execution Environments

TSO

BTS

DLI

CICS Version 3.3 through Version 4.1
CICS/TS1.1,1.2,and 1.3

CICS command level programs
IMS/DC

| SPF Dialog Manager

HOGAN

LANGUAGE ENVIRONMENT
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Supported Databases

- VSAM

- IMS/DB (DL/1)
- DB2

- IDMSDB

- SYSTEM 2000
- DATACOM/DB
< TOTAL/TIS

SmartTest-PLI Interfaces

SmartTest-PLI provides Common User Access (CUA) screens, pull-downs, and pop-ups
designed to provide easy accessto al of the product features. In addition, all functionsare
available using primary or line commands.

The CUA Interface

All CUA screens include action bars. An action bar isthe line of keywords displayed at
the top of the screen. Each keyword represents actions that are available on that screen.
To view thelist of actions on a pull-down, move the cursor to the desired keyword, and
press Enter. To make a selection, enter the number that corresponds to the desired action,
or place the cursor on the desired action and press Enter. Selecting an action followed by
an ellipsis (...) displays a pop-up requesting more information.

A pop-up isawindow that is superimposed on your screen to alow entry of information
for the requested action. Compl ete the requested action by entering the desired data and
options and pressing Enter.

Command Processing

SmartTest-PLI provides both primary commands, entered in the command input area at
the top of the screen, and line commands, entered in the line sequence number area of the
screen.

SmartTest-PLI line commands are processed before primary commands.

Commands entered by pressing a PF key are handled asif entered in the primary
command input area. If acommand is entered by pressing a PF key, the contents of the
command input area are appended to the PF key command. The combined text is then
executed as awhole.



1 Introduction

Multiple commands entered in the command input area are separated by an | SPF
command delimiter (usually a semicolon) and are processed in aleft-to-right sequence.

Note:

The command delimiter isdefined for ISPF inthe COMMAND DELIMITER field on the
ISPF Termina Characteristics screen.

See the ASG-SmartTest Reference Guide for details on CUA and command syntax.

Screen Format

SmartTest screens are modeled after the TSO/I SPF edit screen. Figure 6 shows a
SmartTest Program View screen.

Figure6+ SmartTest Screen Example

Command ===> ©)

File View Test Search List Options Help

Q) (©)
Program View VIAPPLI _VIAPPLI1 -A
Scroll ===> (D) CSR

®

>S>>>>>

VALUE >

DATA_PACKED_DEC = DATA_PACKED_DEC + 1;

DEC FIX (15,0) ADDR 000D6870 |
< * INVALID NUMERIC * |

000483
000504
(F)005
000506
000507
000508
000509

(O]

SOC7FIX1:
RETURN;

END SOC7_DEMO;

|STATUS: DATA EXCEPTION (OC7)
| STMT: 000482 OFF: 000C10 AMODE: 31
|SOURCE: DATA_PACKED_DEC = DATA_PACKED_DEC + 1; [

20 LINES NOT DISPLAYED

PROGRAM: VIAPPLI1 DATE: DDMMMYYYY |
MODULE: VIAPPLI TIME: HH:MM:SS |

(A) Program View

Name of the screen.

(B) VIAPPLI.VIAPPLI1

Module/program being viewed (module.program). This
areaof the screeniscalled the short message areaandisalso
used to temporarily display short informational or error
messages. A value of -A (Active program) following the
modul e.program name indicates that this program is
currently being tested. A value of -Q (Qualified) indicates
this program has been displayed for viewing on the Program
View screen while another program is being tested.
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(C) Command ===>

Thisisthe primary field for entering SmartTest-PL|
commands.

(D) Scroll ===>

Scroll specifies the number of lines or columnsto scroll the
display screen. The Scroll ===> field is omitted from
screens that cannot be scrolled. These are the valid values:

1- 9999: Specifies the number of lines or columns to scroll.

CSR: Specifiesthe screen isto be scrolled until the cursor
is at the top, bottom, left side, or right side of the screen.

MAX: Specifiesthat the top, bottom, right, or left marginis
the scroll value.

HALF: Specifies ascroll value of ahalf screen.
PAGE: Specifies ascroll value of one screen.

DATA: Specifiesascroll value of one line lessthan a
screen. Thisfield is omitted from screens that cannot be
scrolled.

(E) Long message area

Descriptive, informational, or error messages are displayed
in this area. Long messages are displayed when there is no
corresponding short message, or whenyoutypeHELPinthe
command input area while a short message displays.

(F) Line command input
area

SmartTest line commands may be entered over the
displayed line numbersin columns 1 through 6 aswith other
TSO/ISPF editor screens.

(G) Status box at the
bottom of the SmartTest
screen

This provides current status information about the program
being tested including the reason for an interruption in
execution, the current statement number and offset in the
program, and the text of the next source statement to be
executed.
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Command Targets
A target isthe object of a SmartTest primary command. Targets are defined in these
categories:
- Label name
<  Variable name
- Pattern string
- Linerange
- Procedure name

- Subset name

Label Name Target

A label namein aprogram is any section name. A label in PL/I isany PL/I block or label
name. A label namein an Assembler program is any Assembler label. A label namein
COBOL isany paragraph or section name. The label name specifies all transfers of
control to a section.

Variable Name Target
A variable name can be;
- Elementary variable name - String or arithmetic

- Program control variable - Pointers

-«  Aggregates - Arrays and structures

Any legal reference for a data element can be specified as a variable name. Any reference
toanentry in an array istreated as an individual element. When variableitems overlap so
aname can refer to parts of multiple variable items, searches are performed on each part
and all references are reported.

Fully qualified variable names can be specified by the high- to low-level qualifiers
separated by periods, for example:

PROCEDURE_NAME . DATA_NAME_ELEMENT

Multiple variable names can be located at the same time by concatenating the variable
names with a plus sign (+) between them, for example:

DATA NAME1 + DATA NAMEZ2
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Pattern String Target

A pattern string is a sequence of characters. It must be surrounded by single or double
quotes if it contains blanks. Strings of non-alphanumeric characters can be specified by
theX'string', T'string’, and Pstring' operands. The string can be further qualified
using the WORD, PREFI X, or SUFFIX subordinate operands.

X'string' Specifies a hexadecimal string, enclosed in single or double quotes.

T'string' Specifies atext string, which disregards upper and lowercase,
enclosed in single or double quotes.

Pstring' Specifiesapicturestring, enclosed in single or double quotes. These
are the valid picture strings

P=" Any character

P-" Any nonblank character

P. Any nondisplay character

P#  Any numeric character

pP- Any non-numeric character

P@  Any aphabetic character (upper or lowercase)
P<'  Any lowercase alphabetic character

P>' Any uppercase alphabetic character

P$ Any special character (not alphabetic or numeric)

WORD Specifies a string preceded and followed by any non-alphanumeric
character (except hyphen).

PREFIX Specifies aword that begins with the specified string.

SUFFIX Specifies aword that ends with the specified string.

Line Range Command Target

A linerange target can be asingle line or agroup of lines. Line ranges are specified by
placing a hyphen (-) between the first and last line numbersin the range (e.g., 214 - 376).
Line numbers are shown in the first six columns on the Program View screen. If the
specified line number is greater than the last line in the program, the last line is assumed.
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Procedure Name Target
The procedure nameisthe internal CSECT name assigned by PL/I to the specified PROC
statement.

Subset Name Target

Thisis one of the PL/I language subsets. See "Searching for PL/I L anguage Subsets* on
page 169 for atable of subsets.

PL/I Optimization Considerations

SmartTest-PLI may test optimized PL/I programs differently than non-optimized
programs because of modifications made to the program code by the optimizer. Testing
optimized PL/I programs may produce these results:

=  Certain source lines may appear not to be executable from the Program View
screen, and cause unexpected results for commands such as STEP, BREAK, and
ZA (Zoom Assembler).

- Use the GO command with care. Source code can be altered or even eliminated in
the optimization process. As aresult, unpredictable or erroneous results can occur
with the GO command. See the optimized assembler output generated by the
compiler as a navigational tool for testing optimized programs.

<  ThePL/I Optimizer often moves all or part of the processing for one statement to
another statement. When this occurs, you may find that certain variables remain
unchanged, even after a statement that modifies the field.

Note:

For the SmartTest-PLI test session, you should not use the PL/I Optimizer. After
completion of testing and correction, you can recompile using the Optimizer to get a
more efficient program.
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Limitations

These PL/I coding techniques are unsupported in all current and past versions of
SmartTest-PLI. ESW is currently unable to support Based variables when the variableis
based on a pointer that is defined as part of an array of pointers. For example, thiscodeis
supported by SmartTest-PLI:

DCL 1 BASIS_BEREICH, /* Individual pointer declarations */

3 P1 PTR,

3 P2 PTR,

3 P3 PTR,

3 P4 PTR,

3 P5 PTR;
DCL BEREICH1 CHAR(20);
DCL BEREICH2 CHAR(20);
DCL BEREICH3 CHAR(20);
DCL BEREICH4 CHAR(20);
DCL BEREICH5 CHAR(20);

P_BASIS = ADDR(BASIS_BEREICH);

P1 = ADDR(BEREICH1);
P2 = ADDR(BEREICH2);
P3 = ADDR(BEREICH3);
P4 = ADDR(BEREICH4);
P5 = ADDR(BEREICH5);

DCL 1 STRUKIA BASED(P1),
3 F1  CHAR(10),
3 F2  CHAR(10);
DCL 1 STRUK2A BASED(P2),
3 F1  CHAR(10),
3 F2  CHAR(10);
DCL 1 STRUK3A BASED(P3),
3 F1  CHAR(10),
3 F2  CHAR(10);
DCL 1 STRUK4A BASED(P4),
3 F1  CHAR(10),
3 F2  CHAR(10);
DCL 1 STRUKSA BASED(P5),
3 F1  CHAR(10),
3 F2  CHAR(10);

STRUK1IA.F1 = "A1A1A1A1Al1";
STRUK1A.F2 = "B1B1B1B1B1";
STRUK2A.F1 = "A2A2A2A2A2";
STRUK2A.F2 = "B2B2B2B2B2";
STRUK3A.F1 = "A3A3A3A3A3";
STRUK3A.F2 = "B3B3B3B3B3";
STRUK4A.F1 = "A4A4A4A4A4"
STRUK4A.F2 = "B4B4B4B4B4";
STRUK5A.F1 = "A5A5A5A5A5";
STRUK5A.F2 = "B5B5B5B5B5";
STRUK4A.F1 = " XXXXXXXXXX";

10
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However, this variation on the same code is not currently supported by SmartTest-PLI:

DCL 1 BASIS_BEREICH, /* TABLE OF POINTER"S */
3 P_(5) PTR;

DCL BEREICH1 CHAR(20);

DCL BEREICH2 CHAR(20);

DCL BEREICH3 CHAR(20);

DCL BEREICH4 CHAR(20);

DCL BEREICH5 CHAR(20);

P_BASIS = ADDR(BASIS_BEREICH);
P_(1) = ADDR(BEREICH1);
P_(2) = ADDR(BEREICH2);
P_(3) = ADDR(BEREICH3);
P_(4) = ADDR(BEREICH4);
P_(5) = ADDR(BEREICH5);

DCL 1 STRUK1 BASED(P_(1)),
3 F1 CHAR(10),
3 F2 CHAR(10);
DCL 1 STRUK2 BASED(P_(2)),
3 F1 CHAR(10),
3 F2 CHAR(10);
DCL 1 STRUK3 BASED(P_(3)),
3 F1 CHAR(10),
3 F2 CHAR(10);
DCL 1 STRUK4 BASED(P_(4)),
3 F1 CHAR(10),
3 F2 CHAR(10);
DCL 1 STRUK5 BASED(P_(5)),
3 F1 CHAR(10),
3 F2 CHAR(10);

STRUK1.F1
STRUK1.F2
STRUK2.F1
STRUK2.F2
STRUK3.F1
STRUK3.F2
STRUK4.F1
STRUK4.F2
STRUK5.F1
STRUK5.F2
STRUK4.F1

"A1A1A1A1AL";
"B1B1B1B1B1";
"A2A2A2A2A2" ;
"B2B2B2B2B2";
"A3A3A3A3A3";
"B3B3B3B3B3";
"A4AAALALAL"
"B4B4B4B4B4*" ;
"AS5A5A5A5A5" ;
"B5B5B5B5B5";
" XXXXXXXXXX® 5

The Dictionary dumps used for analysis do not contain enough information about the
Base Pointer when the pointers are contained in an array.

11
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2 Additional Languages

SmartTest-PLI and Assembler

The SmartTest-ASM option is designed to aleviate the burden of testing and debugging
Assembler Language Code programs by providing an online, interactive testing
environment with powerful features suited to the needs of assembler programmers. The
assembler component is fully integrated with SmartTest-PLI. All testing and debugging
functions are available with assembler including: Program View, execution control,
breakpoints, monitoring and changing data, and abend processing. The only difference
between using SmartTest-PLI and SmartTest-ASM is some limitation in certain analysis
and debugging facilities.

SmartTest-ASM enables you to work with the source level display of your Assembler
programs in Program View. When alower level of detail is necessary, SmartTest allows
viewing and manipulation of memory, input data, and the general purpose and floating
point registers.

See the ASG-SmartTest for COBOL and Assembler User’s Guide for more information
about Assembler.

SmartTest-PLI and COBOL

SmartTest for COBOL is afull-featured, source-level testing tool for COBOL programs.
For coverage of the testing and debugging features and additional information on

SmartTest support for COBOL, see the ASG-SmartTest for COBOL and Assembler
User’s Guide.

13
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3

SmartTest-PLI Test Session

This chapter introduces the SmartTest test session and contains these sections:

Introducing the Test Session 15
Beginning a SmartTest Session 16
SmartTest User Options 18
Application Knowledge Repository (AKR) 29
Program Analyze 32
Setting Up the Test Session 37
Saving the Test Session Setup 50
Restoring the Test Session Environment 52
Terminating a Test Session 53

Introducing the Test Session

Thefirst time you use SmartTest, verify parametersthat are initialy set to installation
defaults. This section describes how to perform these tasks:

- Begin a SmartTest session.

=  Set and verify these user options from the Options pull-down:

Online operation parameters. These parameters establish online operational
defaults.

Log, List, Punch, and Work file alocations. The Log, List, Punch, and Work
filesareused by SmartTest for recording and printing selected information such
as error messages and printed output, and as work space.

15
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— Log, List, and Punch file processing options. The processing options determine

the processing of these files upon exiting SmartTest.

—  Script file alocations. The default script file concatenation sequence can be

atered for your session.

—  PFkey values. The PF keyscan beredefined to appropriate commandsfor your

Sessions.
- Allocate an AKR.

<  Anayzeaprogram.

Beginning a SmartTest Session

16

The method that you use to invoke SmartTest depends on your system setup. If you need

assistance to activate SmartTest, see your systems administrator.

If your site starts SmartTest directly, use the | SPF selection or CLIST asindicated by
your systems administrator. After you activate the session, the ESW Primary screen,

shown in Figure 7, displays.

Figure 7« Existing SystemsWorkbench Primary Screen

File Understand Change Test Docunent Re-enginesr  Heasure  Help

AEG-Existing Eystens Workbench - ASG-ESW
CoHHand ===k _

ettt Hebebbk kbbbt Aottt
Atttk Eoos 2 I S s 2 Atk
Aetetotek Aetetotek destetebk etttk Eood
Atttk Atttk Atttk stk Atk
Atttk

Copwright ALlen gystens Group, IncC., an unpublished wark.
A proprietary product of ASG, Inc. Use restricted to authorized licensess.
Visit the ASE Support Web Site af wuW.asq.coH
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To start SmartTest, follow this step:

P Select Test » Module/Transaction. After you activate the session, the SmartTest

Primary screen, shown in Figure 8, displays.

Figure8e« SmartTest Primary Screen

File Uiew Test =fearch List Options Help

AZG-EHartTest

Corrand ===
Aottt Aebebebt kbbbl Atttk
Aottt Aetebbt bbbk Aotttk
Hetetek Hetetek Aotttk dstsiolek Ftk
Aetststek Aetststek Atttk debstsiek Atk
Aotttk
etttk

Copyright Allen Eystens Group, IncC., an unpublished vork.
A proprietary product of ASG, IncC. Use restricted to authorized licensees.
Visit the ASG Support Web Site at wWW.asq.coH

Note:

If you start your SmartTest session using the ESW Primary screen, the product name

displays on the screens as ESW - Testing/Debugging.

17
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SmartTest User Options

Upon initial use of SmartTest, options should be customized to reflect the appropriate
settings for your situation. Some options are given defaults during installation.

To display the Options pull-down

1  Sdect Options on the action bar and press Enter. The Options pull-down, shown in
Figure 9, displays.

Figure 9« Options Pull-down

File Ujew Test 2Zearch List O0ptions Help

AE 1. Product paradeters...

ConMand ===» __________________ 2. Product allocations... | _________.
o Logelistepunch. ..
» BCHipt file allocationSae.. Hefetotet
. PF Keys... Heteteh
. Hodes - ZET Options...
. Equate...

=1 R

A=tttk A=tttk Aebetstotek deboletek Aotk
settoiak settoiak Aobtsict=h deboletek Hebak

Copwright Allen Swsteds Group, Inc., an unpublished wark.
A proprietary product of A%G, Inc.  Use restricted to authorized 1icensees.
Uizit the AZG support Web fite at www.asg.cod

2 Sdlect one of these options from the pull-down to customize the SmartTest
environment:

Product parameters  Displaysthe Options - Product Parameters pop-up used to
set parameters that affect the online operation of
SmartTest.

Product allocations Displaysthe Options- Product Allocations pop-up used to
specify allocations for the Log, List, Punch, and Work
files.

Log/list/punch Displays the Options - Log/List/Punch Definition pop-up
used to set values for alocating, formatting, and
processing the SmartTest Log, List, and Punch files.

Script file alocations  Displaysthe Options - Script File Allocations pop-up used
to set the default script libraries.

18
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PF Keys Displays the Options - PF Key Definition pop-up used to
edit PF key values.

Modes Displays the Options - Modes pop-up used to enable and
disable SmartTest processing modes (LEARN, SCRIPT,
XMODE).

Equate Displays the Options - Equate pop-up used to define a

substitute name for any character string. Equated names
are used inthe same manner asany datanameisused. They
can be saved in the AKR and may be viewed on the
Equates List by typing LIST EQUATES.

Note:
If you have Insight installed, this option displays as
Scratchpad on the Options pull-down. See the online help
or the ASG-Insight Reference Guide for moreinformation
about the Scratchpad option.

Online Operation Parameters

Use the Options - Product Parameters pop-up to set parameters affecting the online
operation of SmartTest. Thisincludes specifying whether pseudo code and equates are to
be saved.

To set online operation parameters

1  Sdect Options » Product Parameters. The Options - Product Parameters pop-up,
shown in Figure 10, displays.

Figure 10« Options- Product Parameters Pop-up

Options - Product Paraneters
CoHHand ===k

ALAFH & o w n s m =3 [YES or N0l
fave pseudo code . . YEE [¥E% or HO)
Zave equates . . . . YES [YES or NO)
Zave Harks o . . . . NO [TEE or NO)
cursar character . « % [Token substitution character)

2 Enter the appropriate information in the fields.

19
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Fields

Alarm Controlsthe audible alarm on the terminal. If YES, the alarm sounds
when an error message displays. Some terminals do not support this
alarm control.

Save pseudo Specifies the default for saving pseudo code (pseudo code,

code Breakpoints, and When Conditions) when exiting from a program.

Save equates Specifiesthe default for saving equates when exiting from a program.

Cursor Sets the cursor token substitution character. The cursor substitution

Character character can be used in any primary command during atest session.

Any character can be specified as the token substitution character;
however, it should beacharacter that israrely used in commands. The
default substitution character is the percent sign (%0).

Log/List/Punch/Work File Allocations

20

Use the Options - Product Allocations pop-up to set and verify the DASD alocations for
the Log, List, Punch, and Work files. These options are initially set to default values
established during product installation by the Systems Programmer and probably only

need verifying.

To definethe Log, List, Punch, and Work file allocations

1  Select Options» Product Allocations. The Options - Product Allocations pop-up,
shown in Figure 11, displays.

Figure 11« Options- Product Allocations Pop-up with SM'S

ConRand ===

dptions - Product Allocations

Log files

GEMEFiC UNit « o

Uolume =arial
List file:

GermeFic Unit o . .

Uolume =erial
Punch filex

Generic unit « « .

Uolure =erial
Mork filesd

GEneEric Unit . . .

Uolume =arial

Epace units . . .
PriHary space . .

fecondary space

ERTDA [generic group naWe o unit address)

. ERTHEL [blank for authorized default volure]
EvEDA [genaric group naHe o unit address)

. ERTEO1 [blank for authorized default wolumre]
ERTDA [generic group naWe o unit address)

« ERTEHEL [bBlank for authorized default volumre]
ErEDA [generic group naWe o unit address)
______ [Blank for authorized default volure]
CYLE [BLKZ, TREZ or CYLE)

[space units]
[space units)

Enter the appropriate information in the fields.
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Logfile

Specifies the Management and Storage Class or the device type and
volume serial number for the Log filethat isallocated upon entry into
SmartTest. Log files are used for internal messages.

List file

Specifies the Management and Storage Class or the device type and
volume serial number for the List file that is alocated the first time a
regquest is made to print output using the LPRINT command.

Punch file

Specifies the Management and Storage Class or the device type and
volume serial number for the Punch filethat is allocated thefirst time
areguest is made to punch output using the LPUNCH command.

Work file

Specifies the Management, Storage, and Data Class or the device
type, volume serial number, and space requirementsfor the Work file
that is allocated upon entry into SmartTest. Approximately one
cylinder (on a 3380 device) isrequired for a 5,000 line program.

Log/List/Punch Processing Options

Use the Options - Log/List/Punch Definition pop-up to define and set processing values
for the SmartTest Log, List, and Punch files. These files are used for system message
logging, error handling, and holding the results of several SmartTest commands. It is not
necessary to exit SmartTest to process these files. Some options are initially set to default
values established during product installation by the Systems Programmer.
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To specify the Log/List/Punch Definition options

1  Seect Options» Log/List/Punch. The Options - Log/List/Punch Definition pop-up,
shown in Figure 12, displays.

Figure 12« Options- Log/List/Punch Definition Pop-up

options - LogeList<Punch Definition
CoMHand ===

1 - Process log file 2 - Process list file I - Process punch file
4 — Custodized data set nane

options Lo List Funch
Process option o « o & & = 4 PE FE
PriHary tracks P | 1 1
Fecondary tracks .. 2 5 5
Limes peb page . o« o &« = 56 Sk Sk
Ewsout class o 0 . 0 0w s * * *

Process options: PE [(print<-keepl, PD [print<delete], K, or D.

Job statenent infornationd
#/UZERL JOB CACCTD, "USERL'  FETY=6
A HEGCLAZE=N
<~kTOEPARH EYIAFF=CPUC
o

2  Enter the appropriate information.

Fields

1- Processlogfile Verify or changethe Optionsfor the Log file, then select option 1 to
processthe Log file. A new fileis allocated to collect additional
data, if required. The Log fileis processed when you press Enter.

2 - Processlist file  Verify or changethe Optionsfor the List file, then select option 2to
processthe List file. By default, a new fileis allocated to collect
additional data, if required. Thefile nameisin this format:

userid.yyyxxxxx.VIALIST

where:

yyy isthe product ID.

XXXXX is asegquential number starting with 00001.
The List file is processed when you press Enter.

3 - Processpunch  Verify or changethe Optionsfor the Punch file, then select option 3
file to process the Punch file. Thisfileis defined as fixed block with
80-byte records. The Punch fileis processed when you press Enter.
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4 Customized data Select option 4 to display the Options - Log/List/Punch Name

set name

Customization pop-up on which you can specify user-defined
dataset names for the Log, List, and Punch files. Y ou can also
choose to be prompted for the DSN name during file processing.

Process option

Enter one of the listed processing options. The default is PD for the
Log and List files, and PK for the Punch file.

Primary tracks

Enter the number of primary tracksto allocate. A size change does
not take effect until the next allocation occurs. The default is 1 for
the Log, List, and Punch files.

Secondary tracks

Enter the number of secondary tracks to allocate. A size change
does not take effect until the next allocation occurs. The defaultis2
for the Log fileand 5 for the List and Punch files.

Lines per page

Enter the number of print lines per page. Typica maximum values
are 60 for six lines per inch and 80 for eight lines per inch. The
default is 56.

Sysout class

Enter the SY SOUT classvalue. Thedefault isan asterisk (*), which
sendsthe SY SOUT to the destination specified in the MSGCLASS
parameter on the JOB statement.

Process options

Liststhe available options for the Log, List, and Punch files. These
arethevalid values:

- PK. Print and keep.

<  PD. Print and Delete.

= K. Keep without printing.
- D. Delete without printing.

XXXXX FILE IS

Displays when the Log, List, or Punch file has been properly

ALLOCATED allocated. If the message does not appear, check the assignments on
the Options- Product Allocations pop-up. Xxxxxx isLOG, LIST, or
PUNCH depending on the file that was allocated.

Job statement Enter the appropriate JOB statement information for your

information installation. These JCL statements are required if the PK or PD
processing option has been specified for processing theLog, List, or
Punch files.

Note:

When the PK or PD option is specified, avalid job card must be specified in the JOB
STATEMENT INFORMATION field prior to processing any Log, List, or Punch files.
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If you specify K or PK process option, you can customize the data set where the log, list,
or punch fileis alocated. By default, SmartTest allocates the Log, List, and Punch files,
for example:

userid.STTnnnnn . VIAXXXXX
where:
useridisyour TSO user ID.
nnnnn isasequential number from 00001 to 99999.
XxXxxX isLOG for Log, LIST for List, and PUNCH for Punch files.

If you have specified a TSO Prefix, the prefix will be appended to the beginning of the
file name allocated for the Log, List, and Punch files.

To customize the Log, List, or Punch dataset name

1  Fromthe Options - Log/List/Punch Definition pop-up, type 4 and press Enter to
display the Options - Log/List/Punch Name Customization pop-up shown in

Figure 13.

Figure 13« Options- Log/List/Punch Name Customization Pop-up

options - Log-sList<Punch Name Custodization
Conrand ===

You can define a custodized nae when You choose option PE [print<kespl or
K [keep] by specifying Ulser). Epecifwing v¥(es) on ProHpt later lets wou
dafing a CUStoH nade as you process each log-list<punch file. Otherwise,
specifyw data set name and file node. Then press Enter.

options Log List Punch
File MaHing « « « « o = = u u 5 Ul=ser] o Z[ysted]
FroWpt later for DEM . . ¥ T _ vles] o Hlol

The following are needed if Ulser] and Mlo) are specified above

Log Data et nanme [5eq]
File Hode . . 0O ofverwrite] or Alppend]

List Data set name [5eq]
File Hode . . _ ofverwrite] or ALppend]

Funch Data set naue [5eq]
File Hode . . _ ofverwrite]l or ALppend]
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TypeUintheFileNamingfield for Log, List, and/or Punch toindicate auser-defined
dataset name. Enter the appropriate values in these fields:

File Naming

Specifieswhether theLog, List, and Punchfilesare named
by system default (S) or user-defined (U) dataset names.

Prompt later for DSN

Enablesyou to define acustom name during processing. If
you specify N, you must enter a dataset name in the
corresponding Data set namefield, and specify Overwrite
or Append in the File Mode field.

If you specify Y in the Prompt later for DSN field,
SmartTest prompts you for the dataset name during file
processing.

Log Data set name
List Data set name
Punch Data set name

Indicates the name of the dataset inwhichtheLog, List, or
Punch files will be alocated during processing.

File Mode

Specifies whether additional Log, List, and Punch files
overwrite or are appended to the existing files during
processing.

If you specify Y in the Prompt later for DSN field, SmartTest prompts you for the
dataset name during file processing using the Log Name Customization pop-up,

shown in Figure 14.

Figure 14 « Log Name Customization Pop-up

CoMHand ===k

Log Nane CustodiZation

Enter.

Custon  Data =et nane

The current 1og file's data set naMe is shown below.
nawMe, specify a new sequential data et name.
has to have LRECL=137 and RECFH=U; and specify the file Hode.
curtent Data zet naMe ° *'

File Hode . . « _

To have a custod
If it already edists, it
Then press

ofverwrite]l or Alppendl]
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Script File Allocations

Fields

26

Use the Options - Script File Allocations pop-up to display and/or modify the default
script file concatenation sequence for your session. Script files are sequential datasets or
members of partitioned datasets. Script files can be used to initialize a session, set default
values, set up a session, execute or re-execute a session, or execute a predefined
command sequence.

To specify your default script files

1  Select Options » Script file allocations to display the Options - Script File
Allocations pop-up, shown in Figure 15.
Figure15« Options- Script File Allocations Pop-up
gptions - EZcript File Allocations
CoHHand ===
R - Restore default icript allecations
Enter desired ECri FIT file concatenation.
Fcript file data set nades:
2 Enter or modify the dataset names to be used for the default script files for your
session. Type R to restore the default values for your installation.
Note:
When initializing for defaults, the lines are filled from the bottom to allow
concatenation.
R Restores the default Script library allocations set at install time.
Script file Enter the dataset names of the desired Script filesinthe order inwhich

dataset names  they should be concatenated.
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PF Key Values

To display and/or redefine PF key values used with SmartTest

1  Seect Options » PF Keys. The Options - PF Key Definition pop-up, shown in
Figure 16, displays.

Figure16« Options- PF Key Definition Pop-up

options - PF Kew [01-12) Definition
CoWHand ===

Fress Enter to process changes and-or to display alternate keys.
Press PF3<15 [END] to edit.

Mubber of PF kews: 24 TerHinal type: 3278

FFE1 HELP
PFE2 ZPLIT
PFE3Z END
FFEd RUN
PFFAS RFIND
PFOE ZTEP
FFa7 UP
PFEE DOMN
FFE% ZUAP
PF10 ERAMCH
PF11 ERANCH EARCKUR
PF12 RECALL

2  Enter theappropriate PF key valuesin thefields. PF keys 1 through 12 are displayed
initially. To display PF keys 13 through 24, press Enter.

Thevaueinthe Terminal type field indicates the type of terminal being used. SmartTest
supports these 3270 type terminals:

-  3270-2 (24 lines x 80 columns)
- 3270-3 (27 lines x 80 columns)
e  3270-4 (42 lines x 80 columns)
e  3270-5(27 lines x 133 columns)
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Mode Options

To enable or disable the mode indicated by the specified option

P Select Options » Modes or type SET with no operands. The Options - Modes pop-up,
shown in Figure 17, displays.

Figure 17« Options- Modes Pop-up

dptions - Hodes

CoHRand === Forall ===> CER
AFG2343] USE THE DOMM COHAAND FOR ADDITIOMAL TEST SESSION OPTIONS.

option Fet Descri ption
AZH ON Display Aszedbler code in status bod, and instruction STEP

AZHUIEM OFF  Diszplay Assedbler code far pragrans not on the AKR
AUTOQUAL oM QUALIFY to the Active Prograd after a RUM or STEP
BACKTRACK.  OFF  BACKtrack Recording Hode is dizabled with a buffer of 1H

ERERKE ON The BREAKpoint facility i enabled

COLUHNE aFF The COLUHNE option is disabled

CUA 0N The CUA Henu facility is enabled

DATA AUTO  Nunber of lines for Zood Data wWindows, or AUTO

DELAY 1 NuHbetr of =econds to delay between =teps during STEP AUTO

FLOATING  OFF  Dizplay floating point registers in the status bod
GEMERRATED ul/} Display generated code With the original Solkce Code

HEX OFF Diszplay data in hedadecinal fordat

KEEP AUTO  Mubber of lines for KEEP window, o AUTO

LANGUAGE COE The current LANGUAGE for the test session is COBOL
LE OFF  Mornal Language Environnent ertor processing
LERARN OFF  Dizplay internally generated Prinary ConHands
LINE OFF  Honitar LINKed-to pragrans for the test zession
HAIM oM The prograd being tested is a HAIMLIME

HONITOR oM The default for the RUM CoWHand is HONITOR

Each mode shown on this pop-up can be directly enabled or disabled using the SET
command with the corresponding operand. The current setting for each Test Session
option is saved between sessions with the exception of BREAK, PSEUDO, SCRIPT, and
WHENS. Defaults for these options are restored when a new session is initiated.

Scroll the screen forward to display modes that do not appear. The STOPEXEC and
STOPHAND modes only appear if the current environment is CICS.

For detailed descriptions of options, see the ASG-SmartTest Reference Guide.

Note:
For testing PL/I programs, the MAIN option must be ON.
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Application Knowledge Repository (AKR)

Before programs can be tested, your program must be analyzed. The results of the
analyze are stored in the AKR for use by SmartTest while testing. An AKR can be
defined to be shared by all users, or multiple AKRs can be defined for use by
departments, groups, or individuals.

Online and Batch utilities are provided for managing the AKR. These utilities allow you
to perform these tasks:

=  Allocate or expand the AKR.
- Rename and del ete programs.

<  Work with the AKR directory.

To allocate an AKR

1  Sdect File» AKR utility or type UTILITY. The File - AKR Utility pop-up, shown
in Figure 18, displays.

Figure 18« File- AKR Utility Pop-up

File - AKR Utility
CoHHand ===k

Elank — Display Herber list 0 - Delete Herber
A = Allocate~<exdpand AER R - RenaWe Henber

Application Knowledge Repository [AKR]:

Data set nane . . ‘USERLZ.GEMERAL.AKR’
HeHber o o & & & __________ [if "R" or "O" selected]
MNew naMe . o o & __________ [if "R" zelected]

Valume serial o o ______ [if not cataloged]
Password . . . . [if password protected]

2 Specify the member name of the AKR in the Data Set Name field.
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3 TypeAinthecommand input areaand press Enter. The File- AKR Allocate/Expand

pop-up, shown in Figure 19, displays.

Figure19+« File- AKR Allocate/Expand Pop-up

File - AKR Allocate~Expand
CoHHand ===}

% - EuUbMit JCL E - Edit JCL L - Epecify Catalog
Expand edisting AKR . . . NO [¥es or Mol
AKR data set naWe . . . . 'UEER1Z2.GEMERAL.AKR'
L T T T R,
Unit o w w w a0 0 » » 12 [Generic unit nane]
Zpace units .« . . . . . RECORDE [Records, Tracks or Cylinders)
PriHary Space . . . . . LT [Pridary anount in abouve units)
fecondary Space . . . . B [#econdary aWount in abouve units)

Jobk statenent infordHations
“sUZERLZ  TOBCaccT O,
o HEGECLASE=A
<~k IMZERT '~#ROUTE PRINT NODE.UZER' HERE IF MNEEDED.
sk

Enter the appropriate information in these required fields:

Type NO in the Expand existing AKR field.

Select the AKR dataset name in the AKR dataset name field.

Enter the appropriate SMS classes, if your siteisusing SMS, or the desired

gpace and volume information.

Enter avalid Job card in the Job statement information field.

If you need to specify acatalog or password, type C in the command input area and
press Enter to display the AKR Catalog Information pop-up. After completing the

dataset name and/or password, press PF3 to return to the File - AKR
Allocate/Expand pop-up.

4
a
b
c
d

5

6

If you need to review or edit the JCL prior to submitting it, type E in the command

input area and press Enter.

a

If you do not need to edit the JCL, submit the JCL by typing S in the command input

After making the desired modifications, issue the standard | SPF SUBMIT

command.

Return to the File - AKR Allocate/Expand by issuing the END primary

command or pressing PF3/PF15. The edited JCL is not saved.

area and pressing Enter.
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7  Verify the AKR alocation results by examining the job output. Sample job outputs
are presented in Verifying AKR Allocation Results.

Verifying AKR Allocation Results

After the AKR alocation batch job has completed, review the job output to verify
successful allocation and initialization. Figure 20, Figure 21, and Figure 22 show output
excerpts with messages that indicate successful AKR allocation and initialization.

Figure20« IDCAM S Utility Condition Code M essage Output

IDCAMS SYSTEM SERVICES TIME: HH:MM:SS DDMMMYYYY
PAGE 1

DEFINE CLUSTER -
(NAME(USER12 . GENERAL . AKR) -
CYLINDERS(5) -
CONTROLINTERVALS1ZE(4096) -
NUMBERED -
RECORDS IZE (4089 4089) -
RECOVERY -
UNIQUE -
SHAREOPTIONS(3 3)) -
DATA -
(NAME(USER . TEST . AKR.DATA))
IDCO5081 DATA ALLOCATION STATUS FOR VOLUME SYSDA IS 0
1DCO0011 FUNCTION COMPLETED, HIGHEST CONDITION CODE WAS O
1DCO0021 I1DCAMS PROCESSING COMPLETE . MAX IMUM CONDITION CODE WAS O

Figure2l+« AKR Initialization M essage Output

ASG-CENTER-0S(ESA) AKR UTILITY LOG DDMMMYYYY HH:MM:SS
PAGE 1

INIT DSNAME(USER12.GENERAL . AKR)

ASG13161 AKR "USER12.GENERAL.AKR™ INITIALIZED.

ASG13141 *** END OF VIASYSIN ***

Figure22« AKR Utility Log Summary M essage Output

ASG-CENTER-OS(ESA) AKR UTILITY LOG - SUMMARY DDMMMYYYY
HH:MM:SS PAGE 2

ASG13001 1 AKR(S) INITIALIZED O FAILED.

ASG13151 *** END OF SUMMARY REPORT ***

31



ASG-SmartTest PLI User’s Guide

Program Analyze

The Program Analyze extracts knowledge about the program and populates the AKR
with thisinformation. Programs can be analyzed if they compile with areturn code less
than 8 and have only W or | level messages.

Program Analyze Requirements
These are the input to the Program Analyze:
=  Thecomplete JCL to fetch, compile, and link the program.
- Program Analyze parameters indicating the type of analysisto be performed.

= Analocated Application Knowledge Repository to receive Program Analyze
information.

Analyzing a Program

Y ou can submit the Program Analyze job using these methods:

- From the File - Analyze Submit pop-up in SmartTest (see"Method 1 - Analyzing a
Program Using SmartTest" on page 33).

- From a TSO/ISPF edit screen by executing the VIASUB edit macro (see"Method 2
- Analyzing a Program from an Edit Session" on page 34).

- From any TSO/ISPF screen or user screen by executing the VIASUBDS CLIST
(see "Method 3 - Analyzing a Program from a User Screen” on page 36).

This table describes when to use each method:

Compile JCL isfrom Method for Executing Analyze Job

PDS or sequential dataset "Method 1 - Analyzing a Program Using
SmartTest" on page 33, "Method 2 -
Analyzing a Program from an Edit Session"
on page 34, or "Method 3 - Analyzing a
Program from a User Screen" on page 36

Librarian, Panvalet, or other user source "Method 2 - Analyzing a Program from an

manager when editing the JCL Edit Session” on page 34

Screen-driven submit facility that "Method 2 - Analyzing a Program from an

generates the JCL Edit Session" on page 34 or "Method 3 -
Analyzing aProgram from aUser Screen” on
page 36
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Method 1 - Analyzing a Program Using SmartTest

To analyze a program while in SmartTest

1  Select File» Compile/Analyze action. The File - Analyze Submit pop-up, shownin
Figure 23, displays.

Figure 23« File- Analyze Submit Pop-up

File — AnalYze SUbHit
CoHMand ===

E - Edit JCL % - EUBHIiT JCL

Codpile and link JoL (PDE or sequential):
Data st nane 'USER1Z2.REL.CHTLIHTEET]

Analyze features [v-M]:
REG—ERartTest: ¥ Extended Analysi=l N

AKR data zet naWe 'UZER1Z.GEMERAL.AKR'

AKR prograd nade [if overriding PROGRAR-IO0)

Analyze options:

CoHpile? [Y<H] o« v o« v @ 0 o o T [¥ if needad by features)
Link load Hodule reusable® [Y«M] T

Note:

If you started your SmartTest session using the ESW Primary screen, the product
names listed under the Analyze features (Y/N) field may differ from the names
shown in this example.

Additional Analyze Features are shown on this pop-up if additional ESW
components are installed at your site.

2 Enter the appropriate information in these required fields:

a  Specify thePDSmember or sequential dataset containing the compile/link JCL
in the Data set name field.

b  Specify theanayze feature by typing Y for SmartTest in the Analyze Features
(Y/N) field. Extended Analysisis not used for PL/I programs.

c Specify the AKR dataset name in the AKR data set name field.
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3 If you need to review or edit the JCL prior to submitting it, type E in the command
input area and press Enter.
a  After making the desired modifications, type SUBMIT.
b Return to the File - Analyze Submit pop-up by typing END or pressing

PF3/PF15. The edited JCL is not saved.

If you do not need to review the JCL, submit the compile/link JCL by typing S inthe
command input area and pressing Enter.

4 Verify the analyze results by examining the job output. An excerpt from a sample

job output report is presented in "Verifying Analyze Results' on page 36.

Method 2 - Analyzing a Program from an Edit Session

Y ou may submit an analyze job outside of SmartTest through your regular edit session
(I'SPF, source manager) or user compilée/linkedit dialog. Use the Analyze Submit

Parameters screen to specify SmartTest specific information.

To analyze a program while in an edit session

1

Initiate an edit session on your standard compile/link JCL. An Edit screen, similar to

the one shown in Figure 24, displays.

Figure24 « Sample Edit Session Screen

COLUMNS 001 072
SCROLL ===> CSR

HIGH LEVEL NODE OF ASG DATA SETS

EDIT —-————- ASG.VIACENXX.CNTL(VIAMECII) - 01.03 ------——-———-
COMMAND ===>

TOP OF DATA
000100 //VIASOFTA JOB (ACCOUNT), "NAME*",
000200 7/ MSGCLASS=X
001820 //COMPLNK PROC ASG="ASG",
001830 7/ CENTER="VIACENXX", MIDDLE NODE OF ASG DATA SETS
001840 7/ SYSOUT="*", OUTPUT MESSAGE CLASS
001850 // SYSDA="SYSDA", WORK FILE UNIT NAME
001860 7/ COMPILR="VIAPLI", PL/1 COMPILER
001870 7/ PLICOMP="0SPLI.COMPILER",
001880 // PLILIB="0OSPLI.PLILIB",
001890 // DYNAM="DYNAM", DYNAM OR NODYNAM
001891 7/ MEMBER="", SOURCE/LOAD MODULE NAME
001892 // USERLIB="USER.TEST.LOADLIB*
001893 //*
001894 //PLI EXEC PGM=&COMPILR,
001895 7/ PARM="LIB,APOST,RES,&DYNAM*"
001896 //STEPLIB DD DSN=&PLICOMP,DISP=SHR
001897 //SYSIN DD DSN=&ASG. .&CENTER. .CNTL(&MEMBER) ,DISP=SHR
001898 //SYSLIB DD DSN=&ASG..&CENTER..CNTL,DISP=SHR
001899 //SYSPRINT DD SYSOUT=&SYSOUT,
001900 7/ DCB=(RECFM=FBA, LRECL=121,BLKSI1ZE=1573)
001901 //SYSLIN DD DSN=&&SYSLIN,DISP=(MOD,PASS),

2 Make any changes necessary, such asjob card information, program and/or load

module names, or copybook and/or load library names.
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3  TypeVIASUB and press Enter. The Analyze Submit Parameters screen, shown in
Figure 25, displays.

Figure 25+ Analyze Submit Parameters Pop-up

File - Analyze EUbHit
CoHHand ===

E - Edit JCL % - EubMiT JCL

CoHpile and link JCL [PDE oF sequentialll
Data set naMe ‘'USER1Z2.REL.CNTLIHTEST)

Analyze features [Y-M]:
AZG-ERartTest. ¥ Extended Analwsis: N

AKR data zet naWe 'UZER1Z.GENERAL.AKR'

AKR prograd nade [if overriding PROGRAA-I0)]

Analyze options:

CoHpile? (YNl o« v o« v & o o o T [¥ if needad by features)
Link l1oad Hodule reusable® [v«M] T

4 Enter the AKR dataset name in the AKR data set name field.

Note:
The Extended Analysisfield is not used when analyzing PL/I programs.

Additional Analyze Features are shown on this pop-up if additional ESW
components are installed at your site. Enter the appropriate information in the
additional fields, as needed.

5  If you need to review or edit the JCL prior to submitting it, type E in the command
input area and press Enter.

a  After making the desired modifications, type SUBMIT.

b  Returnto the editor screen by typing END or pressing PF3/PF15. The edited
JCL isnot saved.

If you do not need to review the JCL, submit the compile/link JCL by typing S inthe
command input area and pressing Enter.

6  Verify the analyze results by examining the job output. An excerpt from a sample
job output report is presented in "Verifying Analyze Results' on page 36.
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Method 3 - Analyzing a Program from a User Screen

If you use compile/link dialogsto enter information and invoke job submission, an option
may be added to the user screensto specify that a SmartTest Analysisisto be performed.
Check with the SmartTest systems administrator at your site for these details.

If you use a CLIST to submit jobs, SmartTest isinstalled with asample CLIST,
VIASUBDS, which submits an analyze job using the specified dataset name. Thisisthe
format of the CLIST:

TSO EXEC “ASG.VIACENXX.CLIST(VIASUBDS)*" [dataset name]
Check with your systems administrator for the exact location of this CLIST.
If no SmartTest options have been added to your compile/link dialog screens, and thereis

an opportunity to edit the JCL prior to job submission, see "Method 2 - Analyzing a
Program from an Edit Session" on page 34.

Verify the analyze results by examining the job output. An excerpt from a sample job
output report is presented in Verifying Analyze Results.

Verifying Analyze Results

36

After the Compile/Link - Analyze batch job has completed, review the job output to
verify results. Check for this output:

= Acceptable compiler results.
<  Acceptable linkage editor results.

<  Messagesindicating the program has been successfully analyzed and the program
information is stored on the AKR.

Storage on the AKR does not occur if the program does not compile and analyze
successfully.

Figure 26 shows an output excerpt indicating a successful analyze.

Figure 26« Sample Analyze Output Report

ASG-SMARTTEST-0S(ESA) Rx.x LVLOOO PL/1 PROGRAM ANALYZER
PROGRAM NAME: VIAPPLI

DIAGNOSTICS LINES: O TOTAL - O WARNINGS, O ERRORS, O CATASTROPHES
PARAMETERS PASSED: FEATURES=(S,PLI,X),NOLIST,SOURCE

OPTIONS IN EFFECT: FEATURES=(SMARTTEST,PL/1), NOLIST

ENTRY POINTS:

PROGRAM "VIAPPLI® WAS STORED IN AKR "ASG.VIACENXX.AKR".
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This screen contains these report areas.

DIAGNOSTIC LINES Program Diagnostics.

PROGRAM 'VIAPPLI' Message indicating the program was stored on the AKR.

Setting Up the Test Session

This section provides instructions for setting up atest session for the TSO environment.
Setup information for other environmentsisin"Test Session: Additional Environments®

on page 55.

These are the steps generally involved in setting up atest for the first time in SmartTest:
=  Compile/link and analyze programs to be tested.

- Prepare execution JCL for conversion to a TSO CLIST (if TSO foreground).

- Prepare input data for testing.

-  Activate SmartTest.

- Provide program, module, and testing environment information.

- Initiate test session.

After thefirst time a program has been set up for testing, subsequent test sessions may no
longer require al of these steps.

For information on how to set up a CICS test session, see the ASG-SmartTest CICS
User’s Guide. For information on how to set up an IMS/DC test session, see the
ASG-SmartTest IMSUser’s Guide.

Note:

The PF keys specified in this manual are set to the SmartTest default values. For more
information on the PF keys, see "PF Key Vaues' on page 27.

Selecting the Test Environment

If you have previously set up the desired environment and saved the profile, you can
restore the profile and skip the setup steps. (See "Restoring the Test Session
Environment" on page 52 for more information.)
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Options
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Use the Environment Selection pop-up to select the SmartTest test environment and to
specify the AKR, application load libraries, and procedure libraries for the test session.

To display the Environment Selection pop-up
1  Select theFile » Setup test environment.

2  Select execution environment on the File- Setup Test Environment pop-up and press
Enter.

Or
Type ENV in the primary command area and press Enter on any SmartTest screen.
The Environment Selection pop-up, shown in Figure 27, displays.

Figure 27 « Environment Selection Pop-up

Environnent Zelection

CoHHand ===
A - Epecify additional AKR=E L — Zpecify additional LOADLIES:
P - Specify PROCLIES 0 - Display AKR Directory

Environnent selection: Current environdent is TS0
onlines 1 - T20 5 - IH:-DE Batch Connect: 2 - HUZ Batch

2 - CIC: & - BT 18 - IH: Batch

3 - I%PF Dialog 7 - DB2 11 - BT% Batch

4 - IHZ<DC & - DEZ Procedure 12 - DBEZ Batch
Application Knowledge Repositories [AKR]: 1 Zpecified

'IJZER1 2. GENERAL .RER’

Application Load Libraries: 2 specified
*USER1 2. GENERAL . LOAD"
" COE2.Vde8 . COBZLIE

3  Sdect the TSO environment by entering the corresponding environment number.
The environment options are defined in Options.

A Displays the System AKR Libraries pop-up.
L Displays the System Load Libraries pop-up.
P Displays the Procedure Libraries pop-up used to specify the

procedure libraries to be used during the test session. The procedure
libraries listed on this pop-up are searched before those located
through the JESPROC or the PROCLIBsentry in VIA$SPRMS.
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Displays the Environment - AKR Directory pop-up showing
members in the concatenated AKRSs.

Displaysthe TSO Session Setup screen. Test MV S programsin TSO
foreground (see " Specifying TSO Setup Information” on page 40).

Displays the CICS Session Setup screen. Test programsin the CICS
environment. For more information, see the ASG-SmartTest CICS
User’s Guide.

Displaysthe | SPF Session Setup screen. Test programs through | SPF
Dialog Manager (see"1SPF Dialog Manager" on page 56).

Displays the IMS/DC Session Setup screen. Test programsin the
IMS/DC environment. For more information, see the ASG-SmartTest
IMSUser’'s Guide.

Displays the IMS/DB Session Setup screen. Test IMS/DB programs
in TSO foreground (see "IMS/DB Programsin TSO Foreground" on

page 67).

Displays the BTS Session Setup screen. Test IMS/DC program with
BTSin TSO foreground (see"BTSin TSO Foreground” on page 83).

Displays the DB2 Session Setup screen. Test DB2 programsin TSO
foreground (see "DB2 Programs in TSO Foreground” on page 104).

If the DB2 Stored Procedure test option isinstalled at your site,
displays the DB2 Stored Procedure Setup screen to test DB2 stored
procedures (see "DB2 Stored Procedure Testing Option” on

page 106). If not, amessageindicating that thisoptionisnot installed
at your site displays.

Displays the Batch Session Setup screen. Test MV S programs with
Batch Connect.(see "Testing Programs in a Batch Region" on

page 112).

10

Displaysthe IMS Batch Session Setup screen. Test IMS/DB
programs with Batch Connect (see "Testing Programsin a Batch
Region" on page 112).

11

Displays the BTS Batch Session Setup screen. Test IMS/DC
programs with BTS with Batch Connect (see "Testing BTSin the
Batch Environment" on page 122).
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12 Displays the DB2 Batch Session Setup screen. Test DB2 programs
with Batch Connect (see " Testing DB2 in the Batch Environment" on
page 123).
Application Specifiesthe AKR dataset name(s). The AKRs s concatenated in the
Knowledge order they are entered. Additional AKRs can be specified on the
Repository System AKR Libraries pop-up by typing A in the command area. A
(AKR): message indicates the total number of AKRs specified, including
those specified on the System AKR Libraries pop-up.
Applicationload Specifiesthe application load libraries to be used for the test session.
libraries: Application load libraries are searched in the order entered. A

message indicates the total number of load libraries specified,
including those specified on the System Load Libraries pop-up.

Note:

The Application load libraries field does not apply to CICS
programs.

Specifying TSO Setup Information

40

To specify the TSO test session parametersfor MVS programs and to initiate a

test session

1  Select TSO on the Environment Selection pop-up. The TSO Session Setup screen,
shown in Figure 28, displays.

Figure28e« TSO Session Setup Screen

CoHHand ===

Execution:
Load module

Execution par

TE0 fession Zetup

Enter MIZ for TE0 Zefup Wizard

R - Begin T30 test session [RUN]
¢ - Convert batch JCL to TEO0 CLIET
CR - Conwert batch JCL and Run test

options:
VI AHERGE Ereak on entry [YoN] YES
Break CIECT-pgH id

anetersl  [quotes are optionall

File allocati
Data =& na

Henber . o« &

an CLISTI
He2
Deallocate after test MO
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2  Typeanoption (R, C, or CR) on the command line, or type WIZ to access the TSO
Setup Wizard.
3  Complete thesefields:

a IntheLoad modulefield, type the name of the load module.
b  Inthe Options group, enter any appropriate options.

c In the Execution parameters field, enter any parameters to be passed into the
program at run time.

d IntheDataset namefield, type the CLIST dataset name that contains the
CLIST member from the JCL conversion process.

e Inthe Member namefield, enter the CLIST member namethat contains, or will
contain, the converted JCL.

Note:

If aCLIST has already been created for the program to be tested, see "Initiating the
Test Session” on page 49. If aCLIST does not exist for the program to be tested, see
"Converting Batch Execution JCL to a TSO CLIST" on page 42.

Option Description

R Invokesthe CLIST to initiate the TSO test session.
C Displays the Convert Batch JCL pop-up.
CR Displaysthe Test - Convert and Run (Batch Execution JCL) screen, which

lets you specify the JCL to be converted to atemporary CLIST. A RUN
command is automatically initiated. This option isacombination of the R
and C options.

Field Description

Execution: Load module  Specifies the name of the load module to be executed.

Options

41



ASG-SmartTest PLI User’s Guide

Break onentry (Y/N)  Type YES (the default) to cause the test session to break or
pause at the start of the program. Additional break on entry
options are available on the Session Tailoring screen for
each program to be tested.

Break CSECT/pgmid Enter aprogram or CSECT nameto cause the test session to
stop on entry to the specified CSECT in astatically linked
module.

File allocation CLIST

Data set name Enter the dataset containing the allocation CLIST for
alocating files to be used during testing. If the Convert
Batch JCL facility is used, the dataset specified thereis

shown here.

Member Enter thename of theallocation CLIST. If the Convert Batch
JCL facility is used, the member name specified is shown
here.

Execution parameters Enter application execution parametersin thisfield.
Dedllocate after test Type YES to cause the allocation CLIST to be automatically

executed to deallocate the test files at the end of the test
session, or after a CANCEL command is entered. Issuing
another RUN command causes the datasetsto be reall ocated
automaticaly. Type NO to cause the CLIST to be
automatically executed before exiting SmartTest-PL I to
deallocate the test files. The default valueis NO.

Converting Batch Execution JCL to a TSO CLIST

Executing a program in TSO foreground requires that data files used during execution be
allocated to the TSO session. Thisis accomplished by a TSO file alocation CLIST.

A JCL to CLIST conversion facility is provided in SmartTest to automate CLIST
creation. Unless otherwise indicated, all DD statementsin the JCL stream are converted
regardless of the number of steps. The conversion facility includes a comment statement
for each step.
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Converting Batch Execution JCL

To specify the dataset containing the batch execution JCL to be converted

Note:
If the TSO Session Setup screen is already displayed, bypass step 1 and step 2.

1  Select File » Setup test environment and press Enter. The File - Setup Test
Environment pop-up displays.

2  Choose Select current environment in the Setup Options field and press Enter. The
Session Setup screen displays.

3 TypeCinthe primary command input areaand press Enter. The Convert Batch JCL
pop-up, shown in Figure 29, displays.

Figure29« Convert Batch JCL Pop-up

Convert Batch JCL
CoHHand ===

¢ - Convert batch JEL into CLIET
E - Edit file allocation CLIET

P - Epecifw procedure libraries
A - Execute allecation CLIST

% - Extract setup libraries
F - Edit CLIST using pansls
J - Edit batch TJCL
O - Execute deallocation CLIET
Batch Edecution JCL:
Data =set naWe 'UIASOFT.UIACENHHLCNTL'
Heber . . . UIAHETCL

File allocation CLIET:
Data set nane 'USER.CLIET®

HeWber o o 0 ________ [Blank defaults to JCL HeHber)

optionz:
Delete [YsN] NO [Delete before create 'DIEP=NEN' datasets)
Etep [Y-N] NO [only convert step with prograd to be tested)
Subsysten . . ____ [#ource Library Hanager subsysten nane)

Etep Mane . . [Unique step nane in JOB to conuvert]

Note:

Y ou can aso select the CR option on the TSO Session Setup screen, an option
which combines the C and R options. See " Converting and Running Batch
Execution JCL" on page 48 for more information on using the CR option.

4  Complete these required fields:

a Enter the Batch Execution JCL dataset name and member in the Data set name
and Member fields, respectively. Thisisthe JCL to be converted.

b Enter the File allocation CLIST dataset name and member inthe Dataset name
and Member fields, respectively. Thisiswhere the converted CLIST is stored.
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Options

Option Description

C Converts the specified batch execution JCL member into afile allocation
CLIST. The CLIST dataset name and member name must be entered in the
FILE ALLOCATION CLIST fields.

E Invokes the | SPF editor for the specified allocation CLIST member.

P Displaysthe Procedure Libraries pop-up used to specify procedurelibraries.
The procedure libraries listed on this pop-up are searched before those
located through the JESPROC or the PROCLIBs entry in VIASPRMS.,

A Invokes the CLIST processor with the generated CLIST as input and uses
the ALLOC (allocate) parameter. This allocates the datasets to the TSO
session and provides the files for testing.

S Converts the specified batch execution JCL member and extracts Library
information, such as STEPLIB, DFSRESLB, and so forth.

F Displays the Allocations from JCL screen, which enables you to edit the
SmartTest allocation CLIST using screens rather than directly editing the
CLIST.

J Displays the batch JCL for editing.

D Invokes the CLIST processor with the generated CLIST as input and uses
the DEALC (deadllocate) parameter. This frees the datasets from the TSO
session.

Field Description

Dataset name  Enter the partitioned dataset containing the JCL to be converted to a
TSO CLIST.

Fields

Member Enter the member to be converted to a TSO CLIST.

Dataset name  The partitioned dataset where the generated CLIST will be placed.
Note that this dataset need not be defined by the TSO SY SPROC DD
Statement.

Member The partitioned dataset member that contains the generated allocation
CLIST.
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Delete (Y/N)

For datasets that are created NEW,CATLG, type YES to cause a
DELETE to be issued each time the CLIST is executed, before the

dataset is alocated. The default is NO.

Step (Y/N)

Y ES causes only the step with the load module specified on the

Session Setup screen to be converted. NO causesall DD statementsin

the JCL stream to be converted regardless of the number of stepsin

the procedure. The default valueis NO.

Subsystem

If the JCL to be converted references a PROC in a procedure library

(or libraries), specify the procedure library in thisfield. Specified

procedure libraries must be partitioned datasets.

Editing Allocation CLIST

To edit the CLIST manually, follow this step:

» Select E on the Convert Batch JCL screen. The generated allocation CLIST, shownin
Figure 30, displays.

Figure 30« Generated Allocation CLIST Example

EDIT ---- USER.CLIST(VIAMEJCL) - 01.00 —————————mmmmmmmmm COLUMNS 001 072

COMMAND ===> SCROLL ===> CSR
TOP OF DATA

000001 PROC O VIAPARM(ALLOC)

000002 /* ASG-SMARTTEST CLIST ALLOCATE PROCESSING **ssssxks

000003 IF &VIAPARM = ALLOC THEN DO

000004 CONTROL NOMSG

000005 /* PROGRAM=V I AMERGE

000006 FREE FILECINFILEL, INFILE2, INFILE3,OUTFILE,OUTRPT)

000007 FREE ATTRLIST(VATTR1,VATTR2)

000008 CONTROL MSG

000009 ATTRIB VATTRL RECFM(F B) LRECL(230) BLKSIZE(460)

000010 ATTRIB VATTR2 RECFM(F B) LRECL(132) BLKSIZE(13200)

000011 ALLOC FI(INFILEL) DA("ASG.VIACENXX.CNTL(VIAMINO1)™)

000012 SHR KEEP

000013 ALLOC FI(INFILE2) DA("ASG.VIACENXX_CNTL(VIAMINO2)")

000014 SHR KEEP

000015 ALLOC FI(INFILE3) DA("ASG.VIACENXX.CNTL(VIAMINO3)")

000016 SHR KEEP

000017 ALLOC FI(OUTFILE) DUMMY USING(VATTR1)

000018 ALLOC FI(OUTRPT)  UNIT(SYSDA) SPACE(1,1) CYLINDERS -

000019 USING(VATTR2) NEW DELETE

000020 /* PROGRAM=V I AMERGE

000021 END
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Special considerations apply for Generation Data Group (GDG) datasets. The TSO
ALLOCATE statement created for Generation Data Groups specifies the absolute
generation number represented by the catalog at the time of CLIST generation.
Automatic incrementing of GDG entries does not occur. Each timethe CLIST isexecuted
the same generation is used unless the CLIST is manually edited or regenerated prior to
execution. For example:

//FILEl DD  DSN=ASG.VIACENXX.IN1(0),DISP=SHR
convertsto:

ALLOC FI(FILE) DA(CASG.VIACENXX.IN1.GOO0O6V01”) SHR KEEP
To provide auser interface for editing the CLIST, follow this step:

P Select F onthe Convert Batch JCL screen. The Allocations from JCL screen, shownin
Figure 31, displays. The basic editor provides alist of DDNAME and dataset
information that correspondsto the CLIST allocations.

Figure3le« Allocationsfrom JCL Screen

Allocations frod JOL  —-—-——-——-—-—- Row 1 to 5 of 5
===} _ ECROLL ===} PRAGE
Long, Zhort.ATTrib.CANCEL LEND

Dataset: 'WIAUSE.TEST. DATACWIAMEICLY '

Delete (YoMl MO [Delete before create 'DIEP=MEN' datasets]

options: Insert,Replace,belete,Edit,View,Brovse, select
OO MaWe Data &et MaWes in Order of Concatenation Di sp
INFILEL 'UIAINET.CESETOOL  CNTL{UIAHINGL]' EHR KEEF
INFILEZ 'VIAINST.CESETAOL.CHNTL{VIAHINGZ]" EHR KEEP
INFILEZ 'VIAINST.CESETAOL.CHNTL{UVIAHINGS]" EHR KEEP
QUTFILE DURAY
OUTRPT NEW DELETE

Botton of data

Delete (Y|N) Use for datasets that are created NEW,CATLG, type YES to cause a
DELETE to beissued each time the CLIST is executed, before the
dataset is allocated. The default is NO.

DD Name Specifies the file name for the allocation entry. If thisfield isleft
blank, the dataset is concatenated to the previous entry.
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Field Description

Data Set Names Specifiesthe name of the dataset to be allocated. If DISP=DATA, this

in Order of field isignored.
Concatenation
Disp Specifiesthe disposition with which to allocate the dataset. Thevalid

values are SHR, OLD, NEW, MOD, DATA, and SY SOUT.

Command Type Command  Description

Primary
END WritesaCLIST fromthe current information and end the
edit session.
CANcH Ends the edit session without saving changes.
Attrib Displaysan additional line of information for each entry
showing the dataset attributes, if present.
Long III_)étsplatys al additional information for each entry in the
ist.
Short Resets the display to one line per entry.
Line

Inserts a new blank line after the selected line.

R Adds anew line after and identical to the selected line.

D Deletes the selected line.

S Invokes the attribute editor for the selected line.

E Invokes the | SPF editor for the dataset on the current
line.

Vv Invokesthe | SPF view for the dataset on the current line.

B : nvokes the | SPF browse for the dataset on the current

ine.
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Converting and Running Batch Execution JCL

48

To convert batch execution JCL to atemporary CLIST and initiate a RUN
command

Note:
If the TSO Session Setup screen is already displayed, skip step 1 and step 2 and proceed
to step 3.

1  Select File » Setup test environment, or type SETUP, and press Enter. The
File - Setup Test Environment pop-up displays.

2 Select Setup current environment and press Enter. The TSO Session Setup screen
displays.

Note:

If TSO is not the current environment, type ENV to display the Environment
Selection screen and select the TSO option.

3 TypeCR inthe primary command input area and press Enter to display the Test -
Convert and Run (Batch Execution JCL) pop-up as shown in Figure 32.

Figure32e« Test - Convert and Run (Batch Execution JCL) Pop-up

Test - Convert and Run [Batch Execution JoL)
JCL - WIRUSER TESTLNTL
HeHber: UIARETCL

JCL iz the partitioned data set containing the JCL that executes the
Frograd to be tested.

Hernbet- is the nane of the JCL Henber that edecutes the Progran to be
tezted.

Press ENTER to proceed, Press PFI to terdinate Convert and Run.
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4  Typethe partitioned dataset and the JCL member containing the JCL that executes
the program to be tested and press Enter. The Program View screen, shownin
Figure 33, displays with the message ALLOCATION SUCCESSFUL.

Figure 33« Program View Screen

File Uiew Test Search List 0Options Help

Prograd Wiew ALLOCATION ZUCCESEFUL
CoHHand === Ecroll ===k GER
ooele3 *
*»uxrr  PROCEDURE DIVIEION.
Ll N1y PERFORH 1888-INITIALIZE THRU
QEE] GG 1868-INITIALIZE-*.
Q081 6T PERFORH 2088-PROCESSING-LOOP THRU
0081 65 2000-PROCEEZEING-LOOP—X
LI M= UNTIL FINIZHED-READIMG-ALL-FILEZ.
L1113 A} FPERFORH 9888-TERHINATION THRU
L1117 Ry § BEOOE-TERAINATION=X.
L1115 R IF EMD-FILE-COUMT = & THEM
081 73 HOUVE +5 TO AGEWD-CODE
aae1 7d PERFORH #999—ABEND-IT .
aaE1 7S HOVE +8 T RETURN-CODE.

+

BEE1 TE GOEACK . PEH EXIT

ETATUZC BREAK AT ETART OF TEST ZEZZION FROGRAH: VIAHERGE DATE: 22TULZ002
ETHTC oo@iéd OFF: a904Ccs  AHODE:D 31 HODULE: UIAMERGE TIHE: 11:d1:3%
S0URCES PROCEDURE DIVIZION.

A temporary file allocation CLIST is generated using this format:

"userid.TEMP.CRCLIST(TMPMBR)*®

Initiating the Test Session
After you have completed these tasks, you are ready to begin testing a program in TSO
foreground by performing these tasks.
-  Select the environment.
- Specify the Load module, AKR, load libraries, and procedure libraries (if needed).
<  Generatethe CLIST.

Toinitiate atest session, follow this step:

» TypeR inthe primary command input area on the TSO Session Setup screen and press
Enter or type RUN or STEP on any SmartTest screen or pop-up.

With either method of initiating the test session, SmartTest executes the CLIST to

alocate the files for the program. When the CLIST has completed, the test session is
active with the program source displayed in Program View.
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Setup Considerations

During setup for testing in TSO foreground, keep these input/output dataset and
execution JCL considerations in mind.

If aTSO file allocation CLIST does not exist at the time atest session isto beinitiated,
one must be created. A JCL to CLIST conversion facility is provided to automate the
process.

These points may require you to modify the batch execution JCL prior to CLIST
conversion:

- The JCL to be converted must be valid and executable outside of SmartTest-PLI.

e JCL sysout designations of * (i.e., //[SYSPRINT DD SYSOUT=*) arerouted to the
terminal by the CLIST. Output routed to the terminal displays asit iswritten. It can
only be scrolled forward and is not available once the test session is terminated.

Y ou may want to assign the SY SOUT destinations to sequential files or the held
output queue.

- Make temporary datasets permanent to insure their availability outside the TSO
session.
=  When testing amultiple step job:

—  Specify YES in the STEP field of the Convert Batch JCL pop-up or edit the
multiple step JCL so it contains only the step to be tested.

—  Execute programg/utilities invoked in other steps separately (e.g., SORT,
IDCAMS). Those programs serving to allocate or deletefiles (e.g., IEFBR14)
may be skipped and the appropriate statements manually added to the CLIST
after conversion.

Saving the Test Session Setup

50

Frequently, there is a need to test several programsin an application at the same time.
These programs may run in multiple environments requiring many test session setup
changes. SmartTest providesthe LIST PROFILE primary command to save atest session
setup and restore it when you need to test the same program again or a different program
using the same test session setup.

To save the test session setup information in a profile dataset
1  TypeLIST PROFILE inthe primary command area of any SmartTest screen to

display the Profile Data Set Member List screen. The LIST PROFILE command can
be abbreviated L1 PR.
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In theline command area beside any linethat indicates AVAILABLE, typeW. Inthe
User profile description field, enter any text that reminds you of the purpose of the
setup being saved. For example, you may include the name of the program being
tested, the application or project ID, and the date as shown in Figure 34.

Figure 34 « Profile Dataset Member List Screen Example

Profile Data fet Herber List
ConMand ===k

The current environdent isi T30

Profile dataset name 3 'UZER1Z2.IZPF.PROFILE"

COPY TO dataset nawe 2
% - Eelect HeWber to pestore U - Write current enwirandent to Hedber

¢ - Copy selected Herber R - Replace Henber [Pending status)
O - Delete HeHber # denotes TCA Profile
Profile  ERUiron User profile description [optionall

UIAPETELl  AVAILAELE
UIAPETE2  AVAILAELE
UIAPETEE  AVAILAELE

_ VIAPETE4 T20 testl

_ VIAPETES T:20 test for autotester

_ VIAPETEE T=0 test viapcob and keep window

_ VIARETEY T=0 tca test t=o profile

_ VIAPSTESE T30 this is new stuff

_ VIAPSTE® T30 Q<A transfer for TESTGOE RELEASE 3.3
_ VIRPET1® T30 test count for towW

_ VIAPET11 TE0 analz test wsbr

_ VIAPET12 CICE cics test

_ VIAPET1Z IEPF IZPF setup O8-21-06_

Sharing Test Setups

If your site security allows file sharing in the TSO/ISPF environment, you can also copy
setup information from other profile datasets.

To copy setup information

1

In the Profile data set name field on the Profile Data Set Member List screen, enter
the fully qualified dataset name of the profile dataset containing the desired setup.
The saved profilelist is refreshed to display the profiles from the specified profile
dataset.

In the line command area of the Profile Data Set Member List screen, select the
desired profile to copy to your profile dataset by typing C on the line containing the
profile. The profile is copied to your profile dataset and may be later modified.

Sharing an Alternate Profile Dataset

SmartTest allows you to create an alternate profile dataset, to enable team members to
share test profile setups. The aternate dataset must be an FB 80 (fixed block,
LRECL=80) dataset. Test profiles may be copied from the individual users' profile
datasets to the alternate dataset, and from the alternate dataset to the | SPF datasets. The
common dataset may replace the individual profile datasets as the default.
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To copy test profilesto a common, alternate dataset

1 IntheProfile dataset name field on the Profile Data Set Member List screen, enter
the name of the profile dataset containing the desired test setup profiles, for example:

"USER. ISPF._PROFILE"

2 Inthe COPY TO dataset namefield, enter the name of the common, alternate dataset
to receive the profiles, for example:

"USER.TSO.CNTL"

Note:
The alternate must be an FB 80 dataset.

The profiles are now copied to the common alternate dataset.

To copy test profiles from a common, alternate dataset to an individual, | SPF
dataset

1 IntheProfile dataset name field on the Profile Data Set Member List screen, enter
the name of the common, alternate dataset containing the desired test setup profiles,
for example:

"USER.TSO.CNTL"

2 Inthe COPY TO dataset namefield, enter the name of the individual | SPF dataset to
receive the profiles, for example:

"USER. ISPF.PROFILE"

The profiles are now copied to the individual, | SPF dataset.

Restoring the Test Session Environment

To restore a saved test session environment

1  TypeLIST PROFILE inthe primary command area of any SmartTest screen to
display the Profile Data Set Member List screen.

2  Sdectthedesired profile by typing S inthe line command area of theline containing
the profile.

The saved test session setup isrestored. Y ou can start the test session using the R
command.
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Terminating a Test Session

To terminate a test session and exit from SmartTest
1 Select Test P Cancel to cancel the active test session.

2 Select File » Exit to end SmartTest. Any pseudo code, marks, or breaks are saved in
the AKR if SAVE is specified on the Options -Product Parameters pop-up. See
"Online Operation Parameters' on page 19 for more information on setting these
parameters.

Asan dternative, exit SmartTest by pressing PF3 until you exit the product.
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4 Test Session: Additional Environments

This chapter describes setting up the SmartTest-PLI test sessionsin additional

environments and contains these sections:

Setting Up the Test Session in Other Environments 55
| SPF Dialog Manager 56
IMS/DB Programs in TSO Foreground 67
BTSin TSO Foreground 83
DB2 Programsin TSO Foreground 104
DB2 Stored Procedure Testing Option 106
Testing Programs in a Batch Region 112
Testing DL/I in the Batch Environment 121
Testing BTS in the Batch Environment 122
Testing DB2 in the Batch Environment 123
Testing DFHDRP in the Batch Region 124

Setting Up the Test Session in Other Environments

DB2 Stored Procedure Option

SmartTest offers an option that supports testing a DB2 stored procedure (the DB2
Release 4.1 Stored Procedure feature). See “DB2 Stored Procedure Testing Option” on

page 106 for more information.
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CICS and IMS Environments

Two additional environments are also available as options for SmartTest. These are
discussed in the ASG-SmartTest CICSUser’s Guide and the ASG-SmartTest IMSUser’s
Guide.

ISPF Dialog Manager

Specifying ISPF Dialog Manager Information

To initiate a test session

1 From the Environment Selection pop-up, select ISPF Dialog Manager. The | SPF
Session Setup screen, shown in Figure 35, displays.

Figure 35« | SPF Session Setup Screen

IEPF Zezzion Zetup
CoHHand ===

R - Begin ISPF test session [RUN] I} = Uerify IIPF allocations
% - galect prograns to be tested

Executiond options:
Load Hodule Ereak on entry (YoM YES
EBreak CEECT-pgW id  ________

IZPF Options:
Test Profile DEN
MEWAPFL & o &« 4 & —
Initial IEPF panel

Motel The Test Profile DEM cannot be the same IEPF profile data set
that i=s in use by AZE-%HartTest (DOMAME=IZFPROF). Enter HELP
for Hore infornation on the IESPF

OPTIONE.

2 Complete thesefields:
a  Enter theinitial load module to be tested in the Load module field.
b  Select an option by typing R, S, or V on the command line.

c Enter the appropriate information in the fields. See "Fields" on page 57 for a
description of the fields on this screen.
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Option Description

R Initiates the | SPF test session. This option is the same asissuing a RUN
primary command.

S Displays the Load Module Intercept List pop-up.

\% Displays the ISPF Allocation pop-up.

Field Description

Execution: Load module  Specifiesthe initial load module to be tested.

Break on entry (Y/N) Specifies whether the test session stops at the start of the
test session. Additional break on entry optionsare available
on the Session Tailoring screen for each program to be
tested. The default is YES.

Break CSECT/pgm id Specifies the program name that causes the test session to
stop on entry to the specified CSECT in astatically linked
module.

Test Profile DSN Specifiesthe dataset that containsyour | SPF profilesfor the

application to betested (i.e., ISRPROF, VIASPROF, etc.).
Thismust not be the same dataset that i sbeing used by | SPF
for the SmartTest test session. If noneis entered, a
temporary dataset isallocated, so each application profileis
created when accessed. To access existing profiles, use
ISPF's 3.2 option to allocate alibrary similar to your
ISPPROF library, then use | SPF's 3.3 option to copy the
appropriate application profile from | SPPROF to the new
library. This dataset nameis optional.

NEWAPPL Specifies the | SPF application ID to use for the test
(optional).
Initial 1SPF panel Specifies the first | SPF screen to be displayed by the test

session. If noneis entered, SmartTest's VPPISPFT screen
displays. If VPPISPFT cannot be located in ISPF's
ISPPLIB concatenation, then | SPF's Dialog Manager Test
screen displays. This screen ID isoptional.
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Specifying Programs to be Tested
Use the Load Module I ntercept

This includes modules that are

List pop-up to list any load modules that may be
intercepted by SmartTest for testing. A load module that is linked, attached, or
dynamically loaded and called may be entered on the Load Module Intercept List screen.
invoked by an ISPEXEC Select program. Entries must be

made before the start of the test.

To display the Load Module I ntercept List pop-up

1

Type S in the primary command input area on the | SPF Session Setup screen and
press Enter. The Load Module Intercept List, shown in Figure 36, displays.

Figure 36 Load Module Intercept List Pop-up

CoHHand ===

Load Hodule Intercept List

Type the names of the load
Then press Enter.

Load
Hodule

Hodules to be dynanically intercepted.

Load
Hodule

press Enter.

Press PF3/PF15 to return
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Enter the load modules to be dynamically intercepted in the Load Module field and

to the | SPF Session Setup screen.
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Specifying ISPF File Allocation Information

Options

Use the I SPF Allocation pop-up to specify datasets and libraries to be used by the test
which are not already allocated to your TSO session. To obtain alist of files allocated to
your session, type TSO VIASALCL.

Note:

Typically, no entries are needed on this pop-up. If left blank, the existing | SPF defined
libraries are used. If datais entered on this pop-up, al libraries that are accessed during a
test session must be supplied. These entries override the existing definitions.

To display the | SPF Allocation pop-up

1  TypeVinthe primary command input area on the | SPF Session Setup screen and
press Enter. The |SPF Allocation pop-up, shown in Figure 37, displays.

Figure 37 « | SPF Allocation Pop-up

I:ZPF Allocation
CaoHMand ===

1 - I&%PF Prograd Load Library  [Fequired]

2 - ISPF Panel-Link Libraries [optionall

3 - ISPF TablerHessagesikeleton Libraries [optional)
d - IZPF LIST Data et [required)

5 - ISPF LOG Data et [required)

A - ALL [Display all of the above in succession]

R - Restore ISPF systed variables

2  Select the appropriate option(s) for items to be allocated to | SPF. Typically, the
information on the resulting pop-upsis entered once and retained by SmartTest-PLI.

3 Press PF3/PF15 to return to the | SPF Session Setup screen.

1-1SPF Program Load Displaysthe | SPF Program Load Library pop-up that is used to

Library specify the location of the load module ISPMAIN.

2-1SPF Panel/Link Displays the ISPF Panel/Link Library pop-up that is used to
Libraries specify panel and link libraries used by the | SPF test.

3-ISPF Table/ Displaysthe | SPF Table/M essage/Skeleton Library pop-up that

M essage/Skeleton is used to specify table, message, and skeleton libraries used by
Libraries the | SPF test.
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4-1SPF LIST DataSet Displaysthe ISPF List Data Set Allocation pop-up that is used
to specify the ISPF list dataset that is used for the | SPF test.

5-ISPF LOG Data Set Displaysthe | SPF Log Allocation pop-up that is used to specify
the | SPF log dataset that is used for the | SPF test.

A Displays the | SPF allocation pop-ups in succession.
R Executes the VIAPUSPF CLIST that restores the | SPF system

variables to the site defaults.

Note:
See the ASG-SmartTest Installation Guide for information on the VIAPUSPF CLIST.

Specifying the ISPF Program Load Library

Note:
This procedure is required.

To display the | SPF Program Load Library containing the | SPMAIN member

1  Typelintheprimary command input areaon the | SPF Allocation pop-up and press
Enter. The ISPF Program Load Library pop-up, shown in Figure 38, displays.

Figure 38« ISPF Program Load Library Pop-up

ISPF Prograd Load Library
CoHHand ===

IZPF Prograd Load Libraryl  [required]
Data set nane "I3F.IFLOAD

This library HUst Contain the load Aodule "IEPHAIN' .

2 Enter the |SPF load library dataset name that contains the program ISPMAIN in the
| SPF Program Load Library field.

3 Press PF3/PF15 to return to the | SPF Allocation pop-up.
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Specifying the ISPF Panel/Link Libraries

Use the ISPF Panel/Link Libraries pop-up to specify panel and link libraries for the test.
ISPPLIB and ISPLLIB are the default libraries. Typically, no entries are needed on this
pop-up. If left blank, the existing | SPF defined libraries are used. If datais entered on this
pop-up, al libraries that are accessed during atest session must be supplied.

To specify the | SPF panel and link libraries

1  TypeZ2intheprimary command input areaon the | SPF Allocation pop-up and press
Enter. The ISPF Panel/Link Libraries pop-up, shown in Figure 39, displays.

Figure 39« ISPF Panel/Link Libraries Pop-up

I%PF Panel~Link Libraries
CoHHand ===

I%PF panel libraries: [corresponds to ISPPLIE]

IZPF link likraries: [cCorresponds to IEPLLIE]

2  Enter the ISPF panel library datasets that will be used for the | SPF test in the | SPF
panel librariesfield.

By default, the libraries allocated to ISPPLIB and ISPLLIB (Panel and Link
libraries) are appended to your user-defined libraries. If you do not want to append
thedefault libraries, add this parameter to the VIASPRM Sor the VIASPRMP CNTL
member:

SmartTest-Append-I1SPLIBS=NO

3 EnterthelSPFlink library datasetsthat will be used for the | SPF test in the | SPF link
libraries field.

4 Press PF3/PF15 to return to the | SPF Allocation pop-up.
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Specifying the ISPF Table/Message/Skeleton Libraries

62

Use the | SPF Table/M essage/Skeleton Libraries pop-up to specify table, message, and
skeleton libraries for the test. ISPTLIB, ISPMLIB, and ISPSLIB are the default libraries.
Typically, no entries are needed on this pop-up. If left blank, the existing | SPF defined
libraries are used. If datais entered on this pop-up, al libraries that are accessed during a
test session must be supplied.

To specify the | SPF Table/Message/Skeleton Libraries pop-up

1

Type 3 inthe primary command input area on the | SPF Allocation pop-up and press
Enter. The | SPF Table/M essage/Skeleton Libraries pop-up, shown in Figure 40,

displays.

Figure40« | SPF Table/M essage/Skeleton Libraries Pop-up

I:ZPF Table<Heszage-fkeleton Libraries

CoHHand ===3
IZPF Table libraries: [corresponds to ISPTLIE)
IZPF Heszage libraries:  [corresponds to ISPHLIE]

IZPF Ekeleton libraries! [corresponds to ISPSLIE]

Enter the | SPFtablelibrary datasetsthat will be used for thetest ISPF Tablelibraries.

By default, the libraries allocated to ISPTLIB, ISPMLIB, and ISPSLIB (Table,
Message, and Skeleton libraries) are appended to your user-defined libraries. If you
do not want to append the default libraries, add this parameter to the VIASPRMS or
the VIA$SPRMP CNTL member:

SmartTest-Append-I1SPLIBS=NO

Enter the | SPF message library datasets that will be used for the test |SPF Message
libraries.

Enter the | SPF skeleton library datasets that will be used for the test | SPF Skeleton
libraries.

Press PF3/PF15 to return to the | SPF Allocation pop-up.



4 Test Session: Additional Environments

Allocating the ISPF List Dataset

Fields

To specify an | SPF list file for the test

1  Type4 intheprimary command input areaon the | SPF Allocation pop-up and press
Enter. The ISPF List Data Set Allocation pop-up, shown in Figure 41, displays.

Figure4le« ISPF List Data Set Allocation Pop-up

IZPF Li=st Data et Allocation
CoHHand ===

Enter Data set nane, DURHY, TEHP, TERH o ZVE0UTI
Nare . . « ZVE0UT

EVEQUT . . X Dest
DEN DIEP [Mew, 014, or Zhr)

nit . . .

Uolure . .

fpacel
Units o & _________ [Eylinder, Track, or BElock]
PriHary

Eecondary

DCE:

RECFH . . F
LRECL . . 133
ELEZIZE 133

2 Enter the appropriate information in the fields.

3 Press PF3/PF15 to return to the | SPF Allocation pop-up.

Name Specifies the name of the dataset. Y ou can specify TEMP to allocate
atemporary dataset, TERM to allocate the dataset to aterminal, and
SY SOUT to allocate the dataset to JES.

SYSOUT Specifiesa JES output class. An entry in thisfield isvalid only if you
specified SYSOUT in the Name field.

DSN DISP Specifies the disposition of the dataset. The disposition can be NEW,
OLD, MOD, or SHR.

Dest Specifies a JES destination of the SY SOUT output. This can be a
remote ID or aNJE ID.

Unit Specifies the generic name used to allocate the dataset if the dataset
name specified in the Name field is not cataloged or if you specified
TEMP in the Name field.
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Volume Specifies the volume serial number containing the allocated dataset.

Units Specifies the type of space to be allocated for the dataset. Y ou can
specify space as CYLINDER, TRACK, or BLOCK.

Primary Enter the number of primary cylinders, tracks, or blocksto be
allocated.

Secondary Specifies the number of secondary cylinders, tracks, or blocksto be
allocated.

RECFM Specifies the record format of the list dataset. Record format can be
specified as F (fixed) or V (variable).

LRECL Specifies the record length of the list dataset.

BLKSIZE Specifies the maximum length, in bytes, of ablock for the list dataset.

Note:

The SYSOUT and DEST fields are available only when you specify SY SOUT in the

Name field.

Allocating the ISPF Log Dataset

64

To specify an | SPF log dataset for the test

1  Type5intheprimary command input areaon the | SPF Allocation pop-up and press
Enter. The ISPF Log Data Set Allocation pop-up, shown in Figure 42, displays.

Figure42 e« ISPF Log Data Set Allocation Pop-up

Space:

DCEZ

CoHHand ===k

Enter Data zet nawe, DUHAY, TEHP, TERH o ZVE0UTZ
NaWe . . .

2reaur ..
DEN DISP

Unit . . .
Uolune . .

units . .
PriHary
Fecandary

RECFH . .
LRECL . «
ELEKZIZE

I:ZPF Log Data Zet Allocation

EVEOUT
= Dest

F
133
133




Fields

4 Test Session: Additional Environments

2 Enter the appropriate information in the fields.

3 Press PF3/PF15 to return to the | SPF Allocation pop-up.

Name Specifies the name of the dataset. Y ou can specify TEMP to allocate
atemporary dataset, TERM to allocate the dataset to aterminal, and
SY SOUT to alocate the dataset to JES.

SYSOUT Specifies a JES output class. An entry inthisfield isvalid only if
SY SOUT is specified in the Name field.

DSN DISP Specifies the disposition of the dataset. The disposition can be NEW,
OLD, MOD, or SHR.

Dest Specifies a JES destination of the SY SOUT output. This can be a
remote ID or aNJE ID.

Unit Specifies the generic name used to allocate the dataset if the dataset
name specified in the Name field is not cataloged or if you specified
TEMP in the Namefield.

Volume Specifies the volume serial number containing the allocated dataset.

Units Specifies the type of space to be allocated for the dataset. Y ou can
specify space as CYLINDER, TRACK, or BLOCK.

Primary Specifies the number of primary cylinders, tracks, or blocksto be
allocated.

Secondary Specifies the number of secondary cylinders, tracks, or blocks to be
allocated.

RECFM Specifiesthe record format of the list dataset. Y ou can specify record
format as F (fixed) or V (variable).

LRECL Specifies the record length of the list dataset.

BLKSIZE Specifies the maximum length, in bytes, of ablock for the list dataset.

Note:

The SYSOUT and DEST entries are only allowed when the NAME entry is specified as

SYSOUT.
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Initiating an ISPF Test Session

66

To initiate a test session

1

Make sure you have completed these tasks before testing a program in | SPF:

a

b

e

Select the I SPF Dialog Manager environment.
Specify all appropriate testing options.
Specify the Load module and AKR.

Specify programs to be tested.

Specify |SPF file alocation information.

Type RUN or R in the command input area on the | SPF Session Setup screen and
press Enter.

Or

Press PF4/PF16 (RUN) or PF6/PF18 (STEP).

The test session is active with the program source displayed in Program View.



IMS/DB Programs in TSO Foreground

Specifying IMS/DB Setup Information

4 Test Session: Additional Environments

Options

To specify the TSO test session parametersfor IMS/DB programs and to initiate

atest session

1  Sdlect IMS/DB on the Environment Selection pop-up. The IMS/DB Session Setup
screen, shown in Figure 43, displays.

Figure43+ IMS/DB Session Setup Screen

CoMAand ===}

R - Begin IHE test seszion [RUN]

Execution: optionsi
Load Wodule  ________ Break on entry [¥<N] YE%
PEE Name . . ________ Break CEECT-pgn id ________

Data base region Typel
OLI-DEE-EHF OLI

File allocation CLIST:
Data set nane
Henber o .

IHz<DE Zession setup

¢ - Convert batch JCL to CLIET
W= Uerify IH: allocations

DEZ paraneters:
Plan naWe . . « « &
SUbsysted nade . . .

Deallocate after test NO

2  Specify theload module, the CLIST dataset name and optional member, and any
appropriate options.

R Initiates the IMS/DB test session. Thisisthe equivalent of entering
the RUN command.

C Displays the Convert Batch JCL screen used to convert batch JCL to
an dlocation CLIST. The converted allocation CLIST can be used to
establish the IMS/DB session.

\ Displaysthe IMS/DB Allocation Selection pop-up that is used to

select the datasets, libraries, and parameters to be defined for
IMS/DB.

67



ASG-SmartTest PLI User’s Guide

Fields

68

Load module Specifiestheinitial load moduleto betested. Thisshould bethe name
of the program that is executed by IMS.

PSB Name Specifies the IMS Program Specification Block associated with the
program being tested.

Break onentry  Specifies whether the test session stops on initial entry at the start of

(Y/N) the load module. Additional break on entry options are available on
the Session Tailoring screen for each program to be tested. The
default isYES.

Break CSECT/  Causes the test session to stop on entry to the specified CSECT ina

pgm id statically linked module.

DLI/DBB/BMP

Specifies the mode of the IMS/DB test session.

DLI. Uses private databases with database access through the TSO
region; uses DBDLIB and PSBLIB.

DBB. Uses privates databases with database access through the TSO
region; uses ACBLIB.

BMP. Uses public databases with database access through the IMS
Control Region.

Plan name Specifiesthe DB2 Plan that was generated for the programto be tested
when the BIND was performed. If the database region type of test
specified is BMP, thisfield is not needed.

Subsystem Specifiesthename assigned to DB2 when it wasinstalled inthe MV S

name environment. If the database region type specified is BMP, thisfield
is not necessary.

Dataset name  Specifiesthe dataset containing the allocation CLIST for alocating
filesto be used during IMS/DB testing. If the Convert Batch JCL
facility is used, the dataset specified is shown in this field.

Member Specifiesthe name of the allocation CLIST. If the Convert Batch JCL

facility is used, the member name specified is shown in thisfield.
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Dedlocate after  Specifieswhether the CLIST processor will beinvoked automatically

test to deall ocate the test files at the end of the transaction test session or
after a CANCEL command is entered. Issuing another RUN
command causesthe datasetsto be reallocated. By default, the CLIST
isautomatically invoked before exiting SmartTest. The defaultisNO.

Execution Specifies application parameter string. Thisfield isfor IMSESA
parameters user’sonly.
(APARM)

Specifying IMS File Allocation Information

To specify the IMS datasets, libraries, and parametersto be defined to IMS

1  TypeVintheprimary command input areaonthe IMS/DB Session Setup screen and
press Enter. The IMS Allocation Selection pop-up, shown in Figure 44, displays.

Figure44 « IMSAllocation Selection Pop-up

IHE Allocation Eelection
CoHHand ===

1 - DFERESLE~DFZESL

2 — PROCLIE-DFZUEAAP
3 - PEE-DED Libraries
4 - ACE Libraries

5 - IHZHON

& - IEFRDER

E - IHE Parns [EBHP]
F - IHE Parns [DLI or DEE]
A - ALL [Di=play ALl Of The Above In Succession)

R - Restore IHE systed Lariables and parHs.

2 Select the appropriate option(s) for itemsto be allocated to IMS/DB. Typically, the
information on these screensis entered once and need not be re-entered each time a
test is performed.

Note:

If you choose option A, pressing PF3/PF15 automatically displays the next
allocation screen.

3 Press PF3/PF15 to return to IMS/DB Session Setup screen.
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Options
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1 - DFSRESLB/DFSESL

Displaysthe IMS DFSRESLB/DFSESL Allocation
pop-up used to specify the IMS load library dataset.

2 - PROCLIB/DFSVSAMP

Displaysthe IMS DFSVSAMP/PROCLIB Allocation
pop-up that is used to specify the VSAM buffer pool
dataset and any datasets to be concatenated, and to
specify the IMS procedure library dataset.

3- PSB/DBD Libraries

Displaysthe IMS PSB/DBD Allocation pop-up that is
used to specify the PSB and DBD libraries used by IMS.

4 - ACB Libraries

Displaysthe IMS ACB Allocation pop-up that is used to
specify the ACB libraries used by IMS.

5-IMSMON Displaysthe IMS IMSMON Allocation pop-up that is
used to specify the monitor dataset used by IMS to log
run-time activities.

6 - IEFRDER Displaysthe IMS IEFRDER Allocation pop-up that is

used to specify the dataset that invokes the IMS logging
facility.

B - IMS Parms (BMP)

Displaysthe IMS BMP Parameters pop-up that isused to
specify IMS BMP execution parameters.

P-IMS Parms (DLI or DBB)

Displaysthe IMS DLI/DBB Parameters pop-up that is
used to specify the IMS execution parameters for DLI
and DBB programs.

A-ALL

Displays the pop-ups described above in succession.

R - Restore IMS system
variables and parms

Executesthe VIAPUIMS CLIST that restoresthe IMS
system variables and parameters to their site defaults.
See the discussion on modifying installed CLIST
librariesin the ASG-SmartTest Installation Guide for
detailed information on the VIAPUIMS CLIST.
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IMS DFSRESLB/DFSESL Allocation

Fields

Usethe IMS DFSRESLB/DFSESL Allocation pop-up to specify the IMS and DB2 load
library datasets. All IMSload modules, including DL/I, are expected to be accessed
through DFSRESLB.

Thisis an example of typical DFSRESLB and DFSESL DD statements from batch
execution JCL:

//DFSRESLB DD DSN=IMS.RESLIB,DISP=SHR

See your batch execution JCL and PROCs for the DFSRESLB and DFSESL dataset
names used at your site.

To specify the IMS and DB2 load library datasets

1 Typel onthelMS Allocation Selection pop-up and press Enter. The IMS
DFSRESLB/DFSESL Allocation pop-up, shown in Figure 45, displays.

Figure45+ IMSDFSRESL B/DFSESL Allocation Pop-up

IHE DFEREZLE-DFSEEL ALLOCATION
ConHand ===

Enter IHE Load Library Data set nades:
'IHZ.REZLIE"

Enter DBEZ2 Load Library Data set nades:
' DEN.DENLORD’

2 Enter the appropriate information in the fields.

3 Press PF3/PF15 to return to the IMS Allocation Selection pop-up.

Enter IMS Load Library Specifiesthe IMS|oad library datasets to be allocated to the
Data set names DFSRESLB DDNAME.

Enter DB2 Load Library Specifiesthe DB2 load library datasetsto be allocated to the
Data set names DFSESL DDNAME.
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IMS PROCLIB/DFSVSAMP Allocation
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Usethe IMS PROCLIB/DFSV SAMP Allocation pop-up to specify the datasets for
VSAM buffer poolsand IMS procedure libraries. The DFSV SAMP dataset must be
allocated if databases are allocated using VSAM. Cataloged procedures used by IMS are
contained in the PROCLIB dataset.

Thisis an example of typical DFSVSAMP and PROCLIB DD statements from Batch
execution JCL:

//PROCLIB DD DSN=IMS.PROCLIB,DISP=SHR

See your batch execution JCL and PROCs for the DFSVSAMP and PROCLIB dataset
names used at your site. The PROCLIB datasets may often be concatenated in a
STEPLIB DD statement.

To specify the datasets for VSAM buffer poolsand IMS procedure libraries

1  Type2intheprimary command input areaon the IMS Allocation Sel ection pop-up
and press Enter. The IMS PROCLIB/DFSV SAMP Allocation pop-up, shownin

Figure 46, displays.

Figure46+« IMSPROCLIB/DFSVSAMP Allocation Pop-up

IH: PROCLIE-DFEVEAHFP Allocation
CoHHand ===3

Enter IH: PROCLIE Data set nanes:
'IHNZ.PROCLIE"

Enter DFEUEAHP Data zet nanes:
'IHE.PROCLIE[DFEVEHDE] "

2  Enter the appropriate information in the fields.

3 When al necessary information is specified, press PF3/PF15 to return to the IMS
Allocation Selection pop-up.
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Fields

Enter IMS PROCLIB The procedure library datasets to be alocated to the
Data set names PROCLIB DDNAME.

Enter DFSVSAMP Data Thedatasetsto be allocated to the DFSVSAMP DDNAME.
set names Datasets to be concatenated to the DFSV SAM P dataset can
be entered on the remaining lines.

IMS PSB/DBD Allocation

Usethe IMS PSB/DBD Allocation pop-up to specify the PSB and DBD library datasets.
PSB and DBD libraries must be allocated when the Data base region type field on the
IMS Session Setup pop-up contains DLI.

Thisis an example of typical IMS DD statements from batch execution JCL :

//IMS DD DSN=USER.PSBLIB,DISP=SHR
// DD DSN=USER.DBDLIB,DISP=SHR

See your batch execution JCL and PROCs for the PSB and DBD dataset names used at
your site. These datasets may often be concatenated in an IMS DD statement.

To specify the PSB and DBD library datasets

1  Type3intheprimary command input areaon the IMS Allocation Selection pop-up
and press Enter. The IMS PSB/DBD Allocation pop-up, shown in Figure 47,

displays.

Figure47+ IMSPSB/DBD Allocation Pop-up

IH: PEE<DED Allocation
CoMHand ===

Enter PEE-DED Library Data set nanes:
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2 Enter the PSB and DBD dataset namesto be allocated for use by IMS. The PSB and
DBD datasets are concatenated to the IMS DDNAME.

3 Press PF3/PF15 to return to the IMS Allocation Selection pop-up.

IMS ACB Allocation

Usethe IMS ACB Allocation pop-up to specify the ACB library datasets. ACB libraries
contain the combined PSB and DBD information about the program. ACB libraries
should be all ocated when the Data base region type field on the IMS Session Setup screen
contains DBB.

Thisis an example of atypical IMSACB DD statement from batch execution JCL :
//IMSACB DD DSN=USER.ACBLIB,DISP=SHR

See your batch execution JCL and PROCs for the ACB dataset name used at your site.

To specify the ACB library datasets

1  Type4intheprimary command input areaon the IMS Allocation Selection pop-up
and press Enter. The IMS ACB Allocation pop-up, shown in Figure 48, displays.

Figure48+ IMSACB Allocation Pop-up

IHE ACE Allocation
CoHHand ===F

Enter ACE Library Data et Nades:

2 Enter the ACB dataset names to be allocated to IMSACB for DBB testing.

3 Press PF3/PF15 to return to the IMS Allocation Selection pop-up.
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4 Test Session: Additional Environments

Usethe IMSIMSMON Allocation pop-up to specify the DB monitoring datasets for

output from the IMS monitor.

Thisisan example of atypical IMSMON DD statement from batch execution JCL :

See your batch execution JCL and PROCs for the IMSMON dataset name and attributes
used at your site.

To specify the DB monitoring datasets

1

Type 5 inthe primary command input area on the IMS Allocation Sel ection pop-up
and press Enter. The IMSIMSMON Allocation pop-up, shown in Figure 49,

displays.

Figure49« IMSIMSMON Allocation Pop-up

IHE IHZHOM Allocation
CoHHand ===

Enter Data set naWe, DUAHY, TEHP, or blank:
Hane . . .

DEN DIZP [Mew, 01d, or Zhr)

Unit « « « E7E0A

Voluke o & ______

Epace:

Units . . C¥L [Culinder, Track, or Elock]
Pridary 1

Eacondary 1

OCE:

RECFH . . VE
LRECL . . 2idd
ELKZIZE 2043

Enter the appropriate information in the fields.

Note:

If you usethe IMS monitor, allocate atemporary dataset or permanent dataset in the
Namefield. Additionaly if the IMS monitor isto beinvoked, specify Y inthe MON

field on the IMS DLI/DBB Parameters pop-up.

Press PF3/PF15 to return to the IMS Allocation Selection pop-up.
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Fields

Name Specifies the name of the dataset. Y ou can specify TEMP to allocate
atemporary dataset. No alocation is performed if thisfield isleft
blank.

DSN DISP Specifiesthe disposition of the dataset. The disposition can be NEW,
OLD, or SHR.

Unit Specifiesthe devicetypefor the SY SOUT output, such asSY SDA. A
device typeisonly specified for new or temporary datasets.

Volume Specifies the volume serial number containing the IMSMON dataset.

Units Specifies the type of space to be allocated for the dataset. Specify
space as CYLINDER, TRACK, or BLOCK.

Primary Specifies the number of primary cylinders, tracks, or blocksto be
allocated.

Secondary Specifies the number of secondary cylinders, tracks, or blocks to be
allocated.

RECFM Specifies the record format of the IMSMON dataset. Specify record
format as F (fixed) or V (variable).

LRECL Specifies the record length of the IMSMON dataset.

BLKSIZE Specifies the maximum length, in bytes, of ablock for the IMSMON
dataset.

IMS IEFRDER Allocation

76

Use the IMS IEFRDER Allocation pop-up to specify an IEFRDER dataset to provide
backout and recovery for your IMS databases. Thisis an example of atypical IEFRDER
DD statement from batch execution JCL :

//1EFRDER DD DSN=IMSLOG,DISP=(NEW,CATLG),
V4 UNIT=SYSDA, SPACE=(TRK, (3,2) ,RLSE),

See your batch execution JCL and PROCs for the IEFRDER dataset name and attributes
used at your site.
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To specify an IEFRDER dataset

1  Type6 intheprimary command input areaon the IMS Allocation Selection pop-up
and press Enter. The IMS IEFRDER Allocation pop-up, shown in Figure 50,

displays.

Figure50« IMSIEFRDER Allocation Pop-up

IH: IEFRDER Allaocation
CoHHand ===

Enter Data set nawWe, DURHY, TEHP, or blank:

Mane . . « TEHP

OEM DIEP e [Mew, 014, ar Zhr]

Unit . . . EYEDA

Uolure o o ______

Epace:

Units . « CYL [Culinder, Track, or Elock]
Prifary 1

Fecondary 1

DCE:

RECFH . . UE
LRECL . . 1916
BELEZIZE  192@

Enter the appropriate information in the fields.

Note:

Entering DUMMY inthe Namefield causesthe IM S backout processto fail, should
you need to back out updates to your application databases.

3 Press PF3/PF15 to return to the IMS Allocation Selection pop-up.

Name Specifies the name of the dataset. Y ou can specify TEMP to allocate
atemporary dataset. No alocation is performed if thisfield isleft
blank.

DSN DISP Specifies the disposition of the dataset. The disposition can be NEW,
OLD, or SHR.

Unit Specifies the device type for the SY SOUT output, such as SY SDA.

Volume Specifies the volume serial number containing the |EFRDER dataset.

Units Specifies the type of space to be allocated for the dataset. Specify

space as CYLINDER, TRACK, or BLOCK.
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Primary Specifies the number of primary cylinders, tracks, or blocksto be
allocated.

Secondary Specifies the number of secondary cylinders, tracks, or blocksto be
allocated.

RECFM Specifies the record format of the IEFRDER dataset. Specify record
format as F (fixed) or V (variable).

LRECL Specifies the record length of the IEFRDER dataset.

BLKSIZE Specifies the maximum length, in bytes, of ablock for the [EFRDER
dataset.

IMS BMP Parameters

Use the IMS BMP Parameters pop-up to specify execution parameters for IMS BMP
programs. Thisis an example of typical parameters from batch execution JCL.:

//STEPNAME EXEC PGM=DFSRRCOO,PARM=(BMP,&VBR,&PSB,&IN,
// &OUT ,OPT&SPIE&TEST&DIRCA, &PRLD,

See your batch execution JCL and PROCs for the parms used at your site.
To specify execution parametersfor IMS BMP programs

1  TypeB inthe primary command input areaon the IMS Allocation Selection pop-up
and press Enter. The IMS BMP Parameters pop-up, shown in Figure 51, displays.

Figure51« IMSBMP Parameters Pop-up

IH: EHF FaraHeters
CoHHand ===k
Enter IHE EHF EXecution paraneters:
IN & & ___ [Input transaction code)
ouT .. [Transaction code or logical terHinal for output)
OPT . . [Operator option M, W. or C]
EPIE 1] [SPIE option @ ar 1]
TEST ] [Ualidity check call list address 8 o 1)
DIRCA 90 [Region interreqion coHAUnication area)l
FRLD __ [OFEHPLHEY suffis orF leave blank]
STIHER _ [Tiner to be et @ or 1)
CEPTID _____________ [Checkpoint ID for restart or leave blank]
PARDLI 1 [Parallel OL-I option @ o 1)
CPUTIHE & [CPU time for IHEZ)
NEA . . ___ [MuHber Fast Path data buffers)
0BA « o ___ [Mumnber additional page—fided buffers]
IHZID I [subsysten identifier?
AGM & & ________ [Application Group Nade)
EEH . . ____ [DE2 subsysteHs Hewber]
PREINIT __ [OFEINTHY =suffid oF leave blank]
AFARH [APARA walue or blank]
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Enter the appropriate information in the fields.

Seethe IBM IMS System Definition Reference Manual for additional information on
each of the IMS BMP execution parameters.

Press PF3/PF15 to return to the IMS Allocation Selection pop-up.

Indicates that the application program is accessing the message
gueues. The OUT parameter isignored when this parameter is
specified.

ouT

Indicates the transaction code or logical terminal name to which an
output message is to be sent. This parameter is needed when the
application program sends output without accessing the input queues.

OPT

Indicates the action to be performed when the IMS control regionis
unavailable. Thevalid optionsare N (notify), W (wait), or C (cancel).
The default valueis N.

SPIE

Indicates whether control is passed when a program exception
(OC1-0CF) occurs, thus allowing the program to correct the problem
without an abend occurring. The default value is O (zero), which
indicates control is passed.

TEST

Indicates whether the address in the user call list is checked for
validity. The addressin the user call list must be greater than the high
address of the MV S nucleus and less than the highest virtual storage
address of the machine. 1 indicates the addressis to be checked. The
default value is O (zero).

DIRCA

Specifies the interregion communication area of storage that is used
by IMS to communicate with the test. The default value is 000.

PRLD

Specifies a suffix for DFSMPL and can be two alphabetical
characters. The specified suffix is used to preload modulesin the
region. Thisfield can be left blank if a suffix isnot needed.

STIMER

Specifies whether the timer isto be set. If you specify CPUTIME=n,
the STIMER value must be 1. STIMER=1 results in performance
degradation and should only be specified when gathering statistics.
Zero (0) specifies that the timer is not to be set.

CKPTID

Specifies the checkpoint/restart 1D used to restart a program.
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PARDLI

Indicateswhere DL/I processingisto beperformed. Zero (0) specifies
that DL/I processing isto be performed within the BMP region. One
(2) specifiesthat all DL/I processing isto be performed in the IMS
control region.

Note:
PARDLI has been forced to 1 for IMS system integrity issues.

CPUTIME

This parameter must be O (zero) for SmartTest-PLI.

NBA

Specifies the number of Fast Path data buffers. Thisfield can be | eft
blank if Fast Path databases are not used.

OBA

Specifies the number of additional page-fixed buffers for Fast Path
applications when the standard buffers are all used.

IMSID

Specifies the subsystem identifier for the operating system being
used. Thisidentifier is used instead of the IMS identifier specified
when the system was defined.

AGN

Specifies the application group name used for resource access
security.

Specifies a site-specific value that is used to allow accessto selected
DB2 subsystems under IMS. Y ou can enter 1 to 4 alphanumeric
characters, or leave this field blank.

PREINIT

Specifiesasuffix for DFSINT that can be two a phabetical characters.
DFSINTxx containsalist of preinitialization modules to which
control isto be given. Thisfield can be left blank if a suffix is not
needed.

IMS DLI/DBB Parameters

Usethe IMS DLI/DBB Parameters pop-up to specify execution parametersfor IMS
DLI1/DBB programs.

Thisis an example of typical parameters from batch execution JCL :

//STEPNAME EXEC PGM=DFSRRCOO,PARM=(DLI,&MBR,&PSB,&BUF,

//

&SP IE&TEST&EXCPVR&RST , &PRLD , &SRCH,

See your batch execution JCL and PROCSs for the parms used at your site.
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To specify execution parametersfor IMS DLI/DBB programs

1  TypeP intheprimary command input areaon the IMS Allocation Selection pop-up
and press Enter. The IMS DLI/DBB Parameters pop-up, shown in Figure 52,

displays.

Figure52« IMSDLI/DBB Parameters Pop-up

ConRnand

ELF
2PIE
TEET
EXCPUR
RET
PRLD
ZRCH
CKPTID
HON
LOGA
FHTO
IRZID
ENMAP
DERC
IRLH
IRLHHNH
EKO
AFARH

]
]
]

Enter IH% DLI-DEE Execution Paraneters:

ﬂ:ﬂ

=l =TI =l EZoE

IH: DLI-<DEE Parameters

[I5AH-05AH bBuffer pool sizel

[ZPIE option @ or 1]

[Ualidity check call list address 8 ar 1)

[Long terH fid of buffer pool @ or 1)

[UCF restart @ or 1)

[DFSHPLHN prefid o leave blank)

[Hodule search @=standard, 1=JPA and LPA first)
[Checkpoint ID for restart o leave blank]

[DE Roni tor active ¥ or Nl

[BZAH or O%AH logging @ or 1]

[Fornatted dunp option T, P, or M

[Eubsysten identifier]

[Addr-ess space swappable or non-swappable ¥ or M)
[Data Base Recovery Control)

[v or N to use IRLH)

[IRLH subsysteW nane oF leave blank]

[Ownanic backout ¥ or M)

[AFARA walue o blank]

2 Enter the appropriate information in the fields.

Seethe IBM IMS System Definition Reference Manual for additional information on
each of the IMSDLI and DBB execution parameters.

3 When al necessary information is specified, press PF3/PF15 to return to the IMS
Allocation Selection pop-up.

BUF The ISAM/OSAM buffer pool size. The default valueis 8.

SPIE Indicates whether control is passed when a program exception
(OC1-0CF) occurs, thus allowing the program to correct the problem
without an abend occurring. The default value is 0 (zero), which
indicates control is passed.

TEST Indicates whether the address in the user call list is checked for

validity. The addressin the user call list must be greater than the high
address of the MV S nucleus and less than the highest virtual storage
address of the machine. 1 indicates the addressis to be checked. The
default value is O (zero).
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EXCPVR

Indicatesif real storageisto bereserved for useby IMSISAM/OSAM
buffers. The default value is O (zero), which indicates storage is not
reserved.

RST

Indicatesif the Utility Control Facility (UCF) isto beused for restarts.
The default value is 0 (zero), which indicates UCF is not to be used.

PRLD

A suffix for DFSMPL that can be two alphabetical characters. The
specified suffix is used to pre-load modulesin the region. Thisfield
can be left blank if asuffix is not needed.

SRCH

Indicateswhere the system isto search for modules. O (zero) specifies
the searchisfirstin the JOBLIB/STEPLIB, then LINKLST, and then
LPA. 1 specifies that the search beginsfirst in JPA/LPA, then
JOBLIB/STEPLIB, and then LINKLST. LPA (Link Pack Area)
modules are loaded into a high storage areathat isavail able for use by
all jobs on the machine. JPA (Job Pack Area) modules areloaded into
storage for ajob. The default value is O (zero).

CKPTID

The checkpoint/restart ID used to restart a program.

MON

Indicates if the IMS monitoring option is active. The default is N.

LOGA

Specifiesthe logging access method. Thisparameter isno longer used
and isignored if specified.

FMTO

Specifies whether formatted dump output is to be produced.

T indicates IMS data areas are formatted and other areas are
suppressed by the Formatted Dump Delete List (FDDL). P indicates
no areas are suppressed and IM S data areas are formatted.

N suppresses the formatted dump output.

IMSID

Indicates the subsystem identifier for the operating system being
used. Thisidentifier is used instead of the IMS identifier specified
when the system was defined.

SWAP

Indicates if the address space can be swapped when the System
Resource Manager (SRM) determines that an overload exists. An
overload occurs when the CPU utilization or the paging rateistoo
high. ThedefaultisY (yes), which indicates the address space can be
swapped.

DBRC

Indicatesif Database Recovery Control isto be used for thisexecution
of IMS.'Y specifiesthat Database Recovery Control isto be used and
must be entered if Y isspecified for the IRLM option. N specifiesthat
Database Recovery Control is not to be used for this execution of
IMS. Cisused only for batch backout type runs of IMS.
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IRLM Indicatesif the IMS Resource Lock Manager (IRLM) isto beused. Y
specifiesthat the IRLM isto beused. ThedefaultisN, which specifies
that the IRLM is not to be used.

IRLMNM The name of the IRLM subsystem if IMSis sharing the database with
other IMS systems. The IRLM subsystem name isfirst specified in
the IMSCTRL macro that controlsthe IMS system. Thisfield can be
left blank if the IRLM option is not used.

BKO Specifies whether database updates are backed out when an abend
occurs. The default isN, which indicates the dynamic backout option
is not active.

BTS in TSO Foreground

Specifying BTS Setup Information

To specify the TSO test session parametersfor BTS for testing

1  Select BTS on the Environment Selection pop-up. The BTS Session Setup screen,
shown in Figure 53, displays.

Figure53« BTS Session Setup Screen

ETE fession Setup
CoHHand === _

R - Begin BETS test session [RUN) C - Convert batch JCL to CLIST
F - Previey BTZIN data set W= WVerify BETE<IRE allocations

Executiond options:
Load Wodule  ________ Ereak on entry (YoM YES
EBreak CEECT-pgW id  ________
Data base region typel
OLI-DEE<BHF  OLI

File allocation CLIZTZ
Data =et nawWe
Herber . . . Deallocate after test MO

ETEINZ
Data set nane
Henber . . .
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2  Completethesefields:
a Enter the load module in the Load module field.

b  Enter the CLIST dataset name and optional member in the Data set name and
member fields, respectively.

c Enter the appropriate information in the options. A description of each option
is provided below.

3 Complete the remaining fields on the screen as necessary.

Option Description

R Invokes the CLIST to initiate the test session. For more information,
see“SmartTest-PLI Test Session” on page 15.

P Displaysthe Preview BTSIN Data Set pop-up that isused to select the
BTS transactions and programs to be tested. Before selecting this
option, specify the BTS dataset name and member. For more
information, see " SmartTest-PL | Test Session” on page 15.

C Displays the Convert Batch JCL screen used to convert batch JCL to
an alocation CLIST. The converted allocation CLIST can be used to
establish the BTS test session. For more information, see
“SmartTest-PLI Test Session” on page 15.

\% Displays the BTS Allocation Selection pop-up that is used to select
the datasets, libraries, and parametersto be defined for BTSand IMS.
For more information, see “ Specifying BTS File Allocation
Information” on page 87.

Field Description

Execution: Load Specifiestheinitia |load moduleto betested. Thisshould bethe name

module of the program that is executed by IMS.

Break onentry  Indicates whether the test session stops on initial entry at the start of

(Y/N) the load module. Additional break on entry options are available on
the Session Tailoring screen for each program to be tested. The
default isYES.

Break CSECT/  Causesthetest session to stop on entry to the specified CSECT in a
pgmid statically linked module.
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Databaseregion Specifies the mode of the IMS/DB test session.

type:
DLI/DBB/BMP

DL I: Uses private databases with database access through the TSO
region; uses DBDLIB and PSBLIB.

DBB: Uses privates databases with database access through the TSO
region; uses ACBLIB.

BM P: Uses public databases with database access through the IMS
Control Region.

Dataset name  Specifiesthe dataset containing the allocation CLIST generated by
the Convert Batch JCL facility.

Member Specifiesthe name of the allocation CLIST generated by the Convert
Batch JCL facility.

Deadllocate after  Indicates that the CLIST processor will be automatically invoked to

test deallocate the test files at the end of the test session or after a
CANCEL command is entered. 1ssuing another RUN command
causes the datasets to be reallocated. By default, the CLIST is
automatically invoked to deallocate the test files before exiting
SmartTest. The default isNO.

Dataset name  Specifiesthe BTS input control statement dataset that contains the
PSBs and transactions available during the test session.

Member Specifiesthe BTSIN dataset member.

Selecting BTS Transactions to Monitor

Use the Preview BTSIN Data Set screen to display ./T commands residing inthe BTSIN
dataset. Select the transactions to be tested with SmartTest-PLI. These transactions are
saved from session to session.

The BTSIN data might need altering to reflect these items:

- Specify a PSB= parameter on the appropriate ./T statement, even if the PSB hasthe
same name as the program to be tested, for example:

/T TC=TRNX MBR=TEST1 PSB=TEST1 PLC=25 LANG=CBL TYPE=DLI

=  Addthe TSO=NO parameter on a./O statement to prevent BTS from prompting at
the terminal for input during the test, for example:

-/0 TSO=NO

The BTSIN dataset may not be altered from this screen.
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To display ./T commandsresiding in the BTSIN dataset

1  TypeP inthe primary command input area on the BTS Session Setup screen and
press Enter. The Preview BTSIN Data Set screen, shown in Figure 54, displays.

Figure54 « Preview BTSIN Data Set Screen

CoHHand === ECroll ===k CER

Felect the Transactions and Prograds to be tested.

Previcy BTEIN Data Set

2 Trancode Prograd  PEENAHE  Lang  Type PLC  EPA Edit rtn DEZ PLAN
ADDI TETZAHE4 TETZAHEd CEL  HEG
ADDINL TETZAHE4 TETZAHEd CEL  HEG
ACDPART TETEAHE4  TETEAHE4  CEL HEG
ADDPN TETEAHE4  TETEAHEd  CEL HEG
ER1d IEFER1d  DFEZAHOZ AZH HEG
CLOZE TETEZAHES  TETEZAHES CEL  HEG
COEZDSE  COBZDSS  DFEEAMOZ2  CEL H2G
DIZBUREE T2TEAHOG TETEAHOE CEL  HEG
DLETI TETZAHE4 TETZAHEd CEL  HEG

DLETINY  TETEAHOd TETESAMEd  CEL HEG
DLETPART  TETZAHEd  TETEAAEd  CEL HEG
DLETPH TETEAHE4  TETEAHEd  CEL HEG
DEPALLI TETZAHET TIETEAHOT CEL  HEG
LIMKAEHd LIMKASHd DFZEAMOZ2  AEH HEG
LIMKCOE  LIMKCOE  DF22AMEZ2  CEL H2G
LINKIHE  LIMKIHZ  DF3:AHOZ2 CEL  H2G

e

2 Sdlect the transaction(s) to be tested by typing S in the line command area and
pressing PF3/PF15 to return to the BTS Session Setup screen.

S Selects transaction for testing.

Trancode Specifies the transaction code name of the primary or secondary
transaction.

Program Specifies the load modul e of the application program that processesthe
transaction named by the TC= operand.

PSBNAME Specifies the alphanumeric PSB name to be used when processing the
transaction named by the TC= operand.

Lang Specifies the programming language of the module named by the
MBR= operand. The default iSASM.

Type Specifies the type of application program being defined or the alternate
logical terminal type. The default is MSG.

PLC Specifiesthe processing limit count for thistransaction. The default is 1.




4 Test Session: Additional Environments

SPA Defines the size of the scratch pad area, in bytes, for the transaction
named by the TC= operand.

EDIT rtn Specifies the member name of the user-written transaction code (input)
edit routine that is called to edit each input message segment.

DB2 PLAN Specifies the DB2 plan name for the corresponding transaction.

Note:

If the program uses DB2, the DB2 name should be specified on the
BTSIN transaction ./T cards. The subsystem name should be defined to
BTS or specified in the BTSIN patch ./P cards.

Specifying BTS File Allocation Information

To select the BTS datasets, libraries, and parametersto be defined to IMS

1  TypeVinthe primary command input area on the BTS Session Setup screen and
press Enter. The BTS Allocation Selection pop-up, shown in Figure 55, displays.

Figure55+« BTSAllocation Selection Pop-up

ET: Allaocation Eelection
CoHHand ===

1 - BTE Load library
2 = FORHAT

3 - QIOPCE

4 - QALTPCE

S - WALTRAN

& - BT=0UT

7 - BETZPUNCH

& - ETEDEEUG

@ - ETEZNAR

I - IH% allocations and parns
A - ALL [Display ALl 0F The Abowe In fuccession)

R - Restore BTE and IHE systeW wvariables and pares.

2 Select the appropriate option(s) for items to be allocated to BTS. Typically, the
information on these screens is entered once and need not be re-entered each time a
test is performed.

Note:

If you choose option A, pressing PF3/PF15 automatically displays the next
allocation screen.

3 Press PF3/PF15 to return to the BTS Session Setup screen.
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1-BTSLOAD DisplaystheBTSLoad Library pop-up that isused to specify theBTS

LIBRARY load library dataset.

2- FORMAT Displaysthe BTS Format Libraries pop-up that is used to specify the
IMS/ESA Message Format Services (MFS) datasets.

3- QIOPCB Displaysthe BTS QIOPCB Allocation pop-up that is used to specify
the BTS work file dataset.

4-QALTPCB Displaysthe BTS QALTPCB Allocation pop-up that is used to
specify the BTS work file dataset for alternate PCBs.

5- QALTRAN Displaysthe BTS QALTRAN Allocation pop-up that is used to
allocate the dataset to be used for alternate PCB output.

6- BTSOUT Displaysthe BTSBTSOUT Allocation pop-up that is used to specify
the pop-up and message output dataset.

7-BTSPUNCH Displaysthe BTS BTSPUNCH Allocation pop-up that is used to
specify the dataset used to capture all BTS input.

8- BTSDEBUG Displaysthe BTS BTSDEBUG Allocation pop-up that is used to
specify the dataset used to capture SNAP dumps of the Trace Table
and various control blockstaken by BTS.

9-BTSSNAP  DisplaystheBTSBTSSNAP Allocation pop-up that isused to specify
the dataset used to capture all other SNAP dumps taken by BTS.

I -IMS Displays the IMS Allocation Information pop-up that is used to

alocations and
parms

specify the datasets, libraries, and parametersthat are to be defined to
IMS. See“ Specifying IMS/DB Setup Information” on page 67 for
more information.

A-ALL Displays the pop-ups described above in succession.

R- RestoreBTS Executesthe VIAPUBTS CLIST that restoresthe BTSand IMS
and IMSsystem  system variables and parameters to their site defaults. See the
variables and discussion on modifying installed CLIST librariesin the

parms ASG-SmartTest Installation Guide for detailed information on the

VIAPUBTSCLIST.
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Specifying the BTS Load Library
Thisisan example of atypical BTS load library DD statement from batch execution JCL :

//STEPLIB DD DSN=BTSLIB,DISP=SHR

See your batch execution JCL and PROCs for the BTS load library dataset used at your
site.

To specify the BTS load library and STAX indicator for BTS

1  Typelintheprimary command input areaonthe BTS Allocation Selection pop-up
and press Enter. The BTS Load Library pop-up, shown in Figure 56, displays.

Figure56« BTSLoad Library Pop-up

BET3 Load Library
CoHMand ===

Enter BTE Load Library Data Zet Mawe:
'BTS.BTELIE"

Enter ETE £TAX indicator: _  [Y,N, or blank]

2 Enter the load library dataset that contains the programs used by BTS.
3  TypeY,N, or leave ablank in the Enter BTS STAX indicator field.

Note:

Y specifiesthat BTSisto process the TSO terminal attention exit. When thisfieldis
|eft blank, BTS does not allow the selection of the TSO terminal attention exit.

If the message BTSOO15A INVALID KEYWORD ON PARM STRING, "DLI*
ASSUMED displays when the BTStest session isinitiated, the STAX indicator
contains the wrong value. If this message displays, change the valuein thisfield to
Y, N, or blank.

4 Press PF3/PF15 to return to the BTS Allocation Selection pop-up.
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Usethe BTS Format Libraries pop-up to specify the format datasets from the IMS/ESA
Message Format Service (MFS) library.

Thisisan example of atypical FORMAT DD statement from batch execution JCL.:

//FORMAT DD DSN=USER.FORMAT ,DISP=SHR
// DD DSN=IMS.FORMAT ,DISP=SHR

See your batch execution JCL and PROCSs for the format dataset name used at your site.
To specify the format datasets from the IMS/IESA MFSlibrary

1  TypeZ2intheprimary command input areaon the BTS Allocation Selection pop-up
and press Enter. The BTS Format Libraries pop-up, shown in Figure 57, displays.

Figure57« BTSFORMAT Libraries Pop-up

ET% FORHAT Libraries
ConHand ===k

Enter BTE FORHAT Data set nanes:
*IHZ.FORHAT®

2 Enter the MFS datasets that are used to format the screen message.

3 Press PF3/PF15 to return to the BTS Allocation Selection pop-up.

Allocating the BTS QIOPCB

Usethe BTS QIOPCB Allocation pop-up to alocate the dataset containing the output
message queue for BTS.

Thisis an example of atypical QIOPCB DD statement from batch execution JCL:

//QIOPCB DD UNIT=SYSDA,SPCE=(CYL,1,1),RLSE),
// DCB=(RECFM=FB,LRECL=1024,BLKSI1ZE=3072)

See your batch execution JCL and PROCs for the QIOPCB dataset name and attributes
used at your site.
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To allocate the dataset containing the output message queue for BTS

1  Type3intheprimary command input areaon the BTS Allocation Selection pop-up
and press Enter. The BTS QIOPCB Allocation pop-up, shown in Figure 58, displays.

Figure58« BTS QIOPCB Allocation Pop-up

Enter Data

DEN DISP

Tpace:

PriHary

DOCE:

ELEZIZE

CoHHand ===k

Hame . . .

Unit « « &
Uolune . .

units . .

Fecondary 1

RECFH . .
LRECL . .

ETE QIOPCE Allocation

set nade, DUAHY, o TEHP:D
TEHP

[New, 014, or Zhr)

CYLINDERE [Cywlinder, Track, o Block]
i

UEE
512
1072

2  Enter the appropriate information in the fields.

3 Press PF3/PF15 to return to the BTS Allocation Selection pop-up.

Name Specifiesthe name of the dataset. TEM Pindicatesatemporary dataset
isto be allocated. No alocation is performed if thisfield isleft blank.

DSN disp Specifies the disposition of the dataset. Disposition can be NEW,
OLD, or SHR.

Unit Specifies a generic name used to allocate the dataset if the dataset
name specified in the Namefield is not cataloged or if TEMP was
specified in the Name field.

Volume Specifies the volume serial number containing the allocated dataset.

Units Specifies the type of space to be allocated for the dataset. Space can
be specified as CYLINDER, TRACK, or BLOCK. The default value
iSCYLINDER.

Primary Specifiesthe number of primary cylinders, tracks, or blocksallocated.

The default is 1.
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Secondary

Specifies the number of secondary cylinders, tracks, or blocks
allocated. The default is 1.

RECFM

Specifies the record format of the allocated dataset. Record format
can be specified as F (fixed) or V (variable).

LRECL

Specifies the record length of the allocated dataset. The default is
1024.

BLKSIZE

Specifies the maximum length, in bytes, of ablock for the allocated
dataset. The default is 3072.

Allocating the BTS QALTPCB

Usethe BTS QALTPCB Allocation pop-up to alocate the aternate message queue
dataset used by BTS.

Thisis an example of atypical QALTPCB DD statement from batch execution JCL :

//QALTPCB DD UNIT=SYSDA, SPACE=(CYL, (1,1),RLSE),

//

DCB=(RECFM=FB,LRECL=1024,BLKSI1ZE=3072)

See your batch execution JCL and PROCs for the QAL TPCB dataset name and attributes

used at your site.

To allocate the alternate message queue dataset used by BTS

1  Type4inthe primary command input area on the BTS Allocation Selection pop-up
and press Enter. The BTS QALTPCB Allocation pop-up, shown in Figure 59,

displays.

Figure59« BTS QALTPCB Allocation Pop-up

ETE QALTPCE Allocation
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2 Enter the appropriate information in the fields.

3 Press PF3/PF15 to return to the BTS Allocation Selection pop-up.

Fields

Name

Specifiesthe name of the dataset. TEM P indicatesatemporary dataset
isto bealocated. No alocation is performed if thisfield isleft blank.

DSN DISP

Specifies the disposition of the dataset. Disposition can be NEW,
OLD, or SHR.

Unit

Specifies a generic name used to allocate the dataset if the dataset
name specified in the Name field is not cataloged or if TEMP was
specified in the Name field.

Volume

Specifies the volume serial number containing the allocated dataset.

Units

Specifies the type of space to be alocated for the dataset. Space can
be specified as CYLINDER, TRACK, or BLOCK. The default value
isCYLINDER.

Primary

Specifiesthe number of primary cylinders, tracks, or blocks allocated.
The default is 1.

Secondary

Specifies the number of secondary cylinders, tracks, or blocks
allocated. The default is 1.

RECFM

Specifies the record format of the allocated dataset. Record format
can be specified as F (fixed) or V (variable).

LRECL

Specifies the record length of the allocated dataset. The default is
1024.

BLKSIZE

Specifies the maximum length, in bytes, of ablock for the allocated
dataset. The default is 3072.
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Allocating the BTS QALTRAN

Usethe BTS QALTRAN Allocation pop-up to allocate the dataset used for alternate PCB
output.

Thisisan example of atypical QALTRAN DD statement from batch execution JCL.:

//QALTRAN DD UNIT=SYSDA,SPACE=(CYL,(1,1),RLSE),
// DBC=(RECFM=U, LRECL=1024,BLKS1ZE=3072)

See your batch execution JCL and PROCsfor the QALTRAN dataset name and attributes
used at your site.

To allocate the dataset used for alternate PCB output

1  Type5 intheprimary command input areaon the BTS Allocation Selection pop-up
and press Enter. The BTS QALTRAN Allocation pop-up, shown in Figure 60,

displays.

Figure60« BTS QALTRAN Allocation Pop-up

ETE QALTRAM Allocation
CoHHand ===

Enter Data set nawe, DURAY, or TERP:

MNaWe . . . TEHP
DEN DISP N [Mew, 014, ar Shrl
nit . . . EYE0A
Voluke « & ______
Epacel
Units . . CYLINDERE [Cylinder, Track, or Elock)
Prinary 1
Fecondary 1
DCER
RECFH . . U
LRECL . « 512

ELEZIZE 536

2 Enter the appropriate information in the fields.

3 Press PF3/PF15 to return to the BTS Allocation Selection pop-up.

Fields

Name Specifies the name of the dataset. TEMP indicates atemporary
dataset isto be alocated. No allocation is performed if thisfield is
left blank.

DSN DISP Specifies the disposition of the dataset. Disposition can be NEW,
OLD, or SHR.
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Unit Specifies a generic name used to allocate the dataset if the dataset
name specified in the Name field is not cataloged or if TEMP was
specified in the Name field.

Volume Specifiesthe volume serial number containing the all ocated dataset.

Units Specifiesthe type of spaceto be allocated for the dataset. Space can
be specified as CYLINDER, TRACK, or BLOCK. The default
valueis CYLINDER.

Primary Specifies the number of primary cylinders, tracks, or blocks
allocated. The default is 1.

Secondary Specifies the number of secondary cylinders, tracks, or blocks
allocated. The default is 1.

RECFM Specifies the record format of the allocated dataset. Record format
can be specified as F (fixed) or V (variable).

LRECL Specifies the record length of the allocated dataset. The default is
1024.

BLKSIZE Specifiesthe maximum length, in bytes, of ablock for the all ocated

dataset. The default is 3072.

Allocating the BTS BTSOUT

Usethe BTS BTSOUT Allocation pop-up to alocate the dataset used for BTS program
output. Output includes input verification and formatted IMS call information.

Thisisan example of atypical BTSOUT DD statement from batch execution JCL:

//BTSOUT DD SYSOUT=*
// DCB=(RECFM=FBA,LRECL=133.B;LS0ZE=133)

See your batch execution JCL and PROCs for the BTSOUT dataset name and attributes
used at your site.
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Fields

96

To allocate the dataset used for BTS program output

1  Type6 intheprimary command input areaon the BTS Allocation Selection pop-up
and press Enter. The BTSBTSOUT Allocation pop-up, shown in Figure 61,

displays.

Figure6l« BTSBTSOUT Allocation Pop-up

CoHHand ===

Enter Data zet naWe, DUHHY, TEHP, TERH OR EY20UTZ

ETE ETE0UT Allocation

MaHe . . . TERH

EVEQUT & . _ best _____
DEN DIZP  ___ [Mew, 01d, or Zhr)
unit . . .

VoluHe o o ______
Epace:

Units o w o [Eylinder, Track, or Elock]
PriHary

Eecondary

DCE:

- FER
- 133
133

2 Enter the appropriate information in the fields.

3 Press PF3/PF15 to return to the BTS Allocation Selection pop-up.

Name

Specifies the name of the dataset. TEMP can be specified to alocate
atemporary dataset; TERM can be specified to allocate the dataset to
aterminal; and SY SOUT can be specified to all ocate the dataset to the
output spool.

SYSOUT

Specifiesa SY SOUT classvalue such as A. An entry in thisfield is
valid only if SYSOUT is specified in the Name field.

DEST

Specifies the destination of the SY SOUT output such as R1 or
RSCS.ID. Anentry inthisfieldisvalid only if SY SOUT isenteredin
the Name field.

DSN DISP

Specifies the disposition of the dataset. Disposition can be NEW,
OLD, or SHR.

Unit

Specifies a generic name used to allocate the dataset if the dataset
name specified in the Name field is not cataloged or if TEMP was
specified in the Name field.
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Volume Specifies the volume serial number containing the allocated dataset.

Units Specifies the type of space to be allocated for the dataset. Space can
be specified as CYLINDER, TRACK, or BLOCK. The default is
CYLINDER.

Primary Specifiesthe number of primary cylinders, tracks, or blocksallocated.
The default is 1.

Secondary Specifies the number of secondary cylinders, tracks, or blocks

dlocated. The default is 1.

RECFM Specifies the record format of the allocated dataset. Record format
can be specified as F (fixed) or V (variable).

LRECL Specifiesthe record length of the allocated dataset. The default is 133.

BLKSIZE Specifies the maximum length, in bytes, of ablock for the allocated

dataset. If BTSOUT is alocated to SY SOUT, ablock size must be
specified. A fixed record format (RECFM=F) and ablock size of 133
(BLKSIZE=133) outputs an unblocked file to the spool. A BLKSIZE
must be specified if the allocation is specified as anything other than
TERM.

Allocating the BTS BTSPUNCH

Usethe BTS BTSPUNCH Allocation pop-up to allocate the dataset containing all input
received by BTS. Thisis an example of atypical BTSPUNCH DD statement from batch
execution JCL:

//BTSPUNCH DD DSN=USER.BTSPUNCH,DISP=(,CATLG),
7/ UNIT=SYSDA, SPACE=(CYL, (10,2),RLSE),
7/ DCB=(RECFM=FB, LRECL=80, BLKS 1ZE=6800)

See your batch execution JCL and PROCs for the BTSPUNCH dataset name and
attributes used at your site.
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To allocate the dataset containing all input received by BTS

1  Type7intheprimary command input areaon the BTS Allocation Selection pop-up
and press Enter. The BTS BTSPUNCH Allocation pop-up, shown in Figure 62,

displays.

Figure62« BTSBTSPUNCH Allocation Pop-up

ETE ETEPUMNCH Allocation
CoHHand ===

Enter- Data set nane, DUHHY, TEHF, TERH, SYS0UT, or blank:
NaHe . . .

EVEQUT . . De=t
DEN DIZP ___ [New, 01d, or Zhr)
nit « « «

ValuMe o o ______
Epace:

Units « & o [Culinder, Track, or Elock]
Pri Hary

Secondary

DCE:

RECFH . . __
LRECL - « _____
ELKZIZE

2 Enter appropriate information in the fields.

3 Press PF3/PF15 to return to the BTS Allocation Selection pop-up.

Fields

Name Specifies the name of the dataset. TEMP can be specified to alocate
atemporary dataset; TERM can be specified to allocate the dataset to
the terminal; and SY SOUT can be specified to allocate the dataset to

the output spool.

SYSOUT Specifiesa SY SOUT class value such as B. An entry in thisfield is
valid only if SYSOUT isentered in the Name field.

Dest Specifies the destination of the SY SOUT output such as R1 or
RSCS.ID. Anentry inthisfieldisvalid only if SY SOUT isenteredin
the Name field.

DSN DISP Specifies the disposition of the dataset. Disposition can be NEW,
OLD, or SHR.

Unit Specifies a generic name used to allocate the dataset if the dataset

name specified in the Name field is not cataloged or if TEMP was
specified in the Name field.
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Volume

Specifies the volume serial number containing the allocated dataset.

Units

Specifies the type of space to be allocated for the dataset. Space can
be specified as CYLINDER, TRACK, or BLOCK. The default value
isCYLINDER.

Primary

Specifiesthe number of primary cylinders, tracks, or blocksallocated.
The default is 1.

Secondary

Specifies the number of secondary cylinders, tracks, or blocks
allocated. The default is 1.

RECFM

Specifies the record format of the allocated dataset. Record format
can be specified as F (fixed) or V (variable).

LRECL

Specifies the record length of the all ocated dataset.

BLKSIZE

Specifies the maximum length, in bytes, of ablock for the allocated
dataset.

Allocating the BTS BTSDEBUG

Usethe BTS BTSDEBUG Allacation pop-up to allocate the dataset used for SNAP
dumps of the Trace Table and various control blocks taken during BT S execution.

Thisis an example of atypical BTSDEBUG DD statement from batch execution JCL.:

//BTSDEBUG DD DUMMY

See your batch execution JCL and PROCs for the BTSDEBUG dataset name and
attributes used at your site.
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To allocate the dataset used for SNAP dumps

1  Type8intheprimary command input areaon the BTS Allocation Selection pop-up
and press Enter. The BTS BTSDEBUG Allocation pop-up, shown in Figure 63,

displays.

Figure 63« BTSBTSDEBUG Allocation Pop-up

ETE ETEDEBUG Allocation
CoHHand ===

Enter Data set name, DUHHY, TEHF, TERH, 2YE0UT, or blank:
MNane . . .

EVEQUT . . Dest
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unit . . .
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Units . .
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econdary

DCE:

RECFH . . __
LRECL . . _____
ELEZIZE

2  Enter the appropriate information in the fields.

3 Press PF3/PF15 to return to the BTS Allocation Selection pop-up.

Fields

Name Specifies the name of the dataset. TEMP can be specified to
allocate atemporary dataset; TERM can be specified to allocate the
dataset to the terminal; and SY SOUT can be specified to allocate
the dataset to the output spool.

SYSOUT SpecifiesaSY SOUT classvaluesuch asA. Anentry inthisfieldis
valid only if SYSOUT is entered in the Name field.

Dest Specifies the destination of the SY SOUT output such as R1 or
RSCS.ID. Anentry inthisfieldisvalid only if SY SOUT isentered
in the Name field.

DSN DISP Specifies the disposition of the dataset. Disposition can be NEW,
OLD, or SHR.
Unit Specifies a generic name used to allocate the dataset if the dataset

name specified in the Name field is not cataloged or if TEMP was
specified in the Name field.
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Field Description

Volume Specifies the volume serial number containing the allocated
dataset.
Units Specifiesthetype of spaceto beallocated for the dataset. Space can

be specified as CYLINDER, TRACK, or BLOCK. The default
valueis CYLINDER.

Primary Specifies the number of primary cylinders, tracks, or blocks
alocated. The default is 1.

Secondary Specifies the number of secondary cylinders, tracks, or blocks
alocated. The defaultis 1.

RECFM Specifiesthe record format of the all ocated dataset. Record format
can be specified as F (fixed) or V (variable).

LRECL Specifies the record length of the allocated dataset.

BLKSIZE Specifiesthe maximum length, in bytes, of ablock for the allocated
dataset.

Allocating the BTS BTSSNAP

Usethe BTS BTSSNAP Allocation pop-up to allocate the dataset containing SNAP
dumps taken by BTS during execution.

Thisis an example of atypical BTSSNAP DD statement from batch execution JCL.:
//BTSSNAP DD SYSOUT=*

See your batch execution JCL and PROCs for the BTSSNAP dataset name and attributes
used at your site.
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To allocate the dataset containing SNAP dumps taken by BTS during execution

1  Type9intheprimary command input areaon the BTS Allocation Selection pop-up
and press Enter. The BTS BTSSNAP Allocation pop-up, shown in Figure 64,

displays.

Figure 64 « BTSBTSSNAP Allocation Pop-up

ETE ETEEMAP Allocation
CoHHand ===

Enter Data set nane, DUHHY, TEHP, TERH, SVE0UT, oF blank:
HaHe . . .
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2 Enter the appropriate information in the fields.

3 Press PF3/PF15 to return to the BTS Allocation Selection pop-up.

Fields

Name Specifies the name of the dataset. TEMP can be specified to
alocate atemporary dataset; TERM can be specified to alocatethe
dataset to the terminal; and SY SOUT can be specified to allocate
the dataset to the output spool.

SYSOUT Specifiesa SY SOUT class value such as A. An entry in thisfield
isvalidonly if SYSOUT isentered in the Namefield.

Dest Specifies the destination of the SY SOUT output such as R1 or
RSCS.ID. Anentry inthisfieldisvalid only if SY SOUT isentered
in the Namefield.

DSN DISP Specifies the disposition of the dataset. Disposition can be NEW,
OLD, or SHR.
Unit Specifies a generic name used to allocate the dataset if the dataset

name specified in the Name field is not cataloged or if TEMP was
specified in the Name field.
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Volume

Specifies the volume serial number containing the allocated
dataset.

Units

Specifiesthetype of spaceto be alocated for the dataset. Space can
be specified as CYLINDER, TRACK, or BLOCK. The default
valueis CYLINDER.

Primary

Specifies the number of primary cylinders, tracks, or blocks
alocated. The default is 1.

Secondary

Specifies the number of secondary cylinders, tracks, or blocks
allocated. The default is 1.

RECFM

Specifiesthe record format of the allocated dataset. Record format
can be specified as F (fixed) or V (variable).

LRECL

Specifies the record length of the allocated dataset.

BLKSIZE

Specifiesthe maximum length, in bytes, of ablock for theallocated
dataset.

Specifying IMS File Allocation Information from BTS Allocation Selection

Use the IMS Allocation Selection pop-up to select the IMS datasets, libraries, and
parameters to be defined to IMS.

Select option | on the BTS Allocation Selection pop-up to display the IMS Allocation

Selection pop-up.

See the Batch Terminal Smulator: Program Reference/Operations Manual (SH20-5523)
for more information about BTS.

Note:

If your IMSfile allocations were not entered previously or you need to change them, see
“Specifying IMS File Allocation Information” on page 69.
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DB2 Programs in TSO Foreground

Specifying DB2 Setup Information

To specify the TSO test session parameters for DB2 programs

1  Select DB2 on the Environment Selection pop-up. The DB2 Session Setup screen,
shown in Figure 65, displays.

Figure 65+« DB2 Session Setup Screen

DE2 Zession Setup

CoHHand ===
R - Begin DEZ test session [RUM) ; - Cconvert batch JCL to CLIET
Execution: options:

Ereak on entry [¥oN] YVES
Break CIECT-pGH id

Load Hodule
DEZ Plan nane
DE2 Subsysted

EMecution paradeters:  [quotes are optionall

File allocation CLIET:
Data set nane
HeHbEr o o . W Deallocate after test N0

2  Completethesefields:
a Enter the load module in the Load module field.

b Enter the CLIST dataset name and member in the Data set name and member
fields, respectively.

c Enter the appropriate information in the options.

Options

R Initiates the DB2 test session. Thisisthe equivalent of entering the
RUN command. For more information, see“ SmartTest-PL| Test
Session” on page 15.

C Displaysthe Convert Batch JCL pop-up used to convert batch JCL to
an adlocation CLIST. The converted allocation CLIST can be used to
establish the DB2 test session.
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Load module

Specifiestheinitial load moduleto betested. Thisshould bethe name
from the TSO RUN PROGRAM command.

DB2 Plan name

Specifiesthe DB2 Plan that was generated for the program to be tested
when the BIND was performed.

DB2 Subsystem

Specifiesthe nameassigned to DB2 when it wasinstalled inthe MV S
environment.

Break onentry  Indicates whether the test session will stop on initial entry at the start

(Y/N) of theload module. Additional break on entry optionsare availableon
the Session Tailoring screen for each program to be tested. The
default isYES.

Break Causes the test session to stop on entry to the specified CSECT in a

CSECT/pgmid statically linked module.

Execution Specifies required application parameters.

parameters

Dataset name  Specifiesthe dataset containing the allocation CLIST generated by
the Convert Batch JCL facility.

Member Specifiesthe name of the allocation CLIST generated by the Convert
Batch JCL facility.

Dedlocate after Determines whether the CLIST processor will be automatically

test invoked to deallocate the test files at the end of the test session, or

after a CANCEL command is entered. Issuing another RUN
command causesthe datasetsto bereallocated. By default, the CLIST
isautomatically invoked to deallocate the test files before exiting
SmartTest. The default isNO.
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DB2 Stored Procedure Testing Option

SmartTest has an optional feature that enables a programmer/analyst to interactively test
and debug a DB2 Stored Procedure.

A stored procedure is a user-written program that resides on a DB2 server. An SQL
CALL interface allows an SQL requester to invoke the stored procedure at a DB2 server.
The stored procedure is a Language Environment compliant program, written in PL/I,
COBOL, C/370, or Assembler. The procedure name is defined to DB2 in atable,
SYSIBM.SY SPROCEDURES. When the client executes an SQL CALL, DB2 searches
this table for the procedure name contained in the SQL CALL.

Normally, a stored procedure executes in a special DB2 address space. However,
SmartTest tests the stored procedure in TSO foreground.

Requirements

Before setting up a DB2 Stored Procedure test, make sure these preliminary operations
have been performed:

e  The SmartTest DB2 optionisinstalled at your site.

=  Thestored procedure name is defined to DB2 in the SY SIBM.SY SPROCEDURES
table.

<  Thestored procedure is bound as a plan or a package. (If the stored procedureis
bound as a package, the package must be bound within a plan.)

=  Thestored procedure program is Analyzed and stored in an AKR.

Note:

If you are unsure of the completion of any of the above tasks, check with your DB2
database administrator.
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Setting Up the DB2 Stored Procedure Test

To specify the test session parameters for a DB2 Stored Procedure program

1  Select DB2 Procedure on the Environment Selection pop-up.The DB2 Stored

Procedures Setup screen, shown in Figure 66, displays.

Figure 66« DB2 Stored Procedures Setup Screen

DE2 &tored Procedures Setup
CoHHand ===}

R - Begin DE2 Ztored Procedure session [RUN)
¢ = Conuert batch JCL to CLIET
O - Display Paradeters

Execution: options:
Load Hodule . & . ________ Break on entry (YoM YES
DEZ Plan nawe . .« ________ Ereak CEECT-pgH id «
OEZ2 Subsysted . . Use RRESAF [¥<H] . . « NO

DEZ Scheda name . DIAL2S
DB2 Procedure nade

File allocation CLIET:
Data set nane

Herber . - . . Deallocate after test HNO

Under Execution, compl ete these steps:

a Enter the initial Load module to be tested; the entry must be the name of the

DB2 stored procedure to be tested.

b  Enter the DB2 Plan name that was generated for the stored procedure program

to be tested.

C Enter the DB2 Subsystem where the stored procedure program isto run.

d Enter the DB2 Schema name, which is the name of the DB2 entry in the

SY SIBM.SY SROUTINES table that contains the information about the store

procedure program. This field defaults to your TSO user ID.

e Enter the DB2 Procedure name-that is, the DB2 entry in the

SY SIBM.SY SPROCEDURES table that contains the information about the

stored procedure program.
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Under Options, complete these steps:

a IntheBreak onentry (Y/N) field:

— Type YES to stop the test session at the start of the test execution (such
as, to change test data values). The default is YES.

— TypeNO to run the test execution to completion (end or abend).

Additional break options are available. See “Tailoring a Test Session by
Program” on page 161 for more information.

b  Tostop thetest session on entry to a specified CSECT in a statically linked
module, enter the program name in the Break on CSECT/pgm ID field.

If non-DB2 resources are used by the Stored Procedure, convert that JCL toaCLIST
and make the CLIST availableto the test. To allocate a CLIST:
a Make these entries under File allocation CLIST:

—  Enter the dataset and member name for the CLIST.

— Todeallocatethetest filesat theend of thistest session or after aCANCEL
command, type YES in the Deallocate after test field. To deallocate the
test filesat the end of the SmartTest session, typeNO. (ThedefaultisNO.)

b  TypeC todisplay the Covert Batch JCL pop-up. Follow the instructionsin
“Converting Batch Execution JCL to a TSO CLIST” on page 42.

If you are expecting input parameters from the stored procedure, type D to display
parameters

Or

If you want to review output, see “Reviewing DB2 Stored Procedure Parameters’
on page 109.

TypeR to begin the test session. See “Initiating the DB2 Stored Procedure Test” on
page 111 for more information.
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Reviewing DB2 Stored Procedure Parameters

To review input and output parameters

1  Review the parameters on the DB2 Stored Procedures Parameters screen, shown in
Figure 67). Each parameter specified in the PARMLIST column on the
SYSIBM.SY SPROCEDURES table displays.

Figure 67« DB2 Stored Procedures Parameters Screen

DB2 Stored Procedures Parameters
Command ===> Scroll ===> CSR
Name Type Address Structure Value Hex Value
_ CUSTNO IN 000D5148 CHARACTER(8) A1234 C1F1F2F3 F4404040
_ CUSTNM  OUT  000D5198 CHARACTER(20) JONES D1D6D5C2 C2C9D3
_ CUSTBAL OUT  OOOEO000 SMALLINT 50000 1388
_ ERROR ouT OOOE1000 CHARACTER(255)  ........ 00000000 00000000
BOTTOM OF DATA

This table describes the fields on the DB2 Stored Procedures Parameters screen:

Name Specifiesthe optional parameter namethat can be used by DB2 for
diagnostic messages.

Type Defines the parameter asIN (input), OUT (output), or INOUT
(110).

Address Specifies the main storage location acquired by SmartTest for the
data.

Structure Providesinformation on the parameter's data attributes: character,

integer, floating point, decimal, or variable character data.

Vaue Specifies the character format of the data at that storage location.
The maximum is 8 characters.

Hex Vaue Specifies the hexadecimal representation of the data at that
storage location.

2  TypeS intheline command areato the left of the parameter Name and press Enter.

- If the datais defined as numeric, the DB2 Stored Procedures Numeric Display
screen displays.

- If the datais not defined as numeric, the Memory Display screen displays.
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Changing Test Data Values

If the parameter you selected on the DB2 Stored Procedures Parameters screen is defined
as numeric, the DB2 Stored Procedures Numeric Display screen displays. If the
parameter you selected is non-numeric, the Memory Display screen displays.

To review/change numeric values

1  Review the selected parameter on the DB2 Stored Procedures Numeric Display
screen (see Figure 68).

Figure 68« DB2 Stored Procedures Numeric Display Screen

Command ===>

DB2 Stored Procedures Numeric Display

Numeric Data

Address  Type

OOOEOOOO SMALLINT

This table describes the fields on the DB2 Stored Procedures Numeric Display

Screen:

Numeric Data

Displays the current numeric value for the parameter. Y ou can
change the value in thisfield.

Address

Specifies the hexadecimal address of this parameter.

Type

Provides the parameter's data definition to DB2 (i.e., integer,
decimal, float).

Length

Specifiesthe datalength defined to DB2 (used only if the Typeis
decimal).

2 If desired, change the numeric value for the parameter in the Numeric Datafield.

110

Press Enter to save your changes.
Press PF3 twice to return to the DB2 Stored Procedures Setup screen.

Proceed to “Initiating the DB2 Stored Procedure Test” on page 111.
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To review/change non-numeric values

1  Review the selected parameter on the Memory Display screen (see Figure 69).

Figure 69« Memory Display Screen

Memory Display

Command ===> Scroll ===> CSR
Area 000D5148 Offset 000000 Length 000050

MEMBER DATA NAME=

000D5148 C1FIFCFS F4404040 00000000 00000000 00000000 * A1234 . ....... *

000D5158 00000000 00000000 00000000 00000000 00000000 * . .....ooveoeno...
000D5168 00000000 00000000 00000000 00000000 00000000
000D5178 00000000 00000000 00000000 00000000 00000000
000D5188 00000000 00000000 00000000 00000000 00000000 * .....ceoieoenon..

* % F
* %

This table describes the fields on the Memory Display screen:

Area Displays the hexadecimal address of this parameter.
Offset Displays the relative address of this parameter.
Length Displays the data length as defined to DB2.

2 Tomake achange, type over the values displayed.
3 Press Enter to save your changes.
4 Press PF3 twice to return to the DB2 Stored Procedures Setup screen.

5 Proceed to Initiating the DB2 Stored Procedure Test.

Initiating the DB2 Stored Procedure Test

Y ou have set up your DB2 Stored Procedurestest and are ready to initiate the test session.
The Break on entry option stops the session for interactive data entry. All SmartTest
functions (e.g., breakpoints, session tailoring, pseudo code, searching) may be used
during your DB2 test session.
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To initiate the test session

1  TypeR onthe DB2 Stored Procedures Setup screen and press Enter.

2  Watchthetest session execute the stored procedure in Program View. If you did not
set breaks during set up, the program executes until one of these conditions occurs:
=  Anabend error condition
= Anaddressstop
- Completion of the stored procedure

If you set Break on entry, the test session stops at the beginning of PROC (and at
other breakpoints, as specified).

3  Atthebreakpoint at the end of thetest, press PF4 (RUN) to return to the DB2 Stored
Procedures Setup screen (see “ Setting Up the DB2 Stored Procedure Test” on

page 107).

4  Onthe DB2 Stored Procedures Setup screen, type D to review output parameters on
the DB2 Stored Procedures Parameters screen (see “ Reviewing DB2 Stored
Procedure Parameters’ on page 109).

To use additional SmartTest functions, see “ Testing Techniques’ on page 127 and “ The
Intelligent Search Function” on page 169.

Testing Programs in a Batch Region

The Batch Connect facility in SmartTest allows your original JCL to be executed in a
batch region. Use of this facility provides significant reductions in setup requirements
and TSO resource consumption. The tradeoff isthe job remains active in the batch region
for the entire test session.

Consider using the SmartTest Batch Connect in these circumstances.

- Program(s) to be tested requires too much region for execution in TSO foreground.
=  Test requires media not accessible through TSO foreground (i.e., tape datasets).

e  Test must consist of multiple interdependent steps.

<  Test requiresthe use of special output forms.

=  Thereisalimit of one program to test for each SmartTest batch execution.
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When running a DB2 test under Batch where thereis a PROC in the JCL, the

SYSTSIN DD statement must be in the PROC and may not be overridden after the

execute of the Procedure. The DD for SY STSIN in the Procedure may use the
DDNAME Parameter to allow the DD statement to be placed after the execute.

The Batch Session Setup screens establish atest session in abatch region. Once the test
session is established, an online session can be connected to it. Batch program testing can
be performed interactively. Symbolic support may be unavailable for programs loaded
from read protected libraries.

Specifying Batch Connect Setup Information

The MVS, IMS, BTS, and DB2 Batch Session Setup screens are identical except for the
screentitle. MV S Batch is used asthe example for this section, but the discussion pertains
to setup in all Batch environments.

To establish a batch test session in an MVS batch region

1

2

Select MV S Batch on the Environment Selection pop-up. The Batch Session Setup

screen, shown in Figure 70, displays.

Figure 70 « Batch Session Setup Screen

EBatch fession Zetup
CoHHand ===

EF - EubMit edecution JCL G - Generate froW edecution JOL
C - Connect to subHitted job EG - Edit generated JCL
P - Fpecify procedure libraries 3G - ZubRit generated JCL
E - Edit esecution JCL
Execution: options:
Load Hodule  ________ Break an entry [YoN] YES
Procedure Mawme ________ Ereak CEECT-pgW id ________
Etep Mame . . ________ Reqion Size . . & - _____

Proc $tep Mame Library Hanager . .

Batch edecution JCL:
Data set nane
Henber . . .
Generated JOLI
Data =set nane
Henber o o . W

Fesgion nane for batch CoWAunications:
TE0 Userid . o UIAUZR_

Complete these fields:

a Enter the load module in the Load module field.

b Enter the batch execution JCL dataset name and member in the Batch

Execution JCL Data set name and Member fields, respectively.

c Enter the appropriate information in the options. A description of each option

is provided below.
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Options

Fields
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Option Description

S Submits the specified execution JCL. The JCL dataset name and
member name must be entered in the BATCH EXECUTION JCL
fields.

C Displays the Connect to Job pop-up used to connect the online test

session with a batch test session.

P Display the Procedure Libraries pop-up used to specify procedure
libraries. The procedure libraries listed on this pop-up are searched
before those located through the JESPROC or the PROCLIBS entry
in VIASPRMS.

E Invokes the TSO/I SPF editor with the batch execution JCL prior to
SmartTest-PLI changes.

G Generates the batch JCL and saves the output in the specified
GENERATED JCL member without executing it. The SG (Submit
Generated JCL) option can be used to pass the generated output
directly to the operating system for execution. Job submission does
not occur.

EG Generates batch connect JCL and invoke the TSO/ISPF editor with
the generated JCL . Job submission does not occur.

SG Submits the specified generated JCL. The generated JCL dataset
name and member name must be entered in the GENERATED JCL
fields.

Field Description

Load module Specifiestheinitia load module to be tested.

Procedure Name  Specifies PROC name of the procedure containing the execute
statement for the load module to be tested.

Step Name Specifies step name in the batch job that executes the load module
to be tested.

Proc Step Name Specifies the step name within the procedure that executes the load
module to be tested.
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Break on entry
(Y/N)

Indicates whether the test session will break on entry at the start of
the load module. Additional break on entry options are available on
the Session Tailoring screen for each program to be tested. The
default isYES.

BREAK CSECT/
pgm id

Causes the test session to stop on entry at the start of the specified
CSECT in astatically linked module.

Region size

Modifiestheregion sizein the execution JCL. Theregion size of the
step containing the program to be tested is changed to the value
specified in this field. The default is 4 megabytes.

Library Manager

Specifies the name of the subsystem. If the JCL to be converted is
stored in asource library that isinstalled with a subsystem option,
enter the name of that subsystem. Also, the dataset and member
name used by the source library management system must be
specified in the Batch execution JCL field.

Data set name

Specifies the partitioned dataset containing the member to be
submitted or edited, or from which JCL isto be generated. If the
subsystem option is used, specify the subsystem library dataset
name.

Member

Specifiesthe member to be submitted or edited, or from which JCL
isto be generated.

Data set name

Specifies the partitioned dataset that contains the generated JCL.

Member

Specifies the member that contains the generated JCL.

Session name for
batch
communications

TSO Userid

Contains the ID with which the batch session communicates, and
typically isthe user ID of the person submitting the job. Another
user ID can be specified if desired. If another user ID is specified,
note that the AKR and the test load libraries are those specified by
the user submitting the batch job(s). The AKR and load librariesfor
another user 1D could be different from those being used by the
person submitting the job.
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When you select option S or G on the Batch Session Setup screen, these changes are
made to the specified batch execution JCL :

- A STEPLIB DD statement for the step to be tested is added or updated to
concatenate the ESW load library to the user load library.

< TheREGION sizeis changed to the value specified on this screen.

- A VIAQUEUE DD statement is added for the SmartTest-PLI queue dataset used
during communication between the TSO and Batch test sessions.

e  The EXEC PGM isaltered for the step to be tested to allow SmartTest-PLI to gain
control at the appropriate step.

A SG recommends that the JOBNAME for the JCL you submit be unigue. If you use the
EG (edit generated JCL) option to generate the JCL to the specified dataset, the JCL can
then be edited and the job name can be changed in the generated JCL.

The REGION from the EXEC JCL card is changed to the specified REGION size on the
screen. A DD card is added to the STEPLIB for the dataset containing the ESW library. A
DD card is also added for the SmartTest VIAQUEUE dataset. This dataset is used to
transfer data to and from the TSO address space when the test job is executing. PROCs
are automatically expanded. Enter the required user PROCLIBs on the Procedure
Libraries pop-up (ENV.P).

ASG also recommends that you verify that the work file allocation information entered
on the Options - Product Allocations pop-up is valid for the batch test session. The
GENERIC UNIT and VOLUME SERIAL fields should contain the appropriate values
for your installation. Inappropriate work file allocations can cause unpredictable results
during the batch test session. See “ SmartTest-PLI Test Session” on page 15 for detailed
information on the Options - Product Allocations pop-up.

When submitting execution JCL or submitting generated execution JCL, the TSO
SUBMIT command isissued from a CLIST so the system standard TSO SUBMIT exit
receives control and can process the JCL. The submitted JCL must have a JOB card with
ajob name that will not be changed by the exit.

Processing Multiple Steps in a Batch Job
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To select one or more job steps

1  TypeENV onany SmartTest screen and press Enter. The Environment Selection
pop-up, shown in Figure 32 on page 47, displays.

2 Select the Batch connect environment option for your environment (MVS, IMS,
BTS, or DB2) and press Enter. The appropriate Batch Session Setup pop-up

displays.
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3 Type S or G on the command line, leave the Execution Load module field blank, and
press Enter. The Batch Session Setup - Step Selection, shownin Figure 71, displays.

Figure 71« Batch Session Setup - Step Selection Pop-up

Batch fession Fetup - &tep Selection
FPleaze select the STEP o STEPS wou wizh to test and press Enter.
TJob MaWel DIARZCUET

2TERP PGH TYPE  LOAD HODULE
# PROC HERGE [PROC UIAHETCL)
- HERGE . HERGE AUz UIAHERGE
# END PROC

EOTTOH OF DATA

4  TypeS to theleft of the job step(s). You can select a maximum of 24 steps.
5  Press Enter to continue the JCL generation, modifying each of the selected steps.

Submitting and Connecting to a Batch Job

To establish atest session in abatch region, submit a batch job and connect to it. After
submitting the job, use the Connect to Job pop-up to establish the TSO interface to the
jab.

Submitting a Job
To submit the batch job for execution

1  TypeS or SG onthe primary command input areaon the Batch Session Setup screen
and press Enter.

Note:

For future reference, note the job name and assigned job number shown in the TSO
message that displays (see Figure 72).

Figure 72« Connect to Job M essage Screen

+ASG20761 Batch JOB JOBNAME is waiting for connection by ASG-SmartTest I
Khk

2 PressEnter to return to the Batch Session Setup screen.
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Connecting to a Job

To connect the online TSO test session with a batch test session

1  TypeCintheprimary command input area on the Batch Session Setup screen and
press Enter. The Connect to Job pop-up, shown in Figure 73, displays.

Figure 73« Connect to Job Pop-up

Connect to Job
ConMand ===k ECroll ===k CIR

T50 Userid USERLZ [Required for TE0-IEPF HORi Tor]

Enter 'S' to select a job to be tested.

Enter 'P' to purge a job frod the ASG-SHartTest queus
file.

select JobnuH Jobnane Etatus

N

Select ajob by typing S in a Select field that has a status of WAITING FOR
CONNECT ION and pressing Enter.

Option Description

S Connectsto an available batch session. The selected job becomes active
in SmartTest (see “Initiating the Batch Test” on page 119).

Options

P Purges (delete) a batch session or submitted job.

Status Descriptions

CONNECTED, TEST Indicatesthat thejobiscurrently connected to theonline
ACTIVE test session by the specified TSO user ID.

BEGINNING EXECUTION Indicates that the job has a batch initiator, but is not
ready for connection.

JOB SUBMITTED TO Indicates that the job is waiting for a batch initiator.
BATCH
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TEMPORARILY Indicates that the job was previously connected to the

SUSPENDED onlinetest session by the specified TSO user ID but was
suspended using the PAL1 or ATTN key.

WAITING FOR Indicatesthat thejob hasabatch initiator and isready to

CONNECTION be connected to the online test session.

Initiating the Batch Test

After specifying all information for testing in the batch environment on the appropriate
Batch Session Setup screens, you can initiate the test by submitting the JCL and
connecting to the batch job.

When the batch connection is complete, the program source or disassembled object code
displaysin Program View (shown in Figure 74) and the test session is active.

Figure 74 « Batch Connect Program View Screen

File View Test Search List Options Help

Program View (A) VIAPPLI.VIAPPLIL1 -A
Command ===> Scroll ===> CSR
(B)296
>>>>>> CALL PROGRAM_INIT;
000298
000314 CALL PARM_EDIT; /* INITIAL PARM_EDIT */
000315
000316 IF PARM_TEXT = "EXIT® THEN
000317  RETURN;
000318 ELSE
000319 IF PARM_TEXT = "INVALID" THEN
000320 DO;
000321 CALL INVALID_PARM;
000322 RETURN;
000323 END;
000324

000325 IF CURRENT_PARM_NUMBER = +0 THEN
000326  CALL INVALID_PARM;

000327

() m +
|STATUS: BREAK AT START OF TEST SESSION PROGRAM: VIAPPLI1 DATE: DDMMMYYYY |
] STMT: 000297 OFF: 00029E AMODE: 31 MODULE: VIAPPLI TIME: HH:MM:SS |
| SOURCE: CALL PROGRAM_INIT; |
U U S +
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Screen Description

Screen Area Description

(A) VIAPPLI.VIAPPLI1-A Reflectsthe module and program (modulle . program)
being viewed and indicates the program isin an active
(-A) test session.

(B) >>>>>> Indicatesthe next statement to be executed. The statement
ishighlighted and chevrons appear in the number column.

(C) STATUS: BREAK Displays the status information when atest sessionis
active:

STATUS Indicates the current status of the test.

STMT Specifies the statement number of the next
statement to be executed.

OFF Specifies the offset into the CSECT/load
module where the next statement to be
executed is located.

AMODE Specifies the addressing mode for the load
module.

SOURCE  Specifiesthe source for the next statement
to be executed.

PROGRAM  Specifiesthe name of the program/CSECT
currently active in the test.

MODULE  Specifies the name of the load module
currently active in the test.

DATE Specifies the current date.

TIME Specifies the time the last program

statement was executed.
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Batch Region Considerations

When submitting JCL through SmartTest-PLI for testing in abatch region, you may need
to modify your JCL before processing. Keep these considerations in mind:

The TSO SUBMIT command is issued internally within SmartTest so the system
standard exit receives control and can process the JCL for job submission. The JCL
must have a JOB card with ajob name that will not be changed by the TSO
SUBMIT exit.

When testing DL/I in the batch environment, if the program to be tested does not
access DB2 databases or use BMP to access the DB2 database:

—  Select the IMS Batch environment on the Environment Selection pop-up.
—  Submit the JCL from the IMS Batch Session Setup screen.

Thereisalimit of one program to test for each SmartTest batch execution.

Testing DL/l in the Batch Environment

To usethe IMS Batch environment

1

Select the IMS Batch environment on the Environment Setup Menu to display the
IMS Batch Session Setup screen shown in Figure 75.

Figure 75+« IMSBatch Session Setup Screen

IH% Batch Zession Setup
CoHHand ===

£ - BubMit edecution JCL G - Generate froW esecution JCL
C - Connect to subkitted job EG - Edit genarated JCL

F - fpecify procedure libraries #G - EubRit generated JOL

E - EditT eHecution JCL

Execution: aptions:
Load Wodule  ________ Ereak on entry [¥<M] YE%
Procedure Mame ________ Ereak CEECT-pgn id  ________
Etep MaWe . . ________ Reqion SiZe . &« « _____

Proc tep Made Library Hanager . .

EBatch execution JGL:
Data set nane
Henber . . .
Generated JOL:
Data set nane
HeHbEr o o . W

Fession nade for batch CoMAunications:
TE0 Userid . « VIAUSR_

Submit the JCL from the Batch Submit screen.

Connect to the batch session using the batch Connect to Job screen.
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Testing BTS in the Batch Environment

To usethe BTS Batch environment

1  Select the BTSBatch environment on the Environment Setup Menu. The BTS Batch
Session Setup screen, shown in Figure 76, displays.

Figure 76 « BT S Batch Session Setup Screen

BTE® Batch Ze=szion fetup

Conrand ===
% - 2ubHit erecution JCL G - Generate fron edecution TJCL
C — Connect to subWitted job EG - Edit generated JCL
P - Epecify procedure libraries EE - EubHit generated JCL
E - Edit execution JCL
Execution: aptions:
Load Wodule  ________ Ereak on entry [Y<H] YE%
Procedure Made ________ Break CEECT-pgH id  ________
Ftep Mame . o ________ Region Sige o & « & _____

Proc Step Mame ________ Library Hanager
EBatch execution JCL:

Data set nade

Henber .« . . .
Generated JCLI

Data set nade

Herber . . o &

F@sSi0n naWe for batch conMunications:
TE0 Userid o o VIAUSR_

2 Submit the JCL from the Batch Submit screen.

3 Connect to the batch session using the Connect to Job screen.
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Testing DB2 in the Batch Environment

To test DB2 using the Batch Submit screen

1  Select DB2 Batch asthe environment on the Environment Setup Menu. The DB2
Batch Session Setup screen, shown in Figure 77, displays.
Figure 77 « DB2 Batch Session Setup Screen

DEZ Batch Zession Setup
CoHHand ===

% - BuUbHit eHecution JCL G - Generate frod edecution JCL
¢ - Connect to submitted job EG - Edit generated TCL
F - S|:lEEi'F5I pr-:-cedure libraries G - EFubMi t generated JCL
E - Edit eHecution JCL

Executiona I:Ip‘l'i ons.
Load Wodule  ________ Ereak on entry [TY-N] YES
Procedure MaWme ________ Eraak CSECT-"FH;H id  ________
step MaWe . . ________ REgion SiZe . & & & _____
Proc ftep Mame ________ Library Hanager . . ____

Eatch edecution JCL:
Data set nane
Henbel o« o & o ________

Gener-ated JCL:
Data set nawWe
HeHbet . . & o ________

Zezzion naWe for batch CoWMunications:
TE0 Userid . . VIADZR

2 Submit the JCL from the Batch Submit screen.
3 Connect to the batch session using the Connect to Job pop-up.

Thereisalimit of one program to test for each SmartTest batch execution.

When running a DB2 test under Batch, the JCL that is submitted is automatically
changed. If thereisa PROC in the JCL, the SYSTSIN DD statement must bein the
PROC and may not be overridden after the execute of the procedure. The DD for
SYSTSIN in the procedure may use the DDNAME Parameter to allow the DD statement

to be after the execute.

Note:

SmartTest does not recognize the L1B() field of the SYSTSIN dataset. Load libraries
specified in the LIB() field must be specified in the STEPLIB DD concatenation.
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Support for Changed DB2 Interface

DB2 Version 4.1 provides an alternative method in which IMS/DB can set up the DB2
environment. The execution parameter specifies the application program name and must
specify the SSM field, for example:

EXEC PGM=DFSRRCOO,PARM="DLI,pgm,pPsSb, ,,5555555532355,5SM"

SmartTest supportsthis new interface, but requiresthat the JCL specify the DDITV01DD
card. See the IBM DB2 for MVS Application Programming and SQL Guide for more
information on this alternative method.

Testing DFHDRP in the Batch Region

To test DFHDRP in the batch environment

1  Select the MV S Batch environment on the Environment Selection pop-up.

2 Edit the JCL from the Batch Session Setup screen and change the program to be
tested to VIAPDLI. Thisisdone by changing the PGM=pgmname parameter in the
PARM statement to PGM=VIAPDLI.

3 Submit the JCL by typing S or SG on the setup screen.

4 Connect to the batch session using the batch Connect to Job screen.

DFHDRP Batch JCL
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Figure 78 shows the DFHDRP batch JCL before being modified by SmartTest.

Figure 78« DFHDRP Batch JCL Before Modifications

//ASG JOB (ASG), "ASG-SMARTTEST DFHDRP*®

/*ROUTE PRINT DEST

//*

//DFHDRPB PROC SYSOUT=A

//*

//STEPO1 EXEC PGM=DFHDRP,REGION=1M,

// PARM="SSA=254,PGM=TPGM22,PSB=TPGM22,CICS=CICS1,CMPAT=Y,LANG=C"
//STEPLIB DD DSN=USER.PGMLIB,DISP=SHR

// DD DSN=IMS.RESLIB,DISP=SHR
// DD DSN=CICS.RESLIB,DISP=SHR
//1MS DD DSN=USER.PSBLIB,DISP=SHR
// DD DSN=USER.DBDLIB,DISP=SHR

//DFHLIB DD DSN=CICS.LOADLIB,DISP=SHR
//SYSUDUMP DD SYSOUT=&SYSOUT

// PEND

//DRPTEST EXEC DFHDRPB

//SYSOUT DD SYSOUT=&SYSOUT

//REPORT DD SYSOUT=&SYSOUT

//D121PART DD DSN=PART.DB10V09,DISP=SHR
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Figure 79 shows the DFHDRP batch JCL after being automatically modified by
SmartTest.

Figure 79« DFHDRP Batch JCL After Modifications

//ASG JOB (ASG), "ASG-SMARTTEST DFHDRP®

/*ROUTE PRINT DEST

/*

//DFHDRPB PROC SYSOUT=A

/*

//STEPO1 EXEC PGM=DFHDRP,REGION=2M,

// PARM="SSA=254,PGM=VIAPDLI ,PSB=TPGM22,CICS=CICS1,CMPAT=Y,LANG=C*
//STEPLIB DD DSN=ASG.VIACENxx.LOADLIB,DISP=SHR,

// DCB=BLKS1ZE=32760

// DD DSN=USER.PGMLIB,DISP=SHR
// DD DSN=IMS.RESLIB,DISP=SHR
// DD DSN=CICS.RESLIB,DISP=SHR
//IMS DD DSN=USER.PSBLIB,DISP=SHR
// DD DSN=USER.DBDLIB,DISP=SHR

//DFHLIB DD DSN=CICS.LOADLIB,DISP=SHR
//SYSUDUMP DD SYSOUT=&SYSOUT

// PEND

//DRPTEST EXEC DFHDRPB

//SYSOUT DD SYSOUT=&SYSOUT

//REPORT DD SYSOUT=&SYSOUT

//D121PART DD DSN=PART.DB10V09,DISP=SHR
//VIAQUEUE DD DSN=ASG.VIACENxx.QUEUE,DISP=SHR
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5

Testing Techniques

This chapter describes testing techniques for SmartTest-PL1 and contains these sections.

L earning the Commands 128
Testing with SmartTest 128
Controlling Program Execution 130
Viewing and Changing Test Session Data 142
Program Execution History (Backtrack) 147
Using Pseudo Code 155
Making Proposed Changes Permanent 160
Using Multiple Programs 160
Tailoring a Test Session by Program 161
Capturing and Replaying Test Sessions 161
Position the Display at the Next Executable Statement 163
Saving Keystrokes 164
Linking to Alliance 166
Note:

This chapter assumes that you have completed the appropriate setup and analyze
procedures.

127



ASG-SmartTest PLI User’s Guide

Learning the Commands

SmartTest provides both a Common User Access (CUA) and a command interface to
accomplish your testing activities. CUA presentsan intuitive way of performing tasks. As
you gain experience with SmartTest, you may find that using commandsiis faster than
CUA pull-downs for frequently used functions. To assist you in making the transition
from CUA to commands, SmartTest includes aLearn Mode. When Learn Mode is on,
SmartTest inserts a pop-up, before executing arequest, that shows the primary command
equivalent to the sel ections made on the CUA pull-downs and pop-ups. This pop-up helps
you learn the command syntax for frequently used functions. The full CUA functionality
remains available a so.

To turn the learn mode on, type SET LEARN ON in the primary command input area
and press Enter. The short message area displays the message LEARN ON.

To turn the learn mode off, type SET LEARN OFF in the primary command input area
and press Enter. The short message area displays the message LEARN OFF.

Testing with SmartTest

At the start of atest session, SmartTest attaches the application program as a subtask to
SmartTest's user interface code. Execution of the application program is controlled by
commands entered to SmartTest, which in turn controls the application code.

SmartTest has two distinct methods for controlling the application program—MONITOR
and NOMONITOR. Each method has a strength and a weakness and each is designed to
help get the most out of debugging sessions. SmartTest allows mixed methods during a
single test session to offer benefits of each technique for individual test situations.

Both MONITOR and NOMONITOR are specified by an operand in the RUN function.
The SET MONITOR command determines the default. Guidelines for choosing either
MONITOR or NOMONITOR areincluded in this manual.

Testing Using the MONITOR Method
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The MONITOR method is designed specifically to help during the detailed debugging
stage, when a problem has been isolated to a specific program, or a specific subroutine
within a program.

Using the MONITOR method, SmartTest executes the application program code one
instruction at atime. Executing instructions individually gives SmartTest the ability to
create an execution history (LIST TRACKING), count each statement as it executes
(LIST COUNTS), and monitor instructions that modify memory. Monitoring memory
modifications gives SmartTest-PLI the unique ability to provide storage protection for a
user-specified location (LIST ADSTOP).
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Using the MONITOR method also allows temporary modification of the program using
COBOL-compatible pseudo code. Additional advantages to the MONITOR method
include minimal test setup requirements, detection of INVALID BRANCH situations,
etc.

Since the monitoring method requires execution of several instructions by SmartTest to
execute one application instruction, the CPU overhead of monitoring alargetest is
significant. If performance becomes an issue, use the NOMONITOR method (RUN
NOMON).

Testing Using the NOMONITOR Method

The NOMONITOR method is designed to execute the application at native speed with
negligible CPU overhead added by SmartTest. In the NOMONITOR method, SmartTest
gives control to the application program and waits for an application abend, a breakpoint,
or completion of the test.

In the NOMONITOR method, certain facilities are not available (LIST TRACK, LIST
COUNTS, etc.). However, abends are intercepted and COBOL -compatible pseudo code
can be inserted to control the flow of the test program.

The NOMONITOR method placesintentional abend instructions (breakpoints) at various
pointsin the object code, then gains control when the code abends (SOC1) during
execution. This technique requires that each program analyzed must be linked with the
REUS parameter. This parameter is automatically supplied by the Analyze process, but
can be overridden on the SmartTest List - Analyze Submit pop-up.

Guideline for Using the MONITOR/NOMONITOR Methods

In general, use the MONITOR method for most testing and debugging. The CPU
overhead in relation to the value of the debugging information is acceptable.

For example, the Execution Tracking screen shows all of the statements that executed, in

execution sequence. This screen can be used to follow the execution path backward to see
the execution path to the current statement.
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To reduce the overhead of atest session, place a breakpoint at alabel where a suspected
problem exists and then execute the program using NOMONITOR to execute the test at
native speed until it reaches the breakpoint set. Then, use the STEP primary command or
RUN MONITOR primary command to find the problem. After finding the problem,
either CANCEL thetest, or RUN NOMONITOR to completion. This technique uses the
strengths of both methods, while reducing the overall CPU utilization.

Note:
The NOMONITOR method makes problem determination difficult when the application
program issuesits own SPIE/ESTAE. Thisintercepts the intentional internal program
checks set by SmartTest before it can examine them, yielding unpredictable results.

To test such programs, disable the SPIE and restart the test using NOMONITOR. If there
isno way to disable the SPIE, it is necessary to run through the SPIE/ESPIE using
MONITOR. Then, you can run through the rest of the code using NOMONITOR.

Testing Dynamically Called Load Modules

Prior to executing a CALL verb, many application programs use the FETCH verb to
locate or dynamically load the module to be CALLed. When using the MONITOR
method of testing, SmartTest can detect whether a module that is FETCHed has been
statically linked.

When using the NOMONITOR method, SmartTest cannot determine when control is
transferred from one load module to another. If you want to make SmartTest debugging
facilities available in the CALLed module, it is necessary to define to SmartTest the
names of the FETCHed load modules. This specification allows SmartTest to intercept a
CALL to those modules.

To test dynamically CALLed load modules, use the QUALIFY command to activate the
CALLed module. Then, you can either set breakpoints in the module, or set the Break on
Entry column to YES on the Test Session Tailoring screen.

Controlling Program Execution
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SmartTest gives you the opportunity to step through a program statement by statement or
execute the program to a specified breakpoint where you can verify the program's
behavior. You may interrupt or end atest session at any time without waiting for
end-of-jab.
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Program execution is controlled using actions on the Test pull-down, primary commands,
or line commands. Figure 80 shows the Test pull-down.

Figure80+ Test Pull-down Menu

File Uiew Test =earch List Optionz Help

__ 1. setup Nizards...
CoMHand === 2. RUMN..s
T. FtEPaa.
4, Cancel
5. Break...
B. TtOp... Hoketctok
Fo GOa.. Heteicick
* Ga. Hove,... Eod Hebetotck Hetetetetotok
=k F. Add... E S s e btttk
Hekk 10. Fubtract... #  cheleblk etk
debeich 11. WhEre... Heketsick: ek
Atttk 12. TESTpDintS... Aetetetetebetetetetttetebtet=tot
Hekatstch 13. ASG-ALliance Interface... | sekmckikidrikmckn
14. CICE MENCOPY...
15. DuMp

Cap unpublizhed wark.
A proprietary product of ASG, Inc. Use restricted to authorized licensees.
Vizit the ASG Zupport Web Zite at wuw.asg.cod

Selecting Test Environment Using the Setup Wizards

Use the Setup Wizards option to save timein setting up common types of test
environments. Setup wizards are available for IMS, CICS, and programsin TSO
foreground or using batch connect. These wizards are self-explanatory and walk you
through the process of setting up the appropriate environment.

Executing the Program Continuously Using RUN

To begin test execution or to resume execution after an interrupt occurs, follow this step:

P Select Test » Run or type RUN. The Test - Run Request pop-up, shown in Figure 81,
displays.

Figure8le« Test - Run Request Pop-up with BackTrack Off

Test - Run Request

Enter "Run To" line nudbetr and Honitor aptions
as needed.  Then press Enter.

Run to Line Munber ______
#elect Honitor option

1. Honitor

2. No Honitor
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Aninterrupt can result from any of these conditions:
<  Abend error condition

- Breakpoint or Stop Address

<  Completion of program

Y ou can use the RUN command any time program execution is suspended. This
command is usually assigned to a PF key for convenience.

These are examples of the RUN command:

RUN MON Allows all execution features to be available.

RUN TO 1432  Establishes line number 1432 as the stopping point. Execution
continues to line 1432 unless other interrupts occur beforethelineis
reached.

See the ASG-SmartTest Reference Guide for more information about using the RUN
command.

Executing a Specified Number of Statements Using STEP

To execute a specific number of statements any time program execution is suspended,
follow this step:

P Select Test P Step or type STEP. The Test - Step Request pop-up, shown in Figure 82,
displays.

Figure82« Test - Step Request Pop-up

Test - ftep Requast

Zelect &tep type, Step Options, of Honitor Option, as needed.
Then press Enter.

Itep ...

1. to nedt STATEHENT [Default)

2. tTo nedt PARAGRAPH-LABEL

3. OVER [COEOL PERFORH, ASsedbler Linkage, or

FL-I GCALL]
Step Options:
Etep Count _____ Enter 1 to BS535 [to @99 for
Auto]
step Auto  _ Enter non-blank to select

Honi tor Option: [If OVER specified]
1. Honitor
2« HNo Haoni tor
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Aninterrupt can result from any of these conditions:
<  Abend error condition
- Breakpoint or Stop Address

<  Completion of program

When there are no abends or breakpoints, the program executes the specified number of
statements or runs until the program compl etes.

Y ou may use the STEP command any time program execution is suspended. This
command is usually assigned to a PF key for convenience.

These are exampl es of the STEP command:

STEP Executes the next statement and stops.

STEPS5 Executes the next 5 statements before stopping.

STEPAUTO Executes one statement and pausesfor the time period specified using
the SET DELAY command.

See the ASG-SmartTest Reference Guide for more information about using the STEP
command.

Changing Program Execution Sequence Using GO

SmartTest-PLI provides the capability of changing the program execution sequence. This
may be useful to bypass certain code or to test only certain code.

Select Test » Go, the GO line command, or the GO primary command to change the next
statement to be executed. The RUN or STEP command causes execution to resume at the
selected statement.

The Test - Go Request pop-up is used to transfer control to the statement containing the
specified PL/I label name, pseudo code label, or line.

Note:
Y ou must be in an active test session to use the GO command. Y ou can only enter a GO
command for executable source lines. It is recommended you use the GO command only
to transfer control to a statement within the PROCEDURE or BEGIN block currently
being executed.

Altering execution flow may cause some statements to be re-executed or by-pass
statements that initialize data fields resulting in abend conditions or unpredictable results.

133



ASG-SmartTest PLI User’s Guide

Interrupting Test Execution Using Keystroke

Usethe PAT/ATTN Key to interrupt program execution during atest session.

In TSO foreground, when you press PAVATTN after aRUN MONITOR primary
command isissued, the RUN command is changed to a STEP command and the program
is suspended at the next PL/I statement. When you press PAL/ATTN after aSTEP n
command is issued, the remaining steps are not executed and the program is suspended at
the next PL/I statement.

Note:
Theinterrupt keys do not apply to CICS when executing with NOMONITOR.

In aBatch Connect test session, when you press PAL/ATTN when a program is running,
the connection to the batch region is suspended. The batch version of SmartTest
continues to run until an abend or break, or the completion of the test. When the batch
region isready for command input, SmartTest sets the job state to Waiting for
Connection. The SmartTest job waits for the tester to reconnect to the job and resume
testing, or times out if waiting too long.

Inserting Breakpoints to Interrupt Execution

SmartTest provides the capability of inserting breakpoints into a program at desired
locations. Program execution is suspended each time a breakpoint is encountered during
test execution. While the program is suspended, you can view data values, insert pseudo
code, trace execution paths, or perform other SmartTest tasks.

SmartTest provides three methods of inserting breakpoints into your program:

<  Manualy, at specific lines

=  Automatically, based on program knowledge

< Automatically, with an impact dataset

After inserting breakpoints, they remain active until deactivated or deleted. Y ou may save

breakpoints in the AKR for any program when you conclude atest session. In that way,
the breakpoints are in the program if the test needs to be resumed later.

Manually Inserting Breakpoints in the Program

Use the BR line command to manually insert a breakpoint before the source line where
the command is entered. When you type BR on a non-executable or continuation line, the
BREAK isinserted before the next executable statement in the program.
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Automatically Inserting Breakpoints in the Program
To automatically insert a breakpoint, follow this step:

» Select Test » Break or type BREAK.

The Break facility usesthe Intelligent Search Function to insert multiple breakpoints with
a single command.

Y ou can insert breakpoints before or after the specified target. For example, typing
BREAK 1000_INITIALIZE inserts abreakpoint before the label 1000_INITIALIZE.

For more information about the search function and available operands, see"The
Intelligent Search Function” on page 169 and "Searching for PL/I Program Information

on page 173.

Inserting Breakpoints with Impact Datasets

SmartTest provides facilities for automatically setting breakpoints with lists of data
items. Thelists are called impact datasets. Y ou can create impact datasets yourself or
import them from AutoChange, Alliance, or Estimate.

Impact Datasets from Other Programs

Execution JCL supplied with these ESW products is used to run batch jobs for creating
impact datasets:

=  AutoChange—VIAMEXPJ
« Alliance— VIAMEXPJ
-  Estimate— VIAMEXPJ]

See the ASG-AutoChange User’ s Guide, the ASG-Alliance User’s Guide, or the
ASG-Estimate User’ s Guide for information on creating impact datasets.

User-supplied Impact Datasets

The name of an impact dataset must match the name of the program to which it will be
applied. When creating an impact dataset, create it asa member of a PDS and name it

appropriately.
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The member containsalist of fully qualified datanames, one fully qualified dataname per
line. Each dataname must begin in column ten. Lines beginning with an asterisk are
comment lines. All lines that are not comment lines must contain an X in each of the first
four columns, as shown in Figure 83.

Figure 83« User-supplied Impact Dataset

XXXX  TEST-DATE 00020000
XXXX NUMBER1 OF TEST-NUM1 00030001
XXXX 00040000
XXXX 00050000

To set breakpoints with impact datasets

1  TypeTESTPOINT onthe command line, or choose Testpoints from the Test
pull-down. The Test - ASG-SmartTest Testpoint Generation pop-up, shownin

Figure 84, displays.

Figure84 e« Test - SmartTest Testpoint Generation Pop-up

Test - ASG-SnartTest Testpoint Generation
CoHHand ===F

Enter PrograH, Attribute, IWpact type and POS, then ENTER to generate point
Press END to Peturn.

Generate Testpoints:

Prograd(s)eaaseannns IGZEEET

Data nadMe ATtribute. HOD [HOD<REF]

IHpact tYp&eaeeaaun. AUTO [AUTO-ALL-EST ~USER]
PDEeaennnns e

HEHBEE v e e s s smnnnn IGZEBST

2 Complete the fields using the information this table:

Program(s) Selectsprogramslisted in theimpact dataset. Enter the name of
asingle program or use an asterisk to select al of them. The
names you select must match the names of the programsto
which you apply the breakpoints.

Data Name Specifies where to set breakpoints. One of two entriesis

Attribute allowed, either MOD or REF. MOD sets a breakpoint in the
code wherever an impacted dataitem is modified. REF sets a
breakpoint in the code wherever the impacted dataitem is
referenced.
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Field Description

Impact Type Indicates the source of the imported impact dataset. These are
the allowable entries:

AUTO. AutoChange
ALL. Alliance

EST. Estimate
USER. User-supplied

PDS Specifiesthe PDS containing the impact dataset to beimported.

Member Liststhe PDS member name containing the impact dataset for
ALL, EST, or USR impact types.

Press Enter to display the Test - Testpoint Qualified Program List pop-up shown in
Figure 85.

Figure85¢ Test - Testpoint Qualified Program List Pop-up

Test - Testpoint Qualified Program List
Command ===> Scroll ===> CSR

Select program(s) from the list, then Press ENTER to generate points. Press
END to return.

PDS......... "ASG.VIACENXX.TESTPNT"
Program Specification: *

Selected Program Status

_ TESTPLIA READY
_ TESTPLIB READY
_ TESTPLIC READY

BOTTOM OF DATA
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4  Typean S next to the names of those programs you wish to select and press Enter.
The Breakpoints List screen, shown in Figure 86, displaysfor the first program you
selected.

Figure 86« BreakpointsList Screen

Breakpoints List TESTPLI.TESTPLI1

Command ===> Scroll ===> CSR
Set pseudo . . ON Pseudo active: 13 Inactive: 0
Set breaks . . ON Breaks active: 13 Inactive: 0
Set whens . . . ON Whens active: 0 Inactive: 0
S Line Pseudo Code (breakpoints highlighted) A Count
_ 000046 *
o 1 BREAK Y 000000
_ 000047 TESTNUM1=1;
~ 000048
o 1 BREAK Y 000000
_ 000049  TESTNUM2=2;
_ 000050
e 1 BREAK Y 000000
_ 000051 TESTDATE=1;
_ 000051 TESTDATE=1;
o 1 BREAK Y 000000
000052 TESTDATE=1;

138




5 Testing Techniques

The Breakpoints List screen allows you to make these adjustments:
=  Changethe status of SET PSEUDO, SET BREAKS, or SET WHENS.
- Deactivate individual breakpoints.

- Remove individual breakpoints.

5 Exit the Breakpoints List screen. The Program View screen, shown in Figure 87,
displays breakpoints and the source code or disassembled object code and data.

Figure 87« Program View Screen

File View Test Search List Options Help
Program View TESTPLI.TESTPLI
Command ===> Scroll ===> CSR
""" 1 BREAK
000047  TESTNUM1=1;
000048
""" 1 BREAK
000049  TESTNUM1=1;
000050
""" 1 BREAK
000051  TESTDATE=1;
""" 1 BREAK
000052  TESTDATE=1;
""" 1 BREAK
000053  TESTDATE=1;
""" 1 BREAK
000054  TESTDATE=2;
""" 1 BREAK
000055  TESTDATE=2;
""" 1 BREAK
000056  TESTDATE=2;
000057 *

6  Ingpect the breakpoint settings in the Program View screen and exit the Program
View screen. The Test - Testpoint Qualified Program List pop-up redisplays.

After successfully applying an impact dataset to a program, you see an IMPACT
APPLIED message in the Test - Testpoint Qualified Program List pop-up,
indicating that breakpoints have been saved into the program's source code in the
AKR. Y ou have these options:

- If you selected multiple programsin step 3 on page 137, those programs are
still selected. Press Enter and repeat step 4 on page 138 and step 5 for the next
selected program.

-  Select one or more program, press Enter, and proceed.

- Exit.

Inserting Breakpoints at Date-related Data Items

To set breakpoints at date-related data items, use the EXECUTE command to run the
STFINDAT script whilein atest. The STFINDAT script sets breakpoints wherever it
finds date identifiers and special keywords unique to date processing across IMS (PCB
date fields), CICS (EXEC CICS asktime), and COBOL (CURRENT_DATE, etc.).
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When executed, the STFINDAT script performs these tasks:

- Finds al dataitems listed in the script

- Highlights the data items

- Issuesa BREAK HI ALL command

Usethe STFINDAT script to interrupt processing at key points so that you can examine
or change date information. The STFINDAT script can be tailored to locate these items:
-  Callsto user-written date routines

-  Date-related comments

=  Changes having acommon pattern that are also date sensitive, such asin CALL
routines and copybook areas

Locating the Next Executable Statement

When atest is suspended, you may want to scroll through the program examining other
statements or data values. To reposition the screen to the next statement to be executed,
type LOCATE * inthe primary command input area and press Enter.

Displaying Breakpoints
To display breakpoints, follow this step:

P Select List» BreakpointsortypeL1ST BREAK. TheBreakpointsList screendisplays
listing all breakpoints for the program currently in Program View.

Y ou can activate and deactivate individual breakpoints or all breakpointsin a program
using the Breakpoints List screen.

Removing Breakpoints Individually

Use the D line command on the Breakpoints List screen to delete individual breakpoints
from the program. This command operates in the same manner asthe D (delete) line
command in TSO/ISPF.

Removing All Breakpoints

Usethe View - Reset Request pop-up or the RESET BREAKS primary command to
remove all breakpoints from the program. The Breakpoint included in blocks of pseudo
codeisonly deleted if the BREAK statement is the first statement in the block. You can
also use the RESET PSEUDO command to delete the breakpoints along with the rest of
the pseudo code statements.
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Generating a Dump

To generate a dump, follow this step:

» Select Test » Dump or type DUMP to generate a symptom and a snap dump of the
program being tested, along with its control blocks.

The symptom dump includes general program information and REGISTER information.
The REGISTER information contained in the snap dump is limited to the current values
at the time you issue the dump and might not include the user’ s register values. The snap
dump consists of all PDATA and some SDATA SNAPX options and is appended to the
symptom dump data. All dump datais copied to thelog file. See "Log/List/Punch
Processing Options' on page 21 for information about processing the log file.

Canceling a Test Session

To cancel the current test session, follow this step:

» Select Test » Cancel or type CANCEL.

The CANCEL command closes open test files and frees allocated storage. The program
remains displayed in Program View. Use the RUN or STEP commands to restart the test
if desired.

The short message reflects the cancellation of the test session, and the data window and
status box are removed from the Program View screen.

Exiting a SmartTest-PLI Test Session
To terminate atest session and exit from SmartTest, follow this step:
» Select File » Exit.
Any pseudo code, marks, or breaks are saved in the AKR if the online operation

parameters have Save as the default. See " SmartTest User Options' on page 18 for more
information on setting these parameters.

Y ou can also exit SmartTest by continually pressing PF3 or by typing =x on the
command line.
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Viewing and Changing Test Session Data

SmartTest provides the ability to interactively view and change data, allowing you to test
al program conditions, including conditions not exercised by the datain test files. You
can view and change data by opening data windows within the program and typing over
the values presented in the data window. Y ou may open windows to view and change the
data any time program execution is suspended.

Data windows may be displayed inline with the statement where the datais used, at any
DECLARE statement, or at the top of the Program View screen. Y ou may open windows
on individual or group level dataitems. The values shown in data windows are always
current and change as the program executes.

SmartTest determines the size of the data windows based on the amount of datato be
displayed. Y ou may override the default size for each data window on the Options -
Modes screen. If adata window cannot contain al the data to be displayed, it becomes
scrollable.

The message UNABLE TO ACCESS DATA inthe valuefield indicates that storage for
the dataitem has not been allocated.

Viewing Test Session Data Items Inline
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Usethe ZD, ZH, ZG, ZGH, ZOOMDATA, K, and KEEP commands to perform these
functions.

Use the ZD line command to open display format data windows to show the value and
address of dataitems.

Use the ZH line command to open hexadecimal format data windows to show the value
and address of dataitems.

Theresult of aZD or ZH line command is a data window showing the data items
referenced on the line where the command is entered. The datawindow is positioned after
the statement where the command was entered. When the screen is scrolled, the data
window moves with the display. If the data window cannot accommodate all the data
items specified for it, you can scroll through the data window.
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The datawindow contains the definition and value of the dataitem. Alphanumeric values
are shown in character format and numeric values are shown in decimal format with
leading zeroes suppressed. If the length of the dataitem is greater than fifty bytes,
additional lines are displayed with +50, +100, +150 and so on preceding them as shown

in Figure 88.

Figure 88+« Samplelnline Data Screen

File Uiew Test =Zearch List Options Help
Prograd Liew TEETCOBA.TEZTCOBR
CoHHand === Ecroll ===} CER
ooggal  IDEMTIFICATION DIVIEION.
BOEEEZ  PROGRAN-I0. TESTCOBA.
BOEE83  ENVIROMHENT DIVISION.
aoo0ad  CONFIGURATION SECTION.
B000a5 DATA DIVIEION.
O00006  WORKING-2TORAGE ZECTION.
aoggay @1 TESTER.
""" +
""" a1 TEZTER PIC HM[&S] ADDR &0a07a%8
""" WALUE % muuessssssnnumunnnnnsnssnnnnnnnnnnnsnnnsnnnnnnnnns %
""" FEE P L iausmssssssssssssanamnnssnsnnnnnnnnnn
------ +
BEAaaS 05  WE-CHEP-COUNTER PIC $99%9.
LTk 05 WE-CHEKP-INTERUAL PIC ®[5]1. DEADDAT
LT 0s  TEETI PIC X[79].
[ILTITG U5  LAR-FIELD REDEFIME: TEZT3.
Ll LT el 18 HUHEER1 PIC £%(5] COHP-3.
AEEEL 3 18 FILLER PIC ®[7&].
UL SKIPZ

When you enter the ZD or ZH line command on an array data item, the dimensions are
shown to allow you to change the data item being displayed.

Y ou may use the n (number) operand of the ZD command to display one dataitemin a
statement containing multiple dataitems. Data items are assigned relative numbers from
left to right on the line. The number entered represents the relative number of the data
item to be displayed. For example, the line command ZD 2 opens a data window
containing the second data item on the line.

When you enter a second ZD or ZH line command on the same statement, the existing
data window is replaced.

Datawindows may be removed, individually or globally, from the program being viewed
(see "Removing Zoom Data Windows" on page 145).
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Viewing Group Data Items Inline
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Use the ZG line command to open a data window in display format showing the levels,
value, and address of group dataitems and all of their subordinate data items.

Use the ZGH line command to open data windows in hexadecimal format showing the
levels, value, and address of group dataitems and all of their subordinate dataitems.

Theresult of aZG or ZGH line command is a data window positioned where the
command was entered. When the screen is scrolled, the data window moves with the
display. If the data window cannot accommodate all the dataitems specified for it, you
can scroll through the data window.

When you enter the ZG or ZGH line command on a subscripted or indexed dataitem, the
occurrence number is shown to allow you to change the entry being displayed (see

Figure 89).

Figure 89« Relative Dataltemin ZG

File View Test Search List Options Help

Program View VIAPPLI _VIAPPLI1 -A
Command ===> Scroll ===> CSR
000240 05 SOC7_DATA,
...... o ey
----- | 02 SOC7_DATA DATA(16) ADDR 00142870 |
---- | 03 DATA_PACKED_DEC DEC FIX (15,0)  ADDR 00142870 I
------ | VALUE > +123 < I
----- | 03 DATA_DISPLAY_DEC CHAR(8) ADDR 00142878 I
------ | VALUE > +0000000 < I
------ | 03 soc4_suB CHAR(8) ADDR 00142880 |
------ | VALUE > +0000000 < I
----- | 03 SOC4_SUB_MAX CHAR(8) ADDR 00142888 |
------ |  VALUE > +0000000 < I
...... | 03 SOC4_CORE CHAR(80) ADDR 00142890 I
----- | DIMENSION ( 1) I
------ I VALUE > oot < I

Aswith ZD and ZH, you may use the n (number) operand to display one dataitem on a
line containing multiple data items. Data items are assigned rel ative numbers from left to
right on the line, and the number entered represents the relative number of the dataitem
to be displayed.

The datawindow contains the definition and value of the dataitem. Alphanumeric values
are shown in character format and numeric values are shown in decimal format with
leading zeroes suppressed. If the length of the dataitem is greater than fifty bytes,
additional lines are displayed with +50, +100, +150 and so on preceding them.

When you enter another ZG or ZGH line command on the same statement, the existing
data window is replaced.

A ZD or ZH command is executed when aZG or ZGH line command is entered for adata
item with no subordinate data items.



5 Testing Techniques

Viewing Data Values Where Declared

Usethe ZOOMDATA, ZD, ZG, ZH, and ZHG primary commands to position the
Program View screen at the definition of a specified dataitem and open an inline data
window to display the dataitem. The ZD, ZG, ZH, and ZHG primary commands have the
same meaning as the corresponding line commands.

The result of any of these primary commands is a data window positioned at the DCL.
When the screen is scrolled, the data window moves with the display. If the data window
cannot accommodate all the data items specified for it, the data window becomes
scrollable.

The datawindow contains the definition and val ue of the dataitem. Alphanumeric values
are shown in character format and numeric values are shown in decimal format with
leading zeroes suppressed. If the length of the dataitem is greater than fifty bytes,
additional lines are displayed with +50, +100, +150 and so on preceding them.

Removing Zoom Data Windows

Y ou may remove inline data windows from a program individually or globally.

Removing Individual Zoom Data Windows

Usethe ZO or D line command to close adata window opened as aresult of aZOOM line
or primary command.

Removing All Zoom Data Windows

Usethe RESET ZOOM primary command to close all datawindows opened as aresult of
aZOO0M line or primary command.

Viewing Data Values at the Top of the Screen

To view data values at the top of the screen, follow this step:

P Select View » Keep, type KEEP, or use the K line command to open a data window
containing the value and address of dataitemsin display format at the top of the screen.

Use the KH line or primary command to open a data window containing the value and
address of dataitemsin hexadecimal format at the top of the screen.

Usethe KG line or primary command to open a datawindow containing the levels, value,
and address of group dataitemsin display format at the top of the screen. Use the KGH
line or primary command to open a data window containing the levels, value, and address
of group dataitems and all their subordinate data itemsin hexadecimal at the top of the
screen.
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The result of the Keep option; the Keep primary command; or K, KH, KG, or KGH line
command is a datawindow positioned at the top of Program View. When the screenis
scrolled, the data window remains at the top of the screen. If the data window cannot
accommodate al the data items specified for it, the data window becomes scrollable.

When you enter the K, KH, KG, or KGH command for an array dataitem, the dimensions
are shown to allow you to change the entry being displayed.

When entering the line commands, you may use the n (number) operand to display one
data item in a statement containing multiple dataitems. Data items are assigned relative
numbers from left to right on the line, and the number entered represents the relative
number of the dataitem to be displayed. For example, the line command K 2 opens adata
window containing the second dataitem on the line.

When you enter another keep command, the new data items are added at the end of the
existing data window. When you enter another K, KH, KG, or KGH line command for
the same statement, the information for those data items is added at the end of the data
window.

The datawindow contains the definition and value of the dataitem. Alphanumeric values
are shown in character format and numeric values are shown in decimal format with
leading zeroes suppressed. If the length of the dataitem is greater than fifty bytes,
additional lines are displayed with +50, +100, +150 and so on preceding them.

For example, the primary command KG COMPARISON_KEY S displaysthe levels,
values, and addresses of the dataitem COMPARISON_KEY S and its subordinate data
items.

When no longer needed, the data window may be removed or individual data items may
be removed from the data window.

Removing Individual Data Items From a Data Window

Use the D line command to remove dataitems from the data window.

Removing the Data Window
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Use View - Reset Request pop-up or the RESET KEEP primary command to close the
data window.
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Changing Test Session Data Values

SmartTest allows you to change data values during a test session to perform these
functions:

<  Modify theresults of calculations.
«  Alter the execution path by changing the value of counters and/or switches.
<  Test error handling code by forcing bad data.

=  Correct the data exceptions that are encountered.

Y ou may ater data values by typing over the value displayed in any datawindow. The
new values take effect immediately. The value(s) shown in the data window is always
current and changes as the program executes.

Program Execution History (Backtrack)

SmartTest provides the Backtrack Facility to alow you to step backward and forward
through the executed code and view data values as they existed when each statement was
executed. Y ou may view the execution history using the Backtrack Facility any time
execution of the program is suspended.

The Backtrack Facility has two distinct modes—recording and reviewing.

Recording Execution History

Enter the SET BACKTRACK primary command (abbreviated SET BA) to toggle the
Backtrack Recording mode ON or OFF.

The Backtrack Facility recording mode can be turned on or off whenever an active test
session is suspended—at entry to the program, a breakpoint, an address stop, or an ATTN
key. Toggling the Backtrack Recording mode OFF causes the recorded history to be
discarded.

When atest is canceled using the CANCEL command or reaches END OF TEST,
Backtrack Recording mode is automatically turned OFF and the Backtrack recorded
history is discarded. The Backtrack Recording facility is OFF by default when
SmartTest-PLI is entered.

The SET BACKTRACK primary command may also include the desired size of the
Backtrack Recording memory buffer where dataiis collected (e.g., SET BACKTRACK
2M for a2 MB buffer). Thisbuffer isin memory with adefault size of 1 MB (100 KB for
CICS). The buffer size affects how much statement execution history is available to the
Backtrack Review facility.
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After setting Backtrack mode on, continue the active test using the normal RUN or STEP
primary commands. When the test execution is suspended by an error condition, a
breakpoint, an address stop, an ATTN key, or the end of the program, you can review the
Backtrack history as desired.

Note:
Y ou cannot run NOMONITOR when the Backtrack mode is ON.

Reviewing Execution History

After turning Backtrack Recording Mode ON and executing the program until a
breakpoint is encountered, you can review Backtrack history using either of these two
methods:

- Enter the Backtrack Review mode using the Run or Step function. See "Example
Backtrack Review Session” on page 148 for more information.

- Usethe LIST BACKTRACK primary command (abbreviated LI BA) to display
statements that modified a selected variable. See "Using the BackTrack Variable
History Function" on page 154 for more information.

In Backtrack Review maode, the Program View status box shows the direction—forward or
backward-of program execution history review. While in Backtrack Review mode, you
can open datawindows (Zoom or Keep) to view the contents of data fields at the time of
execution of any statement.

Example Backtrack Review Session
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Note:

Before executing this example, type RESET PSEUDO to ensure all breakpoints and
pseudo code statements are del eted.

In this example from the VIAPPLI program provided with SmartTest-PLI, assume that
the program being tested abends with a data exception (0C7) on the field
DATA_PACKED_DEC. Backtrack Recording mode is ON. Asthe starting point of your
investigation, you need to locate statements that have modified the value of
DATA_PACKED_DEC.
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To locate the most recent statement that modified DATA PACKED_DEC using
Backtrack execution history

1  Select Test » Run and press Enter. The Test - Run Request (Backtrack Recording
Mode Active) pop-up, shown in Figure 90, displays.

Figure90 e« Test - Run Request (Backtrack Recording M ode Active) Pop-up

Test - Run Request [Backtrack Review Hode Active)

Enter a Direction, if needed, and fill in the appropriate "Run To"
option. Then press Enter.

Direction [Default is current direction)
_— 1. Forvard

2. Backward

Run To ...
T, BEors® . ... _ Top, Botton or current stut-edit review
Line Mumber . . . ______

Hodified Data Nane

The Test - Run Request pop-up has changed because Backtrack Recording modeis
active.

2  Enter BackTrack Review mode and initiate a search backward through BackTrack
execution history for the last statement that modified DATA_PACKED_DEC using
these steps:

a Select Backward in the Direction field.
b  TypeDATA_PACKED_DEC inthe Runto Data Name field and press Enter.

The BackTrack execution history on the Program View screen, shown in
Figure 91 on page 150, displays.
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The Program View screen is positioned to the most recent statement in this test
session that modified the field DATA_PACKED_DEC, indicated by the tag
BKTR=>. Thisis also the statement that caused the 0C7 abend.

Figure91« Reviewing Backtrack History of a Modified Data Item

File View Test Search List Options Help

Program View VIAPPLI.VIAPPLI1 -A
Command ===> Scroll ===> CSR
(A)481
BKTR=>  DATA_PACKED_DEC = DATA_PACKED_DEC + 1;
000483
000505  SOC7FIX1:
000506 RETURN;
000507
000508 END SOC7_DEMO;
000509
000510
000511 /* PAUSE HERE */
000512
000513 NOSOURCE_DEMO: PROC;
Fommm - (B)—m—mm - ©)--+
|STATUS: * REVIEWING BACKTRACK HISTORY * PROGRAM: VIAPPLI1 DIRECTION: BWD |
] STMT: 000482 OFF: 000C10 AMODE: 24 MODULE: VIAPPLI SEQ# -2682 |
] SOURCE: DATA_PACKED_DEC = DATA_PACKED_DEC + 1; 10]
A o e

(A) BKTR=> Points to the most recent statement that modified the data

field DATA_PACKED_DEC.

(B) * REVIEWING Indicates the test session isin Backtrack review mode.
BACKTRACK
HISTORY *

C) BWD Indicatesthe direction of the Backtrack History review and
y
-2682 indicates the program review is 2682 statements
from the bottom of the Backtrack history.

3 Repeat step 1 on page 149 and step 2 on page 149 to find the next most recent
statement that modified DATA_PACKED_DEC, aBASED variable.

Asan option, you can type RUN BACK TO DATA PACKED_DEC MOD inthe
primary command area.
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To continue your investigation into the 0C7 abend, open a Zoom data window to
display the value of the data field before it was modified by typing ZD over the tag
BKTR=> in the line command area and pressing Enter. The Program View screen,

shown in Figure 92, displays.

Figure 92 « Data Value Before Execution of the Statement

File View Test Search List Options Help

Command ===>

VIAPPLI.VIAPPLI1 -A
Scroll ===> CSR

000479

SOC7_CHAR = " *;

| SOC7_CHAR BASED CHAR(8)

|  VALUE > ._...... <

| 03 DATA_PACKED_DEC DEC FIX (15,0)
""" | VALUE > +0 <

000481
000482  DATA_PACKED_DEC = DATA_PACKED_DEC + 1;

------ | 03 DATA_PACKED_DEC DEC FIX (15,0)
------ |  VALUE > +0 <

|SOURCE: SOC7_CHAR = " *;

|STATUS: * REVIEWING BACKTRACK HISTORY * PROGRAM: VIAPPLI1 DIRECTION: BWD |
] STMT: 000480 OFF: 000CO6 AMODE: 31 MODULE: VIAPPLI

SEQ# -2 |

Figure 92 shows an opened Zoom data window displaying the value of the datafield
before it was modified by the assignment statement containing the BASED variable.

Select Test P Step and press Enter. The Test - Step Request (Backtrack Review

Mode) pop-up, shown in Figure 93, displays.

To view the results of the execution of the assignment statement

Figure93e« Test - Step Request (Backtrack Review Mode Active) Pop-up

Test - $tep Request [Backtrack Review Hode)

felect Step type, Direction, or %tep Options, as neaded.
Then press Entar.

Etep wus
1. to nedt STATEHENT [Default]
2. to nedt ParagraphelLabel

—_

Direction [Default is current direction]
1. Forvard
2. Eackward

Etep Options:
Etep Count Enter 1 to BS535 (980 if Auta)
tep Auto Enter non-blank to select
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2  OntheTest - Step Request (Backtrack Review Mode) pop-up, select Forward in the
Direction field and press Enter. The Program View screen, shown in Figure 94,
displays. Asan option, you cantype STEP FORWARD in the primary command area.

Figure 94 « Data Value after Execution of the Statement

File View Test Search List Options Help
Program View VIAPPLI _VIAPPLI1 -A

Command ===> Scroll ===> CSR
000479
000480  SOC7_CHAR = * *;

""" S U |
""" | SOC7_CHAR BASED CHAR(8) |
""" | VALUE > < I
""" | 03 DATA_PACKED_DEC DEC FIX (15,0) |
""" ] VALUE > < * INVALID NUMERIC * |
...... e Ty
000481

BKTR=> DATA_PACKED_DEC = DATA_PACKED_DEC + 1;

""" e e et
""" | 03 DATA_PACKED_DEC DEC FIX (15,0) |
""" ] VALUE > < * INVALID NUMERIC * |
...... e Ty
U St +
|STATUS: * REVIEWING BACKTRACK HISTORY * PROGRAM: VIAPPLI1 DIRECTION: FWD |
] STMT: 000482 OFF: 000C10 AMODE: 31 MODULE: VIAPPLI SEQ# -1

] SOURCE: DATA_PACKED_DEC = DATA_PACKED_DEC + 1; 10]
A e +

Figure 95 displays the value of the data field in the Zoom data window after the
assignment statement containing the BASED variable was executed.

To end the Backtrack review mode and resume program execution
1  Select Test » Runto display the Test - Run Request pop-up.

2  Select Forwardinthe Direction field and specify * inthe Run Tofield. Asan option,
you can enter the command RUN TO *.

Figure 95+« Resuming Program Execution

File View Test Search List Options Help

Program View VIAPPLI .VIAPPLI1
Command ===> Scroll ===> CSR
ASG2429W BOTTOM OF BACKTRACK HISTORY. BACKTRACK REVIEW EXITED.(A)
001228
001229 FIND_NEXT_PARAMETER: PROC;
001230

001231 SUB1 = SUB1 + 1;
001232 IF SUB1 > VALID_PARMS_COUNT THEN
001233 DO;

001234 IF VALID_PARM_TEXT (SUB1) = " " THEN

001235 DO;

<<<<<< CURRENT_PARM_NUMBER = VALID_PARM_NUMB (SUB1);

001237 DAT1 = = DEMONSTRATION OF: *;

001238 DAT2 = VALID_PARM_TEXT (SUB1);

001239 DISPLAY_AREA_LENGTH = 80;

001240 PUT SKIP EDIT(DAT1,DAT2) (A):

001246 SUB1 = VALID_PARMS_COUNT;

001247 END;

001248 END;

001249 END FIND_NEXT_PARAMETER;
ey +
ISTATUS: BREAK ON ENTRY TO A PROGRAM  PROGRAM: IEFBR14 BACKTRACK: |
| STMT: N/A  OFF: 000000 AMODE: 24 MODULE: IEFBR14 (B) RECORDING I
[SOURCE: SR R15,R15 HEX: 1BFF I
A
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This table describes the sections of the Program View screen:

(A) ASG2429BOTTOM OF The long message indicates Backtrack history

BACKTRACK review mode has ended.

(B) RECORDING Indicates the Backtrack facility isin recording
mode.

(C) Program View Positioned at the last statement executed before

Backtrack history was reviewed.

To continue your test session, use the RUN or STEP command. A Program View
screen similar to the one shown in Figure 96 displays.

Figure 96 « Recording Backtrack History to End of Test Session

File View Test Search List Options Help

Program View TEST ENDED, RC=0
Command ===> Scroll ===> CSR
000344
>>>>>> RETURN; /* GOBACK TO OPERATING SYSTEM */
000346
000364 PROGRAM_INIT: PROC;
000365

000366  /* DEFAULT TO EXECUTION FAILURE  */

000367  /* BUG */

000368 /* CALL GET_TIME_OF DAY; */

000369 /* MOVE TIME_OF DAY_WORK TO TIME_OF DAY START; */

000370

000371 RETURN_CODE = -1;

000372

000373  /* INITIALIZE WORKING STORAGE VALUES */
000374

000375  DATA_PACKED_DEC = 0;
000376  DATA_DISPLAY_DEC = 0;

g +
|STATUS: BREAK AT END OF TEST SESSION PROGRAM: VIAPPLI1 BACKTRACK: |
] STMT: 000345 OFF: 000386 AMODE: 31 MODULE: VIAPPLI RECORDING |
] SOURCE: RETURN; /* GOBACK TO OPERATING SYSTEM */ |
A

The program executes to completion and is suspended at the end of the test session.
At this point in the program, you can either review the Backtrack history or end the
test session.

End thetest session and discard the Backtrack history by typing RUN inthe command
input area and pressing Enter.
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Using the BackTrack Variable History Function

To review BackTrack execution history using the LIST BACKTRACK primary
command

1  TypeLIST BACKTRACK to display the List - BackTrack Variable History pop-up
shown in Figure 97.

Figure97 e« List - BackTrack Variable History Pop-up

List - BackTrack Uariable Histary
Tupe a fullw qualified data naWe with any applicable subscripts
in the Target area. For & list of data naWes, type a “pattern”
in the Target area. Then press Enter.

Target

2 Enter a dataname to search the BackTrack execution history for statements that
modified the specified dataitem. Y ou can enter a pattern to select from alist of
datanames.

3  PressEnter to display the List - BackTrack Variable History pop-up, shown in
Figure 98, displays showing the statements that modified the selected data item.

Figure98e List - Backtrack Variable History Screen

List - BackTrack Uariakle History WIAZUEITVIASUEIT —-A

CoHHand ===k _ Ecroll ===k GER
Uariablel COHPARIZON-CODE Desci PIC @
IndaH:
% RELHOD LALUE LINE  STATEHENT CONTEMTS
TOP OF DATA
UIAHRG3T . VIARRGST
_ -3 . HOEL 5T HOVE ZEROE TO COHPARI Z0N-KEY-1, COHF
UIASUEZY . VIASUEST
_ -2 u HREDIE HOUE 1 TO COHMPARIZON-CODE
-11 BAA0IS HOVE 1 T COHPARIZON-CODE
01 EEE ] {CURRENT UALUE OF VARIABLEX

EOTTOH OF DATA

+

STATUED STOPPED AFTER ERERK PROGRAA: VIAZUEI? EBACKTRACK:
ZTHTC ©09a2I OFF. ada23d AHODED 31 HODULE: UIRZUEIT RECORDING

SOURCES IF INFILEA-COMPARIZON-KEY HWOT EQUAL EOF-KEY

+

TheList - BackTrack Variable History screen lists the statements that modified the
selected dataitem. Y ou may view a statement in the program source by selecting the
statement and pressing Enter.

Y ou can review other statements in BackTrack execution history by typing LIST
BACKTRACK and repeating step 1 through step 3.
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After completing your review of the selected statements, you may continue the test by
pressing PF3/PF15 on the List - BackTrack Variable History screen or by entering the
RUN TO * primary command on the Program View screen.

Using Pseudo Code

SmartTest provides pseudo code to alow you to interactively modify a program during a
test session to test proposed changes without recompiling the program.

Pseudo Code Concepts

SmartTest-PLI provides COBOL-compatible statements called pseudo code. Y ou can
enter these statementsinline with existing PL/I source code. Inserted code can change the
execution sequence of the program or temporarily fix a data problem.

Enter pseudo code statements directly into the source code of aprogram displayed in
Program View. Each pseudo code statement is associated with the executable source
statement following it. Multiple pseudo code statements associated with an executable
source statement form a pseudo code block. Pseudo code statements follow standard
COBOL syntax rules.

The Pseudo Code List screen displays al pseudo code for the program currently in
Program View. Pseudo code remains active until deactivated or deleted (see “Viewing
Pseudo Codein a Test Session” on page 159 and " Removing Pseudo Code from a
Program” on page 159).

Y ou can save pseudo code with any program stored on the AKR.

Note:

For setup options on automatically saving pseudo code, see” SmartTest User Options' on
page 18.
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Pseudo Code Statements Available

156

These are the available pseudo code statements and operands:

ADD

Addsthe value contained in or represented by thefirst operand to the
value contained in or represented by the second operand. Thevalueis
converted to the proper format for the specified dataitem.

BREAK

Forces a breakpoint before a specific statement. A pseudo code
BREAK statement causes an unconditional interrupt in the program
execution.

GOTO

Transfers control to the statement containing the specified PL/I
procedure name, pseudo code label, or line number.

IF/THEN/ELSE

Tests conditional expressions. Nested | F statements are supported.
Supported condition tests include Relation, Class, and Sign.

MOVE

Assigns the value contained in or represented by the first operand to
the area represented by the second operand. Thevalueis converted to
the proper format for the specified dataitem, if possible. If the value
cannot be converted to the proper format, program execution stops
and an error message displays.

SUBTRACT

Subtracts the value contained in or represented by the first operand
from the value contained in or represented by the second operand. The
valueis converted to the proper format for the specified data item.

WHEN

Tests conditional expressions in the same manner as COBOL
conditional expressions. Use of the WHEN statement causes the test
to be performed after the execution of every instruction that modifies
data.

Note:
Processing WHEN statements is resource intensive. Use sparingly.

pslabel

Defines a pseudo code paragraph name. These names are entered in
Area A and are used by GO TO pseudo code statements. A pseudo
code label can consist of one to thirty alphanumeric characters, the
first being al phabetic. The specified name cannot be an existing |abel
name. Pseudo code labels cannot be defined in WHEN statements.
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77

Definesapseudo code dataitem. These dataitemsare entered in Area
A. Each 77 level dataname must be unique and cannot be qualified. 77
level data definitions can be entered anywhere within the code.
Pseudo code data items must be defined before being referenced and
cannot be defined in WHEN commands.

& COUNT

Indicates the number of times each pseudo code statement has been
executed. & COUNT isuseful in tests for specifying alternative logic
based onitsvalue. Thevalue of & COUNT isautomatically initialized
to zero and incremented before the corresponding verb is executed.
& COUNT can be referenced as required in any pseudo code
statement, but cannot be modified (e.g., MOVE 2 TO & COUNT is
invalid).

COBOL Reserved Words in Pseudo Code

Many standard COBOL reserved words can be used in pseudo code. These reserved
words are used in pseudo code statements in the same manner they are used in standard
COBOL programs. SmartTest supports these COBOL reserved words in pseudo code:

ALL ELSE PIC
ALPHABETIC EQUAL PICTURE
COMP FROM POSITIVE
COMP-1 GREATER SPACE
COMP-2 IS SPACES
COMP-3 LESS THAN
COMP-4 LOW-VALUE THEN
COMPUTATIONAL LOW-VALUES TO
COMPUTATIONAL-1 NEGATIVE USAGE
COMPUTATIONAL-2 NEXT SENTENCE ZERO
COMPUTATIONAL-3 NOT ZEROS
COMPUTATIONAL-4 NUMERIC ZEROES

These symbols can be used in conditional pseudo code statements:

equals
lessthan
greater than

vV A
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Using PL/I Datanames in Pseudo Code

These statements apply when using PL/I datanames in pseudo code:

<  New datanames must be defined using a COBOL 77 statement using COBOL
syntax.

- PL/I datanames defined in the program can be used in pseudo code statements.

- Non-unique elements of a PL/I structure can be coded using COBOL or PL/I
syntax. For example:

DCL 1 REC 1,

05 A CHAR (1) INIT (FA" );
DCL 1 REC 2,

05 A CHAR (1) INIT (* ™);
MOVE A OF REC_1 TO A OF REC_2.
Or

MOVE REC_1.A to REC_2.A.

Using Constants in Pseudo Code

Pseudo code statements can contain numeric and non-numeric literals. If the data element
being tested is a character field (non-numeric), the second operand in the pseudo code
statement must be in quotes. For example:

IF OUT_CNT_4 = "001" THEN BREAK.

If the data element being tested isadecimal field (numeric), then the second operand in a
pseudo code statement does not need to be in quotes or zero padded. For example:

IF OUT_CNT_3 = 1 THEN BREAK.

Entering and Editing Pseudo Code
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Y ou can enter pseudo code statements with existing PL/l source code on the Program
View screen. During atest session, pseudo code statements can be entered whenever
program execution is suspended. Pseudo code statements are written in standard COBOL
format.

The C (copy), D (delete), | (insert), M (move), and R (repeat) line commands are
availablefor entering and editing pseudo code statements in a program. These commands
operate in the same manner as in TSO/ISPF, including block format.
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Executing Pseudo Code in a Test Session

Pseudo code is executed asif it is part of the program logic when a RUN or STEP
command is issued.

Each pseudo code statement is associated with the source statement following it and is
executed before that statement. For example, at a breakpoint, execution is suspended and
the chevrons are positioned in the line number area of the next logic statement to be
executed. If ablock of pseudo code isinserted immediately prior to this statement, the
RUN or STEP action starts executing with the first pseudo code statement in the inserted
block.

SmartTest checks syntax of pseudo code statements when a command is entered
referencing a pseudo code statement or variable and when saving the pseudo code to the
AKR. The SmartTest-PLI commands that reference pseudo code are RUN, STEP,
ZOOM commands, LIST BREAKS, LIST PSEUDO, LIST WHENS, LPRINT PSEUDO,
and QUALIFY.

Pseudo code statements with correct syntax are executed as part of the program logic.
When a pseudo code statement causing a program execution error is encountered, the

current test isinterrupted and an error message displays. Correct the pseudo code and
resume the test session.

Viewing Pseudo Code in a Test Session

To display the Pseudo Code List screen showing all pseudo code for the program
currently in Program View, follow this step:

» Select List » Pseudo code or type LIST PSEUDO.

Y ou can activate and deactivate pseudo code statementsindividually or globally using the
Pseudo Code List screen.

Removing Pseudo Code from a Program

Y ou can remove pseudo code from a program individually or globally.

Removing Individual Lines of Pseudo Code

Use the D line command to delete individual lines of pseudo code from a program. This
command operates in the same manner as the D (delete) line command in TSO/I SPF,
including block format.

Removing All Pseudo Code
To delete all pseudo code (including breakpoints) from a program, follow this step:

P Select View » Reset or type RESET PSEUDO.
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Making Proposed Changes Permanent

Pseudo code provides a means of testing proposed changes to the program without
recompiling. Permanent changes to the source code must be completed using the source
code editor at your site. SmartTest does allow split screen sessions under | SPF so you can
view pseudo code statements at the same time you are editing.

Note:

If you edit your program, you need to reanalyze the updated program so SmartTest-PLI
includes the changes in the next test session.

Using Multiple Programs
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SmartTest-PLI provides the ability to view programs other than the one being tested
without cancelling the active test. This processis called qualification.

To display aprogram (other than the program being tested) in Program View, follow this
step:

» Select File» Open or type QUALIFY.

Programsresiding in the AKR are displayed in source code format. Programs not stored
on the AKR are displayed in disassembled object code. Several programs may be
gualified for viewing simultaneously.

The program currently being tested remains the active program. If a STEP, RUN, GO, or
CANCEL primary command isissued, it is executed for the active program being tested,
not the program being viewed; and the status box changes to indicate the status of the
active program being tested. All other commands are performed on the displayed
program.

The QUALIFY * primary command is used to redisplay the active program.

The CANCEL operand is used to remove the program being viewed from qualification
for viewing.

These are some examples of the QUALIFY primary command:

QUALIFY loadmod.program Brings a program from a different load module
into Program View.

QUALIFY CANCEL ALL Removes all programs from qualification and
exits Program View.
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Tailoring a Test Session by Program

The Test Session Tailoring screen is used to turn SmartTest features selectively ON or
OFF for a set of modules and/or programs. This screen displays using one of these
methods:

- Selecting TAILOR on the Test Facilities List screen

- Entering the LIST TAILOR command on any SmartTest screen

=  Selecting List » Test session tailoring

Session tailoring can reduce the execution time for atest by specifying options at the

individual program level. For example, you can set Break on Entry as NO for programs
that have already been verified, to avoid stopping at the entry point.

An exampleinput line is provided on the first data line displayed, to indicate how to
specify information for a program. The | (insert), R (repeat), and D (delete) line
commands can be used when editing the list of programs. Block forms of these
commands are not supported.

For details of the Test Session Tailoring screen shown in Figure 99, see the
ASG-SmartTest Reference Guide.

Figure 99« Example Test Session Tailoring Screen

Test Zession Tailoring UIAPPLI.UIAPFLILI -A
CoMHand === Ecroll ===} GER
Honitor Track Count Break Break Break Pseudo Single
Hodule.Prograd id Act Act Act Act Entry Rtn Act step
Hetokek: TOF OF DATA
** UIAPPLI.WIAPPLIL YES YEE YEE YEE YEE N0 YES YES
' VIAPPLZ.VIAPPLZ1 YEZ YEZ MO YEZ YEZ Ha YES YEZ
Hetebot BOTTOR OF DATAH
Note:

For PL/I programs, the program name specified on the Test Session Tailoring screen
must be the PL/I compiler generated name.

Capturing and Replaying Test Sessions

SmartTest provides a Script facility for the capture and replay of primary command
sequences. The captured commands are saved in afile that may be replayed to execute
the recorded primary commands multiple times. Script files can be used to initialize a
session, set default data values, insert breakpoints, open data windows, or perform other
tasks that can be accomplished using primary commands.
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SmartTest assigns a dataname for the script dataset and displaysit in the long message
areawhen the SET SCRIPT ON primary command isissued. The Script facility allocates
and opens a dataset to record all SmartTest primary commands as they are entered. To
stop recording the primary commands and close the script file, issue the SET SCRIPT
OFF primary command. Record the generated dataset name for specification when the
script file playback is requested.

Script files are sequential datasets or members of partitioned datasets. Script files can be
used to initialize a session, set default values, set up a session, execute or re-execute a
session, or execute a predefined command sequence. The name of the dataset displays
when the dataset is opened or closed. The script file nameisin this format:

USERID.STTnnnnn.VIASCRIP

where nnnnn is anumber beginning with 00001 that isincremented by 1 for each new
script file. Once the dataset is closed, it can be used as an input dataset name with the
EXECUTE command.

Note:

If aTSO prefix isnot set to the user 1D, the prefix is added to the beginning of the dataset
name.

Y ou can include commentsin script files by typing an asterisk (*) in the first column of
the command by the comment text.

Note:
Actions executed using CUA and line commands are not recorded in the script file.

For information on the Script related primary commands, see the ASG-SmartTest
Reference Guide.

Replaying a Script File
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Use the Execute facility to replay a primary command sequence stored in a script file.

The Execute facility reads and executes a script file. Each script file can contain
EXECUTE commands that execute nested script files. Script files creating loops are
recognized and an error message displays.
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To execute a script file

1  Select File » Execute and press Enter. The File - Execute Script pop-up, shown in
Figure 100, displays.

Figure 100« File- Execute Script Pop-up

File - EMecute =cript
Ta edecute 5 script file, type a Data 3ot Made, & Data fet MaWe with a
Herber naHe, or just a Aedber name in parentheses. HNelt specify any
desired Options. Then press Enter.

Data et MName

options
_ 1. =TEP
2. REZUHE

2  Enter the name of the script filein the Data Set Name field and press Enter.

Note:

Select the STEP option to invoke the debug option that allows stepping through each
primary command in the script file. Each primary command in the script file displaysin
the primary command input area. The displayed primary command can be changed or
erased from the primary command input area. Press Enter to execute the displayed
primary command. Processing of the script file continues in this manner until all primary
commands have been displayed and/or executed.

While stepping through the script file, select the RESUME option to execute the
remaining script file primary commands without stepping through each primary
command.

For more information on the Execute facility or the EXECUTE primary command, see
the ASG-SmartTest Reference Guide.

Position the Display at the Next Executable Statement

Usethe LOCATE * primary command during atest session to position the display at the
next statement to be executed. The next executable statement is denoted by the chevrons
(>>>>>>).

During atest session, chevrons are placed in the line number area of the Program View
screen to indicate the next statement to be executed. If the display has been scrolled and
the chevrons are not visible, the LOCATE * command positions the display to the
statement containing the chevrons.
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This command may only be used from the Program View screen during an active test
session.

This command can be abbreviated as L *.

Saving Keystrokes

SmartTest provides several ways to reduce the number of keystrokes needed to enter
commands.

Token/Cursor Substitution

When entering commands, use the Cursor Substitution character while in the Program
View screen to bypass typing datanames and label names as command targets.

Search commands allow you to type the Cursor Substitution character (default %) in
place of adataname or label name. After entering the command with the Cursor
Substitution character, place the cursor on the name in the source to be used as the target.
When the command is processed, the substitution character is replaced with the name
from the cursor location.

For example, the primary command FX % finds the statements that contain the text
located at the current cursor position. Place the cursor on the item before pressing Enter.

Y ou may substitute multiple tokens (e.g., qualified datanames such asMYDATA OR
MY STRUCTURE) by specifying multiple cursor substitution characters, each separated
by a blank. When substituting multiple tokens, the tokens must be contiguousin the
source code.

Substituting Short Names for Character Strings
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Use the EQUATE primary command to define a substitute name for any character string.

Equated names are used in the same manner any dataname is used. They can be saved in

the AKR and may be viewed on the Equates List by issuing the LIST EQUATES primary
command.

To delete an equate, type EQUATE using the equate name without any other operands.
This command may be abbreviated as EQ.

For example, the primary command EQUATE FILESHOW_MANY _FILES READ
assigns a substitution short name (FILES) to along field name
(HOW_MANY_FILES READ). The primary command FX FILES searches for
occurrences of HOW_MANY _FILES READ.
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Retain Commands in the Command Input Area

Usethe & (Retain) primary command in conjunction with any other primary command to
reuse the command specified.

The & command is useful when the same primary command isto be executed repeatedly,
or if minor changes to acommand are desired. It removes the necessity of re-entering the
entire command.

For example, the primary command & FX END_FILE_COUNT executesa FINDXTND
command targeting field references and leaves the command displayed in the command
input area. Y ou can type over the dataname field name to execute the FINDXTND
command for another field.

Recall Commands, Messages, and Pop-ups

Usethe RECALL primary command to display previous primary commands, long
messages, or pop-ups. The PF12/PF24 keys are assigned by default for the RECALL
command.

The last 20 primary commands and the last 20 long messages are stacked in arecall
buffer and may be displayed using the RECALL primary command. When the command
or pop-up displays, it may be executed again with or without modification.

Use the MESSAGE operand to display previous messages. The NEXT operand can be
used to move forward rather than backward through the stack.

Once the RECALL command has been entered with operands, subsequent RECALL
commands with no operand use the last operand entered until a different operand is
specified or another command is executed.

When the RECALL function has processed the entire command or message stack, further
RECALL commands process the stack again.

For example, the primary command RECALL MSG displays the last messagein the long
message area. The primary command RECALL POPUP displays the last pop-up

displayed.

165



ASG-SmartTest PLI User’s Guide

These commands are not stacked for use by the RECALL command:

ANALYZE RIGHT
RECALL PLOG
PLIST KEYS
UPDATE RETURN
REDO REPEAT
PRODLVL DOWN
RSCROLL RFIND
RHIGH RESET
LEFT END
HELP UP

View Release and Level Numbers

Use the PRODLVL primary command to display the current SmartTest product level.

The PRODLVL command displays the product name, operating system, product release
number, and release level on the message line, in this format:

ASG15541 ASG-SMARTTEST-0S(390) Rn.n AT Lnnn, ASG-CENTER Rn.n AT Lnnn
where:

Rn.n isthe release number.

Lnnn istherelease level.

Thisinformation is requested if you need to contact ASG Customer Support for
assistance.

Linking to Alliance

If Allianceisinstalled, SmartTest provides adynamic link to it that can be used to display
program analysisinformation. SmartTest automatically runs script queries appropriate for
the current execution environment upon entry to Alliance.
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Prior to establishing the link, a complete Alliance application analyze must be done for
the program you wish to processin Alliance. The Alliance application analyze must
include the load module libraries and execution JCL. Also, you must copy the
VIAPALSC and VIAPQ* members from the ESW CNTL library into a user-defined PDS
and appropriately customize them for your needs.

To link with Alliance

1  Seect Script file allocations from the Options menu on the SmartTest primary
screen, as shown in Figure 101.

Figure 101+ Selecting the Script File Allocation Menu |tem

File Uiew Test =earch Logic List Options Help

ASE-3Hart « Product paraneters...

. Product allecations...

. Log-list-punch...

. BCRipt file allocations...
. PF kewsz...

. Hodes...

. fcratchpad...

CodHand ===

=1 P ke

Atttk Atttk Hetetebtek Hetslelk Eood
Aotttk Aotttk Eos s s L Aotk

Copwright ALlen $wstens Group, Inc., an unpublished work.
A proprietary product of ASG, Inc. Use restricted to authorized licensees.
Vigit the AG Support Web Site at wuw.asg.coH

The Options - Script File Allocations pop-up displays.

2 Onthe Options - Script File Allocations pop-up, enter the name of the user-defined
PDS containing the VIAPALSC and VIAPQ* members. The Options - Script File
Allocations pop-up, shown in Figure 102, displays.

Figure 102« Options- Script File Allocations Pop-up

gptions - Zcript File Allocations
CoHHand ===}

R — Restore default script allocations
Enter desired Zcript file concatenation.

cript file data set names:
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3  Exittothe SmartTest primary screen. On the command line, issue the ALLIANCE
command. The ASG-SmartTest/ASG-Alliance Interface pop-up, shown in

Figure 103, displays.

Figure 103+ SmartTest/Alliance I nterface Pop-up

ConHand ===

AEG-ERartTest-AZGE-Alliance Interface

Pleaze enter the following =

Prograd Nade .......

Alliance AKR.... . o gASG-EHartTest~<AZG-Alliance Interface.

Application Mame . . __________

guery HaHE..sseans UIAFQIHE

4  Complete thesefields:

Alliance AKR  Specifiesthe AKR containing the analysis information produced
by Alliance for the specified application and program.

Application Specifiesthe name of the application containing the program to be
Name processed in Alliance.

Program Name  Specifies the name of the program to be processed in Alliance.

Query Name  Specifies the name of the query script that SmartTest selected
from the PDS specified in the Options Script File Allocations
pop-up. Thisfield automatically containswiththe name of aquery
script appropriate for the current environment; however, you can
specify another.

5  PressEnter, verify the information, and press Enter again. The VIAPAL SC script
executes and runs the query listed in the SmartTest/Alliance Interface screen. A
series of screens flashes by, ending with an Alliance query display appropriate for
the load module, JCL, transactions, and current SmartTest execution environment.

6  TypeEND on the command lineto exit the query display. The Alliance primary
screen displays. Press PF3/PF15 to exit the Alliance primary screen and redisplay the

SmartTest primary screen.
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This chapter discusses analysis features of SmartTest-PLI and contains these sections:

The Intelligent Search Function 169
Excluding Lines from the Display 172
Searching for PL/I Program Information 173
Printing Program Information 177

The Intelligent Search Function

The SmartTest-PLI Intelligent Search Function uses built-in understanding of the PL/I
language. This function can be used to search the program for information about PL/I
statements, data variables, labels, and other program details. The search function
recognizes and bypasses COMMENT statements, unless specifically requested.

There are six primary commands in the Intelligent Search Function: BREAK,
EXCLUDE, FINDXTND, HIGH, LPRINT, and SCROLL.

Searching for PL/I Language Subsets

SmartTest-PLI classifies statements into subsets by grouping together PL/I statements of
asimilar nature. This table describes each of the PL/I subsets and corresponding entities:

Subset Description

Assignment Contains statements that assign a value to adata item, such as
A =B.

BLOcks Contains PROCEDURE, BEGIN block, and END statements.
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CAll Contains statementsrelated to subprogram callssuchasCALL and
FETCH.

CONditional Contains statements or parts of statements that conditionally
changetheflow of control inaprogram such as|F, THEN, EL SE,
and SELECT/WHEN.

DEFinition Contains declaratives of data variables.

ENDProcedure Contains statements containing an END PROC name.

ENtry Containsinternal entry points (PROCs) andall ENTRY statements
for external entry points.

EXEcutable Contains statements that are executable.

EXIt Contains statements containing a RETURN that returns control to
the calling PROC.

GOto Contains statements containing a GOTO statement or a
SELECT/WHEN structure.

INPUT Contains 10 statements (10, Input, or Output) including CALL

10 statements that are indicated as containing 10, Input, or Outpui.

Output

LABd Contains statements containing labels.

ONBIock Contains BEGIN block statements that are executed when an ON
condition is raised.

ONConditions Contains statements establishing ON conditions error handling.

PROcedure Contains PROC statements.

STORage Contains statements controlling program storage allocation.

STructure Contains agroup of subsets, which together help show the general
structure of the program.

TESted Identifies the lines of code that have been tested based on
information created and updated with TCA reports.

UNTested Identifies the lines of code that have not been tested based on

information created and updated with TCA reports.
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Many SmartTest-PLI commands can include one or more of these subsets. Y ou can
concatenate subsets by placing a plus sign (+) between them. For example, to highlight
the subset of lines containing 10 and PROC statements, typeHIGH 10 + PRO.

Screen Subsets

Tag Subset

These screen subsets generally are the result of an interactive command:
- Highlighted or HI

- NONHighlighted or NHI

- Excluded or X

- NONExcluded or NX

SmartTest-PLI uses atag subset to provide information about the source code. The tag
subset displaysin columns 73 through 80 on the Program View screen and shows results
of the program analyze as well as command execution.

TAGged or TAGS refersto al lines having informative tags on them. The tag subset can
be used in commands that accept subsets as targets.

When a subset is specified as the target of these commands, the entire program is
searched for all occurrences of statements associated with the subset. All information
pertaining to afunction can be presented with a single command.

Determining Impact of Change

Using the SIZE operand with the search function locates all datanames directly or
indirectly affected by achange in the size of the specified dataname. This resultsin a
complete list of all dataitems to be reviewed for a size change of the specified dataname.
By including the LEVELS operand, the indirect impact of a size change to a dataname
can be seen onelevel at atime.

Using the VALUE operand with the search function locates all occurrences of adataname
directly or indirectly affected by a change in the value of the specified dataname.

The search function can be limited through the use of command operands.

These operands limit the search function to include only these specified data item access
types: MOD, USE, and DEF. The default is REF and includes al dataname reference

types.
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The search function may be limited by using the direction operands NEXT and PREV to
start the search from the current position and locate the closest occurrence. The FIRST
and LAST operands present their respective reference to the dataname specified. ALL is
the search function default, with the exception of the BREAK command, where NEXT is
the default.

The scope of the search function can be limited to particular statement types through the
use of the IN clause.

Excluding Lines from the Display

To display only relevant information on the screen, you can remove extraneous
statements. Y ou can use the search function to suppressthe display of statements meeting
specified criteriaor al linesin Program View.

To invoke the search function to remove all lines meeting the criteria from the display,
follow this step:

P Select Test » Exclude or type EXCLUDE.

Use the Exclude action to remove specific lines or all lines from the screen. Lines can be
excluded from the display before or after other commands are issued. Excluded lines are
represented by shadow linesstatingn LINE(S) NOT DISPLAYED and aline of
dashes. Y ou can suppress the dashed line using the SET SHADOW command. For
example, typing EXCLUDE NHI or X NHI removes all non-highlighted lines from
Program View.

Displaying Individual Excluded Lines

Usethe F (First), H (Hidden), L (Last), and S (Show) line commands to display excluded
lines.

The F and S line commands are used to display a specified number of linesin ablock of
excluded lines, starting from the top of the block. The H or L line command is used to
display the last lines of ablock of excluded lines.

For example, the line command F2 displays the first two lines of an excluded block. The
line command L5 displays the last five lines of an excluded block.

Displaying All Excluded Lines
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Select Excluded lines on the View - Reset Request pop-up or use the RESET
EXCLUDED primary command to display al excluded lines without resetting any
current highlighting and tags.
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To display all excluded lines

1  Select View P Reset and press Enter. The View - Reset Request pop-up, shown in
Figure 104, displays.

Figure104 « View - Reset Request Pop-up

UView - Reset Request
To reset display features, select an Option. Then press Enter.

Reszet Options

ALl [Excluded lines, Highlighted lines, Tags, Hessages)
All Line=

Excluded Lines

Highlighted Lines

Tag CoMHents

Hassages

Label=s

Keep Mindows

ZooH Nindows

Pseudo Code [Including Breaks and Whens)
Ereaks

Vhens

| I T T T O O O Y R |

2  Type/ onthe Excluded linesfield and press Enter.

Searching for PL/I Program Information

The Intelligent Search function is used to locate statements that meet specified criteria.
This function can be used to display and highlight specific program information,
datanames, sets of lines, or patterns.

Use the Search pop-ups or the FINDXTND primary command to perform the search
function. Statements that meet the criteria are displayed and highlighted.

This function searches the program in source code sequence for occurrences of the
specified target. A target isthe object of a search and can be a set of lines, a dataname, or
apattern. Several target types and operands are available.

Use of aFINDXTND command resultsin all lines containing the specified target being
highlighted with the cursor positioned on the first target. If lines containing targets are
excluded from the screen, they are redisplayed. Targets highlighted as a result of a
previous command are reset, so only the results of the current FINDXTND command are
highlighted.

The FINDXTND primary command may be abbreviated as FINDX or FX.
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Take care when examining PL/I storage, as usage is controlled by the programmer.
SmartTest-PLI is unable to determine usage of adataitem and can only display the
contents based on the initial declaration. For example, a character string can be treated as
agroup of bit switches, but SmartTest-PLI attempts to treat the field as displayable
characters. To display the hex equivalent, use the hex features within SmartTest.

Pointer variables and offset variables, which are types of locator data, contain an address
of astorage location or an offset from an address. SmartTest displays both the actual
address contained in the locator and the contents of the field at that address.

PL/I classifiesvariables asinternal or external. The scope of the variable is determined by
this classification; therefore, SmartTest-PLI indicates that avariableis not availableif the
test execution location is outside the scope of the variable.

Finding All IO Statements in a Program
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This example demonstrates how to display only those statements in the program
containing Input and Output statements. The program must be displayed in Program
View.

To display only statements containing I nput and Output statements

1  Omital linesnot in the search using the SET XMODE ON command.

Note:
XMODE isatoggle and remains on until set to OFF.

2  Select Search » Subset and press Enter. The Search - Subset Name pop-up, shownin
Figure 105, displays.

Figure 105+« Search - Subset Name Pop-up

Fearch - fubszet MaWe

Type a subset naMe and select search options. Then press Enter.
For a selection list, type a pattern [e.q. ABCH) in the nane area.

Fubset nade

Direction DptinnS ACtion
1 1. Al _ IN-Clause... 1 1. Find
Z. Hent Z. Highlight
3. Preuious 3. Zcroll
4. First 4. Print
£, Last £, Punch
B

EHClude




3  Complete thesefields:
a  Type 10 inthe Subset namefield.
b  Select All inthe Direction field.
c Leave the Optionsfield blank.

d Select Find in the Action field.

4 Press Enter to display the Program View screen shown in Figure 106.

Figure 106 « Program View with Input and Output Sear ch Results

File Wiew Test Zearch List Options Help

Frograd Uiew
Conrand ===

13 EZTATEHENTZ FOUND

000476 EUT ZKIP EDIT(' ') [A):
ORR4TT ok BUE ke
OAR47S ok PUT SKIP EDIT[DISPLAY_AREA] [A]; *-

aaods®  END ZURHARY_ROUTIME:
+

000474 FUT ZKIP EDIT(' ') [A]:

000458 FUT ZKIP EDIT(' ') [A]:

000dE1 FUT ZKIP EDIT(' ') [A]:

0084E2 PUT SKIP

008453 EDIT(" UIA-SHARTTEST PL-I DEMOMSTRATION COMPLETED'] [A]}
000454 FUT ZKIP EDIT(' ') [A):

O0B4ES FUT SKIP

O0EdEE EDIT(" THAHE voU FOR YOUR PARTICIPATION'] [A]:
00457 FUT ZKIP EDIT(' ') [A);

O04ES

FOURCED BRZED_VAR = '=AC4° §
+

ETATUED # REVIEWIMNG EACKTRACK HIZTORY ®  PROGRAH: UIAPPLIA
ETHT: @0id®s  OFF: @03172 AHODE: 31 HODULES VIAPPLI

DIRECTIONZ EMD

To display the excluded lines

6 Analysis Features

1  Select View P Reset and press Enter. The View - Reset Request pop-up, shown in

Figure 107, displays.

Figure 107« View - Reset Request Pop-up

Uiew - Reset Request

Reset Options

All Lines
Excluded Lines
Highlighted Lines
Tag CoHHents
Hessages

Label=

Keep Mindows

ZooH Windows
Pseudo Code [Including Breaks and Whens)
Breaks

Whens

[ I T T T T I O O BN |

To reset display features, select an Option. Then press Enter.

ALl [Excluded lines, Highlighted lines, Tags, Hessages]
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2  Type/ inthe Excluded Linesfield and press Enter (see Figure 108).

Figure 108 « Program View Screen after Displaying All Excluded Lines

File View Test Search List Options Help
Program View VIAPPLI.VIAPPLI1 -A
Command ===> Scroll ===> CSR
>>>>>> CALL PROGRAM_INIT;
000298
000314  CALL PARM_EDIT; /* INITIAL PARM_EDIT */
000315
000316 IF PARM_TEXT = "EXIT" THEN
000317 RETURN;
000318  ELSE
000319 IF PARM_TEXT = "INVALID® THEN
000320 DO;
000321 CALL INVALID_PARM;
000322 RETURN;
000323 END;
000324
000325 IF CURRENT_PARM_NUMBER = +0 THEN
000326 CALL INVALID_PARM;
000327
Y N N A A +
| STATUS: BREAK AT START OF TEST SESSION PROGRAM: VIAPPLI1 DATE: DDMMMYYYY |
| STMT: 000297 OFF: 00029E AMODE: 31 MODULE: VIAPPLI TIME: HH:MM:SS |
| SOURCE: CALL PROGRAM_INIT;
A e

All lines that were excluded by the targeted search are displayed.

Example of Finding Data Field References

This example demonstrates how to display, tag, and highlight all program referencesto a
datafield. The program must be in Program View. XMODE is assumed to be ON.

To find data field references

1  Select Search » Data and press Enter. The Search - Data Name pop-up, shown in
Figure 109, displays.

Figure 109 « Search - Data Name Pop-up

fearch — Data Nawne

Tywpe a data nane and select search options. Then press Enter. For
a selection 1ist, enter a pattern [E.g. RECH] in the nane area.

Data naHe
References Indirect iWpact Eize change
1 1. All 1 1. Hone levels . . —
2. Defs 2. 0Of ziZze change
3. Uszes 3. 0f walue change
d. Hods
Directian options ACtion
i i. All _ Mo data aliasing i i. Find
2. Mext _ IN-Clausze... 2. Highlight
3. Previous 3. Ecroll
4. First 4. Print
5. Last 5. Punch
6. Exclude
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2  Complete thesefields:
a  TypeDATA_ PACKED_DEC inthe Data namefield.
b  Seect All inthe Referencesfield. Thisvalueisrequired.
c  Select All inthe Direction field.

Note:

The Indirect impact, Size change, Options, and Action fields are applicable for
COBOL environments. Specifying values in these fields can result in an error.

3 Press Enter to display the Program View screen shown in Figure 110.

Figure 110+ Program View with Data Item Information Search Result

File Ujew Tezt =zearch List Opltions Help

Prograd Liew UIAPPLI.VIAPPLIL -A

CoHHand === Ecroll ===F CER
TOF OF DATAH

------------------- 276 LINEEZ NOT DIEPLAYED
BEEZ2TT 18 DATA_PACKED_DEC FIXED DEC [15] INIT[123],
------------------- 22 LINEEZ NOT DIZPLAYED
L] ODCL 1 EZ8CY_CHAR CHAR[E] EBRZED[ADDR [DATA_PACKED_DEC] ]
------------------- 126 LINE:S NOT DISPLAYED
0aad27 DATA_PACKED_DES = o3
------------------- 118 LINEZ NOT DIEPLAYED
BRAS3S DATA_PACKED_DEC = DATA_PACKED_DEC + 1;

——————————————————— & LINEE MWOT DISPLAYED
BEESdT * 11 OVERTYFE THE WALUE OF ' DATA_PACKED_DEG' IN THE ZOOHDATF
——————————————————— 2 LINES NOT DISPLAYED

*

L * "SET DATA_PACKED_DEC TO &. [RUN’
------------------- @43 LINES NOT DISPLAYED
+ 1
ETATUED PROTECTION EXCERTION [0Cd] PROGRAA: UIAPPLIL DATED ©40CTZ2O00
ETHT. ©ald®s OFFD @031ve AHODED 31 HODULE: VIAPPLI TIHE: 18123155
F0URCE: EBASED_VAR = '"F0C4° 3 |1

+

Printing Program Information

To print program information, follow this step:

» Select Print on any appropriate Search pop-up or type LPRINT to invoke the search
function to copy one or all occurrences of the specified target to the List File.

The List File can be printed at any time using the Option - Log/List/Punch Definition
pop-up. For information on how to processthe List File, see”SmartTest User Options' on

page 18.

A printed copy of program information can be obtained by using the search function to
copy program source lines, meeting specified criteria, to the List File.

177



ASG-SmartTest PLI User’s Guide

For example, the primary command LPRINT COND copies all conditional statementsin
the program to the List File for subsequent printing. The primary command LPRINT *
resultsin the entire virtual screen (all dataviewed by scrolling forward and backward)
being copied to the List File. All excluded lines are copied to the List file as excluded
lines (as they appear on the screen at the time the LPRINT * command is entered).

You can use the LPRINT * command on these screens to copy them to the List file:

BackTrack Variable History Screen List - Equates pop-up

Breakpoints List screen List - Program/Subprogram Names pop-up
Execution Counts screen List - User Marks pop-up

Execution Tracking screen Pseudo Code List screen

List - CALL Statements pop-up When Conditions List screen

Scrolling the Display
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The search function can be used to position the display to a statement meeting specified
criteria.

Select Scroll on any appropriate Search pop-up or use the SCROLL command to invoke
the search function to position the display to the first line containing the specified target.
Highlighted lines remain unchanged.

The most common use of the SCROLL command is to move the display to the next
occurrence of information aready highlighted by a previous command.

For example, the primary command SC HI NEXT scrolls the display to the next
occurrence of information already displayed by the FINDXTND command.



7 Help Facility

This chapter discusses the types of help available with SmartTest-PLI and contains these

sections:
[ntroduction 179
Screen Help 181
Command Help 182
General Information 184
Specific Information 184
Help Abends 185
Help Messages 186
Printing M essages 188

Introduction

A comprehensive and context-sensitive Help facility, including an online Help Tutorial,
is provided that answers most questions online. The Help Tutorial contains help
information for several types of topics, such as pull-downs, screens, pop-ups, commands,
messages, and abends. The Help Tutorial also includes a Table of Contents that describes
each major SmartTest function, and a comprehensive Index for viewing specific
information.
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Y ou can access the SmartTest online help facility using any of the methods described in

thistable;

Screen and pop-up help Help for the current screen is requested by selecting

Help » Current screen. Help for the current screen or pop-up
displays by typing HELP, or by pressing PF1/PF13. No
message can appear on the screen at thetimethishelpis
requested.

Command help

Help for acommand is requested by selecting Help » Specific
command, or by typing the command in the command input
areaand pressing PF1/PF13. The HELP COMMANDS
command displays along message that lists most of the
primary commands. Once this message displays, pressing
PF1/PF13 displaysacompletelist of all SmartTest commands.
Thislist of commands can also be accessed by selecting

Help » All commands. From the list of commands,
information about a particular command can be displayed by
selecting the appropriate number.

Genera information

General help information is requested by selecting

Help » Table of contents, or typing TOC on any Help Tutorial
screen, to display the Help Table of Contents. Help
information can be viewed by pressing Enter or by selecting a
menu option.

Specific information

Help for specific topicsisrequested by selecting Help » Index,
selecting option 7 on the Help Table of Contents, or typing
INDEX fromwithinthe Help Tutorial. Help for aspecific topic
can be viewed by selecting the appropriate index entry.

System, ASG, and IMS
Abends

Help for abends is requested by selecting Help » Common
abends, or by typing HELP ABENDS. The Abends help screen
displays, which lists and describes the abends. Select one of
these options, depending on the type of abend:

1 displaysthe System Abends screen.
2 displaysthe ASG Abend Codes screen.
3, 4,5 displaysan IMS Abends screen.

Messages

Help for a current message displays by selecting

Help » Current message. Help for a short message, displayed
in the upper right corner of the screen, is requested by typing
HELP, or by pressing PFL/PF13. The corresponding long
message displays on the screen. Help for a specific message
can be displayed by selecting Help » Specific message, or by
typing HELP msg#.

180



7 Help Facility

Help Navigational Commands

All of the online help topicslisted in the previous table are contained in the Help Tutorial.
Each online help topic can be reached from anywhere within the Help Tutorial by going
through the Help Table of Contents or Index. Once the Help Tutorial is accessed, there
are several commands available for navigating within the Help Tutorial. These
commands are listed in this table.

BACK Redisplays the previous Help Tutorial screen.

END Exits the Help Tutorial.

Enter key Displays the next screen in a continuation series.

INDEX Displays the first screen of the Help Index.

SKIP Goes directly to the next subject.

TOC Displaysthe Help Table of Contents.

UP Displays the next higher-level subject.

Alpha character Displays the Index screen corresponding to that character

(valid only for index screens).

Screen Help

Help for the current screen is requested by selecting Help » Current screen. Help for the
current screen or pop-up displays by typing HELP, or by pressing PF1/PF13. If any
messages appear, help for the screen or pop-up displays by typing HELP SCREEN. The
Help Tutorial for the current screen displays.

The Help Tutorial for each screen or pop-up describes al the options available on that
screen, lists descriptions of al the fields, and notes any special processing considerations.
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Figure 111 showsthe Help Tutorial for the Options - Product Allocations pop-up.

Figure 111+ Pop-up Help Example

AZG-EWartTest - RY.0 - Options - Product Allocations ---—-———--—-—————-- HELF

The Options - Product Allacations pap-up i= used to specify the allocation
paraneters for the Log, List, Punch, and Wark files. Ta access this pop-up
froH the Options pull-down, select Allocation, or enter the ALLOCDEF coWAand
on any screen.

Mote: Hanagement Class, Storage Class, and Data Class provide various
paradaters for newly allocated datasets. These paraneters apply only if wou
hawve ZHE actiuve at our Site. vYour systed adeinistrator deterwines The valid
antrias for these paraHetsars.

The ftorage Class and VoluMe serial paradeters are Autually eHclusive.
Figld Descriptions

Loy File Zpecify aither the Hanagewent Class and Itorage Class ar the
Generic unit and voluWe serial nueber for the Log file
that is allocated upon entry into ASG-EHartTest. The Lag file
iz used for error Hessages and 1og comdands. File characteristics
are specified on the Options - Log<List<Punch Definition pop-up.

[Hore...press Enter to continue)
------ Cur panel = WSTALLD Prew panel = USTALLD Last nsg = ISRZ06Z -

Command Help
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Help for a specific command is requested by selecting Help » Specific command, typing
the command in the command input area and pressing PFL/PF13, or typing HELP
followed by the desired command name. A long message displays describing the
command. Pressing PF1/PF13 again displays the Help Tutorial screen for that command.
The Help Tutoria for each command displays the command syntax diagram, and gives a
description of each operand in the command. Typing UP on acommand help screen
displays a complete list of all SmartTest commands.

For help on all SmartTest commands, select Help » All commands or type HELP
COMMANDS. The All commands action displays acomplete list of all SmartTest
commands. The HELP COMMANDS command displays along message that lists most
of the primary commands. Once this message displays, pressing PFL/PF13 displays the
list of all SmartTest commands. From thislist, information about a particular command
can be displayed by selecting the appropriate number.



Figure 112 shows the Help Tutorial screen for the RECALL command.

Figure 112+ Command Help Example

AZG-EnartTest - RY.0 ————————- RECALL Cordand HELF

The RECALL coHHand displaws the prewvious EEV pridary or internal Coddand,
Hessage, oF pop-up. The last twentw conmands that have been ekecuted and the
last twenty Hessages that have been displayed are stacked. These cCoddands and
Heszages can be displayed using RECALL. once the desired coWdand displays,
it can be executed again by preszing Enter or changed prior to edecution.

Thiz is the RECALL cComdand syntas:

RECall ¥
—COHHand | CHO- —HEXT-
-HEZzage| H3E- -PREL-
-POPUp

HiniAHUA Abbrewiations are in CAPE
Default operands are highlighted
LEGEND: ---Fequired-——-—---=---=-=--= o
| —optional-|
This topic is presented only if explicitly selected by nurber:
1 - operand Descriptions

------ Cur panel = UETREC  Prew panel = VPTCHDE Last Weq = IZRZ002 —————=

7 Help Facility

For some commands (on the Program View screen only), pressing PF1L/PF13 after the
long message, displays =NOTES= lines giving specific examples for using the command.
Once the =NOTES= lines are displayed, pressing PFL/PF13 again displays the Help
Tutorial for that command. The Help =NOTES= displays for those commands where
specific examples are helpful. Use the RESET primary command to remove the

=NOTES=lines.

Figure 113 showsthe Help =NOTES= for the RECALL command.

Figure 113+ Help Notes Example

File Uiew Test Search List O0ptions Help

Progran Liew VIAPPLI
CoHrand === scroll ===} CIR
AZGAEdSI RECALL REDIEPLAYE THE PREVIOUE CORHAND OR HEZSAGE.
SMOTE= +-—-——-—————- Exanples -———--— RECALL --———- Dezcriptions -——--—-——-—- +
=HOTE= RECALL Recalls the last connand that was
=NOTE= entered in the prinary coddand
=HNOTE= area.
=NOTE= | REC H3ZG Recalls the last Wessage that was
=NOTE= displawed in the Hessage area.
=NOTE= | RECALL NEXT once recalling is started, MEXT
=MNOTE= Hay be used to reverse its
=MNOTE= ditection.
=HOTE= + t t
aEaaal # PROCEEE OPTIONE INSOURCE Z0URCE NEST MOHACRO:
HERaa2 * PROCEESE AGGREGATE E:0 ZTHT GOSTHT;
BEEgDT # PROCESE HARGINE(2,72,1] HARGINI('|'1:
BEEg0d # PROCESS OPT(@] ATTRIBUTES[FULL) MREF[FULL];
HEEOES # PROCESE GOSTHT,LIST,MEST,LIMECOUNT [55],0PTIONS . 30URCE,,NOTEST
OE000E * PROCESE MOOPTIHIZE,MOFLOM,ATTRIEBUTES:
[l LT
BEaE0E
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General Information

General help information is requested by selecting Help » Table of contents, or by typing
TOC on any Help Tutorial screen. The Help Table of Contents displays. Help information
can be viewed by pressing Enter or by selecting a menu option.

Figure 114 shows the Help Table of Contents.

Figure 114 « Help Table of Contents

AZE-EWartTest - RY.0O -—-—- Help Table of Contents HELF

The topics below represent general categories of infordation about the AZG-ESN
Testing-Debugging coMponent, ASG-EHartTest. To get help for a pull-down,
select the ACtion Bar topic. This Tabkle of Contents Waw be redisplaved frod
any HELF =creen by entering the TOC Connand.
These topics are presented only if eMplicitly selected by nuHber:

1 overuiew of ASG-EHaPTTest

2 Introduction to CUR

3 The Action Bar

d  custamer Suppart

5 AEG-EHartTest Release 7.0 SuUHHArY of Reuisions

& Inder for ASG-3HartTest Help

—————— Cur panel = UPTHTOC Pred panel = WEPALLOC Last H=g = ISRE00Z ————==

Specific Information
Help for specific topicsis requested by selecting Help » Index, selecting option 7 on the
Help Table of Contents, or typing INDEX from within the Help Tutoria. Help for a
specific topic can then be viewed by selecting the appropriate Index entry.

On any Index screen, typing an al phabetic character displays the Index screen
corresponding to that character.
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Figure 115 shows a Help Index screen.

Figure 115+ Help Index Example

AZE-ZRartTest - RY.0 —————————- Inde< A - B HELF

To =select a topic, enter the 2- or I-character identifier.

ABENDE

AZ - ADD ComAand Bl - BackTrack Facility
A3 - Address stop Entry Zcreen E2 - BackTrack Mariable History Pop-up
Al - AKR Oirectaory E3 - BackTrack Uariable History Screen
AS - AKR Ufilities Ed = ERANCH CoWWand
AE - ALLOCDEF CoHWand ES - BREAK CoHHand
AT - ALLIANCE ComAand E& - Ereakpoints List Zcreen
AS — ALTPCE Hessage Queus List
ECFeen
A? - ALTPCE ZegHent List Zcreen
AlR - AMALYZE CoHRand
A1l - Analwze Options

Another inded page can be displayed by entering its letter.

—————— Cur panel = UPTIDWL Pred panel = UPTIDY  Last H=g = ISRZ00Z2 ————==

Help Abends

ESW products include help for these frequently encountered abend codes:

- System abend codes, such as 0C1, 0C4, x13, x22

- ESW product abend codes

- IMS abend codes

Help for system, ESW product, and IMS user abendsis available by selecting Help »

Common abends, typing HELP ABENDS, or typing ABENDS in the command input area
and pressing PF1/PF13. Each of these actions displays the ABENDS screen, as shown in

Figure 116.

Figure 116« ABENDS Screen

AEG-EHartTest - RE.O ————————————— AEBENDE HELI

The following topics will ke presented only if edplicitly selected by nuHber:

- Eysted Abends

AZE Abends

IAE Abends 0O3 - 645

IAE Abends &5d - 931

IHE Abends 932 - I415

oo R
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On the ABENDS selection screen, enter the number of the set of abend codes you want to
view. Selecting Option 2 on this screen displays the ASG Abend Codes screen, which
lists and describes the ESW user abend messages.

Figure 117 shows the ASG Abend Codes screen.

Figure117+ ASG Abend Codes Screen

AZG-FHartTest - RY.0 —————————- AZGE Abend Codes HELFP

Abend codes in the range @O0 - 999 (X354 - ¥'IET') bypass EIM error
FeCovery, causing the abend to be handled by IEPF or by the systed. If
the probled cannot be resolved, contact ARG CustoWer suppart.

B W30S Unable to intercept prograd.

P67 M'ICT' The A%ZE-Center AUTHORIZE password was not specified during
inztallation.

RS W 30E An internal error occurred during initialization.

ey X'3ICA' A package load Hodule was CALLed directly.

72 W Ieo The E3W Edit Honitor encountered a severs error.

avd  M'ICE' An inkalid VIAZBAZE Wodule was found. The current product

edpects a level of CEOSA or greater. Enter HELP 4238 for nore
infarHation.

[Hore...press Enter to continuel
------ Cur panel = VETRENDD Prey panel = VETABND Last Wsg = IEZRZ002 —————=

Help Messages

186

SmartTest messages are displayed in the long message area. Thisisthe format for
messages.

ASGnnnnx text
where:
nnnn is the message number.
X isone of the severity levels listed below.

text isthelong or short message text.
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Severity Levels

This table describes the severity levels:

[ Informational Indicates that there is no required action.

w Warning Indicates a non-critical error condition exists.

E Error Indicates a critical error condition exists.

D Disaster Indicates that a serious error condition exists and the

product is unable to continue.

T Termination Indicates that the product terminated with the specified
error.

Short messages are displayed when available. Long messages are displayed if a short
message does not exist, or when help is requested immediately after a displayed short

message.

Help for a specific message displays by selecting Help » Specific message, or by typing
HELP followed by the message number. The Help Explanation and Action Panel for that
message displays.

Figure 118 shows the Help Explanation and Action Panel.

Figure 118« Help Explanation and Action Panel

HELF Explanation and Action Pansl
CoHHand ===k _ Ecroll ===} PAGE

Additional =support WHay be found at our Webk 2itel WM. asq.coH
AZGAGESE  END OF PROGRAM; UZE BRANCH BACKUP TO FOLLOW OTHER ERAMCHES.

EXPLANATION:
This i$ a warning Hessage indicating that BRAMCH has reached the
physical end of the program.

ACTION:
If you Wish to branch to other paths, use BRANCH BACKUP fto reach
the desired decizion paint and then use BRANCH to follow another
path.

EOTTOH OF DATA
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Printing Messages

188

All SmartTest messages or arange of messages can be printed using the VIASMPRT
program. The VIASMPRT program produces alisting of the specified messages that
includes:

- M essage number

=  Short message (if available)

- Long message

- Explanation of the message

-  Action (if any)

JCL to execute the VIASMPRT program isin ASG.VIACENXX.CNTL(VIASMPRT)
where xx represents the version of Center installed at your installation. The entire

message file is printed unless a specific range is specified in the PRM parameter. For
example, PRM="START=300,END=499" would print messages 300 through 499.

The ALL keyword can be specified in the PRM parameter to print all messages.

The default value for START is 1 and the default value for END is 5000. If only the
START valueis entered, messages print starting at the message number specified and
ending with 5000. If only the END value is entered, messages print starting with 1 and
end with the message number specified.

The NOTES keyword specifies that any notes associated with a message will be printed.
The default isNONOTES. Typically, notes are provided to show Center primary
commands.
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Figure 119 and Figure 120 on page 190 show the VIASMPRT JCL and the output from

the job.

Figure 119« VIASMPRT JCL

//ASG  JO

B ( ), "ASG-CENTER VIASMPRT"

ook ko kb b X o b 3k % X o b ok X X %

//7* INSERT "/*ROUTE PRINT NODE.USER®" HERE IF NEEDED.

//*

/7*

//* * ASG, INC. ASG-CENTER *
//* * *
/7 * UTILITY TO PRINT ASG MESSAGES *
//* * *
//*

/7*

//VIASMPRT PROC VIASOFT="ASG", ASG HI-LVL NODES

// CENTER="VIACENXX", ASG MIDDLE NODES

// SYSOUT="*", PRINT OUTPUT MESSAGE CLASS

// PRM=""* PARM FOR MESSAGES TO BE PRINTED
//*

/7*

//* *

/7 MESSAGE PRINT UTILITY

//* *

//* * THIS PROGRAM WILL PRINT ALL OF THE MESSAGES IN THE ASG

//* * MESSAGE FILE AND THE HELP TEXT ASSOCIATED WITH EACH

//* * MESSAGE IT WILL PRINT THE ENTIRE FILE BY DEFAULT. YOU MAY
//* * SELECT A GIVEN RANGE OF MESSAGES BY SPECIFYING THE OPTION-
//* * AL PARAMETER KEYWORDS: START AND END. FOR EXAMPLE:

/7 * PRM="START=300,END=499"

//* * WILL PRINT MESSAGES NUMBER 300 THROUGH 499, INCLUSIVE.

//* * THE DEFAULT VALUES FOR START AND END ARE 1 AND 99999

//* * RESPECTIVELY. CONSEQUENTLY THE PRM VALUE "END=300" WILL
//* * PRINT MESSAGES 1 THROUGH 300, AND THE PRM VALUE

//* * T"START=4000" WILL PRINT MESSAGES 4000 THROUGH 99999.

//* *

//* * AN OPTIONAL KEYWORD, NOTES, WILL ALSO PRINT ANY NOTES

//* * ASSOCIATED WITH A MESSAGE.

//* *

//* * ADDITIONALLY, THE KEYWORD “ALL® WILL EXPLICITLY PRINT ALL
//* * MESSAGES.

/7*

//7*

//*

//VIAMPRT EXEC PGM=VIASMPRT ,REGION=4096K,

// PARM="&PRM"

//STEPLIB DD DSN=&ASG..&CENTER..LOADLIB,DISP=SHR

//VIAMSGS DD DSN=&ASG. .&CENTER. .VIAMSGS,DISP=SHR

//VIAPRINT DD SYSOUT=&SYSOUT

//VIALOG DD SYSOUT=&SYSOUT

//SYSUDUMP DD SYSOUT=&SYSOUT

//*

// PEND

/7*

//VIASMPRT EXEC VIASMPRT PRINT MESSAGES

/7*

00010000
00020000
00030000
00040000
00050000
00060000
00070000
00080000
00090000
00100000
00110000
00120000
00130000
00140000
00150000
00160000
00170000
00180000
00190000
00200000
00210000
00220000
00230000
00240000
00250000
00260000
00270000
00280000
00290000
00300000
00310000
00320000
00330000
00340000
00350000
00360000
00370000
00380000
00390000
00400000
00410000
00420000
00440000
00450000
00460000
00470000
00480000
00490000
00500000
00510000
00520000
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Figure120+ VIASMPRT Output

PRINTING MESSAGES FROM 0771 TO 0772.

2 MESSAGES PRINTED.

END OF MESSAGE PRINT PROCESSING.

ASGO771 SUBSET "COBOLII"™ IS NOT VALID IN A LANGLVL 1 OR 2 EDIT SESSION.

EXPLANATION:
The COBOL Edit session was selected to view a program as COBOL
LANGLVL1 (COBOL68) or LANGLVL2 (COBOL74), and the command entered
requested a target of SUBSET COBOLII.

ACTION:
IT the program is COBOLII, then reenter the Edit screen with COBOLII
selected; then you may enter commands for SUBSET COBOLII.

ASGO772 THE EDITOR PARAMETER *1° 1S UNKNOWN.

EXPLANATION:
An invalid parameter was entered in the Editor Parms field of the
Edit Options panel.

ACTION:
Refer to the Reference Manual or the Reference Card for a list of
valid editor parameters.
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ACB
See Application Control Block (ACB).

action bar

The line of keywords at the top of a screen. Each keyword represents a category of
actions that may be performed on that screen. An action is selected by moving the cursor
to the desired keyword and pressing Enter. See "The CUA Interface" on page 4 for more
information.

active program
A program that is being viewed and/or tested on the Program View screen. Also see
qualified program.

address command

A command that is entered in the hexadecimal address areawithin the status box or in any
address or offset field displayed on a SmartTest screen. These commands display specific
areas of memory such as the current word, 24-bit address, or the 31-bit address. A
message can also be displayed that indicates to where the 24-bit or 31-bit address points.
See the ASG-SmartTest Reference Guide for more information.

address stop
An absolute address and length of storage that isto be monitored during atest session. A
program interrupt occurs before the specified areais actually updated.

AKR
See Application Knowledge Repository (AKR).

alias
A dataname aliasincludes a Parent (higher level group item), aChild (lower level item), a
RENAMES or REDEFINES, or an 88 level item.

alias name

The name of a program entry point. Alias names are shown on the AKR Directory and
Module Directory screens.
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alias of

A field on a pop-up listing entriesin the AKR. If the analyzed program contains an
ENTRY point, Alias Of isthe name of the program that containsthe ENTRY point. If the
name in the PROC MAIN statement was overridden at the time the analyze job was
submitted, Alias Of is the name that was entered in the AKR program name field on the
File - Analyze Submit pop-up.

analyze
The process used by SmartTest to prepare a COBOL, PL/I, or Assembler program for
testing. See analyzer.

analyzer

The batch component of SmartTest that executes complex algorithmic formulas to
analyze the complexities of a COBOL, PL/I, or Assembler program. It produces a
detailed analysis of the elements and relationships for a program, then places this
information in the AKR. There are three analyzers. The Program Analyzer analyzes
COBOL programs. The Assembler Analyzer analyzes Assembler programs. The PL/I
Analyzer analyzes PL/l programs.

analyzer summary
A summary of the run-time statistics and diagnostic messages that are produced when an
Analyze job completes.

Application Control Block (ACB)
A control block for IMS/DC that contains the PSB and DBD, and is created by the
ACBGEN process.

Application Knowledge Repository (AKR)

The Application Knowledge Repository component of SmartTest. The AKR isaBDAM
or VSAM file organization that contains all analysis information produced by the
Program Analyzer or Assembler Analyzer. Multiple AKRs can be defined for your
installation. SmartTest supports concatenated AKRs.

application plan
See plan name.

Assembler analyzer
See analyzer.

Batch Terminal Simulator (BTS)
An IBM product that allows execution of IMS DB/DC applicationsin a TSO or batch
environment.

batch test session

A SmartTest test session that is established in an MV S batch region, to which an online
test session can be connected. This feature allows batch program testing to be performed
interactively.
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breakpoint
An interruption that occurs during the execution of a program being tested. Breakpoints
result from a BREAK command or an error condition.

BTS
See Batch Terminal Simulator (BTS).

command input area
Thefield on SmartTest screens where primary commands are entered, indicated by ===>
on the second line of the screen.

current cursor location

Refers to the source statement where command processing begins. The current cursor
location can be one of these based on the cursor position: If the cursor isin the command
input area, the current location is the first source code line on this screen. If the cursor is
in the line command input area, the current location is the beginning of that line. If the
cursor isin the source code area, the current location is the cursor position.

cursor character

A substitution character that can be used in commands. The command and cursor
character are typed in the command input area, the cursor is placed on the desired token,
then Enter is pressed. SmartTest |ocates the cursor and reads the specified token as part of
the command. The cursor character is set on the Parameter Definition screen. See the
ASG-SmartTest Reference Guide for more information.

dataname

A standard term for fields defined in the DATA DIVISION of a COBOL program, a
DECLARE in PL/I, or adata arealabel in an Assembler program. Includes variable
names, files, groups, array elements, and fully qualified datanames.

data usage

Defines how a dataitem is used: DEF indicates the statements where the dataitem is
defined; USE indicates the statements where the value is used or tested; MOD indicates
the statements where the value is set or madified; REF indicates any of the above
conditions. Note: This function is only available for COBOL.

database description (DBD)
A control block that describes the physical structure of a databasein an IMS
environment.

DBCS
See Double Byte Character Set (DBCS).

DBD
See database description (DBD).

193



ASG-SmartTest PLI User’s Guide

194

DB2
An IBM relationa database management system.

DB2 Stored Procedure

A user-written program that resides on a DB2 server and isinvoked by an EXEC SQL
CALL statement. A stored procedure is a Language Environment compliant program
writtenin PL/I, COBOL, C/370, or Assembler. The SmartTest DB2 Stored Procedure
option enables programmers/analysts to use SmartTest features to interactively test DB2
Stored Procedures.

debug
The process of locating and correcting program errors.

diagnostic message

Aninformational or error message generated by the online and batch components.
Online - A short message displaysin the upper right corner of the screen (if available). A
long message displays on line three when PF1/PF13 is pressed or HELP is entered for a
short message. Batch - Messages are included in the Analyzer Summary.

DL/I | DL/1
The database (DB) portion of the IMS system.

Double Byte Character Set (DBCS)

A character set that uses two bytes to represent each character. Various Double Byte
Character Sets are used with languages such as Chinese, Korean, and Japanese, which
cannot be represented with single byte codes.

equate

A substitution name for a character string. The substitution name is created using the
EQUATE command. Long commands, patterns, datanames, etc., can be equated to a
substitution name.

IMS
AnIBM hierarchical database management system.

label name
Any PROCEDURE DIVISION paragraph or section name and the PROCEDURE and
PROC literals.

line command
An abbreviated keyword that is entered in the line command area (columns 1 through 6)
on the screen.

list file
A filethat is alocated the first time the LPRINT command is executed. Thisfileis used
for LPRINT output.
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log file
A filethat is allocated upon entry into SmartTest. Thisfileis used for error messages and
log commands.

long message

A diagnostic or error message that displays on SmartTest screens. Long messages are
sometimes preceded by short messages that are displayed in the upper right corner of the
screen. Pressing PF1/PF13 after receiving a short message displays the corresponding

long message.

member
A member in aPDS or source manager such as Panvalet or Librarian. Thisisthe dias
name found in the AKR.

module
A link edited member of aload library PDS. A module can contain several programs.

monitored storage

The data monitored by specifying the absolute addresses and lengths of storage areas on
the Address Stop Entry screen. All storage areas listed on this screen are monitored by
SmartTest and a program interrupt occurs before a specified storage areais actually
updated.

PCB
See Program Communication Block (PCB).

plan name
A DB2 application plan that contains information relating a program to the data used by
the program. A DB2 plan is the output of the BIND process.

PL/l analyzer
See analyzer.

PL/l subset

PL/I statements of asimilar nature that have been grouped together. For example,
input/output statements are grouped into the 1O subset. The LIST SUBSETS command
can be used to display all subsets online.

pop-up

A window that displays as the result of selecting an item on a pull-down or pop-up, or as
the result of entering certain commands. It is superimposed on the screen to allow entry
of information for the requested action.

primary command
A series of keywordsthat is entered in the command input area of the screen.
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program
Program source member name, the name specified in the IDENTIFICATION DIVISION
of aCOBOL program, the PROCEDURE name of a PL/I program, or the CSECT name
of aprogram that is not COBOL.

program analyzer
See analyzer.

Program Communication Block (PCB)
A definition of the database view used by an application program in an IMS environment.

Program Specification Block (PSB)
All Program Communication Blocks (PCBs) are contained in a PSB.

PSB
See Program Specification Block (PSB).

pseudo code
Statements that are temporarily inserted into program source during atest session. The
syntax of this code is compatible with COBOL.

pull-down

Thelist that displayswhen an action is selected on the action bar. On a pull-down, actions
followed by ... display a pop-up when selected. Actions not followed by ... immediately
activate internal commands.

punch file
A filethat is allocated the first time the LPUNCH command is executed. Thisfileis used
for LPUNCH outpuit.

gualified program

A program that displays on the Program View screen using the QUALIFY command,
while another program is being viewed and/or tested. The program specified with the
QUALIFY command is a qualified program; the program being viewed and/or tested is
an active program.

SBCS
See Single Byte Character Set (SBCS).
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screen subsets
Lines that have been acted upon by an interactive command that have caused them to be
in one of these screen display set types:

Highlighted | HI
NONHighlighted | NHI
Excluded | X
NONExcluded | NX

script file
A sequential file that contains a predefined sequence of commands that can be read and
executed.

short message
A diagnostic or error message that displays in the upper right corner of SmartTest
screens. Pressing PF1 after receiving a short message displays the corresponding long

message.

Single Byte Character Set (SBCS)

A character set that uses one byte to represent each character. Single Byte Character Sets
are used with languages such as English where the characters can be represented with a
one-byte code.

status box

A box that displays at the bottom of SmartTest screens during atest session. Current
status information for the program being tested is shown. This information includes the
statement number, offset, source statement, program name, module name, date, and time.
When the Assembler mode is set ON, the status box also shows the AMODE value,
Assembler instructions, hexadecimal value, and the general register contents. The status
box can be removed from the screen using the SET STATUS OFF command.

Storage Management Subsystem (SMS)

An operating environment that automates and centralizes the management of storage. To
manage storage, SM S provides the storage administrator with control over data class,
storage class, management class, storage group, and ACS routine definitions.

Stored Procedure
See DB2 Stored Procedure.

subset
A language subset, screen subset, or tagged lines subset. See the ASG-SmartTest
Reference Guide for detailed information on subsets.
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tagged lines subsets

Information shown in columns 73 through 80 as the result of a FLOW or TRACE
command. These tags can be used as subsets in commands that accept subsets as targets:
TAGged | TAGS

TARGet | TGT

DECision

STArt

OPTions

target
An object of a SmartTest primary command.

TCA
See Test Coverage Analysis (TCA).

Test Coverage Analysis (TCA)

SmartTest-TCA, Test Coverage Analysis, is a testing option that measures test suite
coverage for a set of programs. It fosters a systematic approach to assess the quality of
testing performed in the internal operation of programs. Test Coverage Analysisisatool
for application systemstesting and quality assurance testing —to help ensure that program
routines are covered by data execution (i.e., to what extent the data exercises the
program). Test Coverage Analysis records the program'’s reaction to the data presented,
without user intervention (to preserve the integrity of the results). For detailed
information, see the ASG-SmartTest TCA User’s Guide.

token
A contiguous set of characters preceded by and followed by a blank, period, comma, or
parenthesis.

TSO test session
A SmartTest test session that is executed in a TSO/I SPF environment. Batch JCL is
converted to an allocation CLIST and is used to establish the TSO test session.
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Symbols

& (retain) command 165
& COUNT command 157
/P cards 87

/T command 85

Numerics
3270 terminals supported 27
77 pseudo code statement 157

A
ACB
alocation 74
definition 192
action bar 4,191
active program 5, 191
ADD command 156
adding pseudo code 156
address
commands definition 191
space 82
stop 191
swapped space 82
AGN execution parameter 80
AKR 2
allocating 29
catalog 30
concatenating 38, 40
definition 1
directory 39
password 30
SMS classes 30
utilities 29
alias 191
Alliance 135, 166
accessing from ESW screen Xiii
description x
linking Xiii
Alliance, linking to 166
ALLOC parameter 44

alocating
ACB library datasets 74
alternate message queue 92
alternate PCB output dataset 94
an AKR 29
BTSfiles 87
BTSinput dataset 97
BTS program output dataset 95
DB monitoring datasets 75
DFSRESLB and DFSESL 71
execution parameters 78
|IEFRDER dataset 76
IMSfiles 69
IMS PROC libraries 72
ISPF list file 63
| SPF log dataset 64
Log/List/Punch/Work files 20
output message queue 90
PSB and DBD library datasets 73
QALTPCB 92
QIOPCB 90
script files 26
SNAP dump dataset 99, 101
VSAM buffer pools 72
allocation CLIST 44, 105
alternate
message queue 92
PCB 88
analyze method
from a User screen 36
from an Edit session 34
through SmartTest 33
Analyze Submit Parameters pop-up 35
analyzing a program 32
application control block
see ACB
application group name 80
Application Knowledge Repository
see AKR
application parameters 105
ASG Abend Codes screen 186
ASG-SmartTest Primary screen 17
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Assembler
and SmartTest-PLI 13
integration 2

AutoChange 135
accessing from ESW screen xiii
description x

B
backout and recovery datasets 76
backtrack
recording history 147
reviewing history 148
Batch
connecting for test 117
DFHDRP testing 124
initiating test 119
region testing 112
session setup 113
setup considerations 121
submitting thejob 117
test session 116, 192
testing BTS 122
testing DB2 123
testing DL/I 121
Batch Connect facility 112
specifying multiple steps 116
Batch Session Setup screen
example 113
field descriptions 114
options 114
Batch Terminal Simulator 192
BIND 105
BKO execution parameter 83
BMP
execution parameter 70
parameters 78
region 80
BREAK command 135, 156
break on entry 84, 105
breakpoint
definition 193
displaying 140
inserting 134, 139
removing 140
setting with impact datasets 135
Breakpoints List screen 138
Bridge
accessing from ESW screen xiii
description x
BTS
alocating input dataset 97

allocating program output dataset 95

alternate message queue 92
alternate PCB output dataset 94

BTSDEBUG 99
BTSOUT 95
BTSPUNCH 97
BTSSNAP 101
definition 192
format libraries 90
in TSO session setup 83
input 88
output message queue 90
QALTPCB 92
QALTRAN 94
QIOPCB 90
setup information 83
SNAP dumps dataset 99
STAX indicator 89
system parameters 88
system variables 88
testing in Batch 122
transactions to monitor 85
work file 88
BTS Allocation Selection pop-up
example 87
options 88
BTS Batch Session Setup screen 122
BTSBTSDEBUG Allocation pop-up
example 100
field descriptions 100
BTSBTSOUT Allocation pop-up
example 96
field description 96
BTS BTSPUNCH Allocation pop-up
example 98
field descriptions 98
BTS BTSSNAP Allocation pop-up
example 102
field descriptions 102
BTS FORMAT Libraries pop-up 90
BTS Load Library pop-up 89
BTS QALTPCB Allocation pop-up
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